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Before you start using this guide, it is important to understand the terms and typographical conventions used in the 
documentation. 

The following kinds of formatting in the text identify special information. 

Formatting convention Type of Information 

Numbered (1, 2, 3 ..) Step-by-step procedures. Follow these instructions to complete a specific 
task. 

Bold Brand names, window names, application name when used for the first 
time in a chapter or section, items you must select, such as menu options, 
command buttons, or items in a list. 

Notes and warnings Information that requires special attention. 

CAPITALS Names of keys on the keyboard (e.g. SHIFT, CTRL, or ALT). 

KEY+KEY Key combinations for which the user must press and hold down one key 
and then press another (e.g. CTRL+P, or ALT+F4). 

Emphasis Use to emphasize the importance of a point or identify variable 
expressions such as parameters 

 

 

Typographical Conventions 
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Acronym 

Acronym  Description  

CIM Communication Interface Module 

OLI Offline Interface Module 

CL Campus Locks 

CM Computer Managed 

SMS Security Management System 

SP System Processor 

CCTV Closed Circuit Television 

V-VMS Next Generation Video Management System 

V-EVMS Video Enterprise Management System 

VI-16IN/S3 16 Contact Input Expansion Module 

VI-16O/S3 16 Relay Output Expansion Module 

VRI-1/S3 Single Reader Interface 

VRI-2/S3 Dual Reader Interface 

VRINX Reader Interface 

VRCNX-R/M/A 16 Door Reader Controller 

VSRC Single Door Reader Controller 

VSRC-M/A Dual Door Reader Controller 

GUI Graphical User Interface 

UDF User Defined Field 

mCIM Mercury Communications Interface Module 
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Introduction 

The Vanderbilt Security Management System (SMS) software offers access control, digital video capture, 
badging, visitor management, alarm monitoring, and other security applications tailored to every end user. SMS can 
manage offline (local decision) programmable locks, online systems and Wireless open architecture locks. 
Vanderbilt controllers accommodate up to 16 readers, including PIN-enabled locks, magnetic stripe and proximity 
card readers, iButton readers, biometric hand readers and finger key readers. An easy-to-use GUI provides ñdrag 
and dropò assignment of Areas and Area Sets, Cardholder Categories, Site Codes and Site Code Sets, etc. 

This user manual provides you guidelines for configuring and customizing SMS based on your unique company 
needs. Beginners and experienced users should find the information they need to perform all the administrative and 

end user activities required to manage SMS. It also features concise technical discussions, point-by-point guidelines 
for programming the system and summaries that give you instant access to the information you need. End users 
can also find guidelines for defining cardholders, adding credentials, monitoring transactions/alarms and executing 
manual overrides (i.e. unlock a normally locked door). 

 

System Overview 

SMS is a computer-based alarm monitoring system that allows cardholders to gain access to a secured area at 
specific intervals. If a violation occurs the system creates transactions that can be labeled as alarms and routed to 
appropriate alarm workstations. These secured areas can be controlled from a remote location; from another room 
or from around the world. The system is also capable of visitor management, advanced reporting, badging and 

digital video recording. SMS provides support for offline computer managed locks and campus locks. The online 
system also supports online locks, wireless readers and other local decision locks. 

The following sections describe the basics of the system. 

 

Areas, cardholders and readers 

An area is a physical space that is used to give access to a cardholder, which represents a person who is interacting 

with SMS. A cardholder swipes a credential or enters a pin number at the reader or keypad. An area can have one 
or more readers attached to it. For example, a main lobby in a building with four entrances can have four readers 
but it can be defined as one area called ñMain Lobbyò. That way a cardholder can gain access through these four 
doors by having access to one single area. The area record is downloaded to the controller only once and that saves 
the memory on the controller. It is important to note that a reader can be associated with only one area, although an 
area can have multiple readers associated with it. 

 

Grouping Structure - Area Sets and Cardholder Categories 

The areas and cardholders can be grouped as sets and categories to grant access easily. For example, a user can 
create a cardholder category called ñIT Departmentò and include all the IT employees in that category. The user can 
also create an area set called ñIT Generalò including all the IT areas. 

 

Preface 
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Area Access 

Cardholders are given access to areas during a specific timezone. Some other specific details about the access 
include door type (disabled access, pedestrian access etc.) and area state (this allows the software to deal with 
strike, lock down etc.). The door types and area states are user definable. 

 

Credentials 

A Cardholder can be assigned zero or more Credentials. A credential is a physical or logical object used at a reader 
to establish a Cardholder's identity; common credentials are badges, iButtons, proximity key fobs, PINs, etc. If a 
Cardholder has more than one credential, any of them can be used to enter an Area to which the Cardholder has 
been granted Access, provided that the reader can read the credential type that is presented. 

 

Transactions 

Transactions are the events that happen in SMS or in an external system interfaced to SMS. ñValid Accessò, 
"Access Deniedò, "Relay Energizedò etc. are some examples of Transactions that can occur in the security 
management system. Every Transaction is associated with a time, device type and other information depending on 
the type of the Transaction. Transactions are used for alarming, reporting and monitoring. 
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Online and Offline Access Control 

SMS supports both online and offline (local decision) access control. In the online system a read head is connected 
to a reader interface which is in turn connected to a reader controller. 

Read heads are the transducers that actually interact with a credential; for instance, a slot through which a magnetic 
stripe is swiped or a keypad into which a pin number is entered. Reader interfaces are pieces of hardware that 
decode the data encoded on the credential into a set of numbers usable by the controller. Controllers store 
information about cardholders and access and implement the access control logic (the controller decides whether 
the door should open in response to a credential). Controllers remain in constant communication with the software. 

Offline (local decision) locks are standalone locks with a credential reader that are installed in a door, on a door 
frame, or near a door and are not connected to an external online controller. They are programmed and audited 
using a PDA or similar device or via connection to SMS over TCP/IP, depending on the capabilities of the locks. 

Communication 

These are the main entities involved in the system communication. 

Á SQL Server  - SQL Server is a database system where all information associated with the security system is 
stored. 

Á Gatekeeper  (Gatekeeper Service) - The Gatekeeper is a Windows service that is the authentication hub in 

SMS. There is only one instance of the Gatekeeper running in a system, no matter how large the system is. It 
is run on the same physical machine as the System Processor. The Gatekeeper processes all login requests 
from the Launcher (and alarm monitoring applications depending on configuration) and controls access to the 
SMS client applications and database. The Gatekeeper communicates directly with the SP to coordinate client 
licensing and register authenticated clients. 

Á SP (System Processor) - The SP is a Windows service that is the communications hub in SMS. There is only 
one instance of the SP running in a system, no matter how large the system is. It can be run on the same 
physical machine as the SQL Server for smaller systems. The SP enforces SMS licensing, Operator and 
application authentication and routes transaction and alarm information between SMS client applications. 

Á CIM  (Communication Interface Module) - The CIM is a client application responsible for handling the 
communication to the Vanderbilt controllers in the system. A CIM can typically communicate with up to 64 

controllers (up to 1,024 card readers/locks) depending on system activity. Smaller systems require only 
one CIM, running on the same physical machine as the SQL Server, but larger systems can have several or 
even dozens of CIMs. 

Á mCIM  (Mercury Communication Interface Module) - The mCIM is Windows service responsible for handling 
the communication to the Authentic Mercury protocol controllers in the system. The mCIM can typically 
communicate with up to 256 Authentic Mercury protocol controllers (up to 8,192 card readers/locks) 

depending on system activity. Smaller systems require only one mCIM, running on the same physical 

machine as the SQL Server, but larger systems can have several or even dozens of mCIMs. 

Á CMI Service (Calendar Managed Intervals Service) ï The CMI Service is a Windows service responsible for 
processing Calendar Managed Timezone Intervals into the correct format for download to the controllers. The 
controllers require a 7-day format for Timezone Intervals. The CMI Service runs nightly and updates the 
controller downloaded Timezone Intervals corresponding to Calendar Managed Timezones for the next 7-day 
period. The CMI Service runs on the same physical host as the SP. 

Á Controllers  - Controllers are pieces of hardware that have devices such as relays, contacts and card reader 
interfaces connected to them. The controllers make the decisions about whether to grant access to 
cardholders when they present a credential to a card reader. They also monitor contact points, energize relays 
based on schedules, etc. The VRCNX and VSRC series are the main controllers for SMS. Controllers are also 
commonly referred to as panels. 
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Communication between CIM and Vanderbilt controllers 

A CIM can be connected to many online controllers at once (typically up to 64, depending on system activity). 
Communication occurs via the network, a COM port or a dial-up modem. The CIM downloads information about 
badges, schedules, etc. to controllers; occasionally downloads new firmware to controllers and collects transaction 
information from the controllers. A list of both connected and disconnected controllers can be viewed at the CIM. 

The controller is responsible for initiating the connection to the CIM; the CIM does not actively attempt to connect to 
controllers. Networked controllers will attempt to connect to the CIM at whatever IP Address was programmed into 
them during setup. This programming of the controller's network device is commonly done via telnet (VRCNX-R / 
VSRC) or SSH (VRCNX-M/A or VSRC-M/A); the controllers web based graphical user interface (GUI) via TCP/IP 
or the Vanderbilt Discovery and Configuration software application. 

Communication between mCIM and controllers 

An mCIM can be connected to many Authentic Mercury protocol online controllers at once (typically up to 256, 
depending on system activity). Communication occurs via the network. The mCIM downloads information about 
badges, schedules, etc. to controllers and collects transaction information from the controllers. 

The controller is responsible for initiating the connection to the mCIM; the mCIM does not actively attempt to connect 
to controllers. The Authentic Mercury protocol controllers will attempt to connect to the mCIM at the host IP Address 
programmed into them during setup. This programming of the controller's network device is commonly done via the 
controllerôs web based graphical user interface (GUI) via TCP/IP. 

CIM to SP communication 

The CIM / mCIM connects to the SP upon startup and sends transactions to it as soon as they are gathered from 
controllers. If the CIM / mCIM cannot connect to the SP, it will stop accepting transaction information from the 
controllers, causing them to be buffered there until the CIM / mCIM can connect to the SP. This is to prevent a 
transaction that could potentially generate an alarm from bypassing the SP. 

CIM to database communication 

The CIM / mCIM communicates to SQL server like any other client application. It writes transactions to the database 
as they are gathered from controllers. If the CIM / mCIM cannot connect to the database, it will stop accepting 
transaction information from the controllers, causing them to be buffered there (as long as controller power is 
maintained, or a Vanderbilt controller supports Enhanced Offline Mode) until the CIM / mCIM can connect to the 
database. This is to prevent these transactions from being lost should the CIM / mCIM be stopped before database 
communication is reestablished. 

CIM to workstation communication 

The CIM / mCIM listens on port 5354 / 5370 for connections from other SMS client applications. The primary usages 
of this communication are to allow other workstations to issue Manual Overrides (for instance, opening a door) and 
to allow other workstations to flash new firmware into the controllers. 



 

30 SMS Software Manual Version 7.0.0 

 

Controller behavior when offline 

When a controller is not connected to the CIM / mCIM, it continues to function normally using the last information 
sent to it as long as power is maintained to the controller. This is to ensure people can continue to open doors 
regardless of the state of the CIM / mCIM. It will buffer as much transactional information as possible until it runs out 
of memory, waiting for the CIM / mCIM to come back online. Once memory is full, it will overwrite the oldest 
transactions in the buffer with new transactions. This storage capacity depends on how much memory is installed 
in the controller as well as how rapidly transactions are being generated. If power is cycled to a controller or a 
controller is restarted, the controller will restart in Degraded Mode and then attempt to contact the CIM / mCIM. If 
the CIM cannot be contacted, Vanderbilt VRCNX-M/A and VRSC-M/A controllers will then enter Enhanced Offline 
Mode within about 2 minutes. Note that some legacy Vanderbilt controllers contained a capacitor to allow operation 
without external power for several days to 1 week and will continue to operate normally until power is restored or 
the capacitor is drained. These legacy Vanderbilt controllers do not support Degraded or Enhanced Offline Modes 
so if power drains completely and the CIM cannot be contacted, operation of connected devices may cease unless 
these devices support an offline mode. 

Degraded Mode 

Data downloaded to the VRCNX and VSRC series controllers from the CIM includes a file specifying valid Card 
Formats and Site Codes for devices connected to the controller. Authentic Mercury protocol controllers receive 
similar information from the mCIM. In the event power is cycled or these controllers are reset, and Degraded Mode 
has been enabled, this file is used to grant Access to all connected devices based on Card Format and Site Code. 
Once connection the CIM / mCIM is established, current access related information will be downloaded, and full 
operation will be restored. 

Enhanced Offline Mode 

Data downloaded to the Vanderbilt VRCNX-M/A and VSRC-M/A controllers from the CIM is copied to nonvolatile 
memory in the controllers, so a complete backup of the data used for full access control is maintained. In the event 
power is cycled or these controllers are reset, and Degraded Mode has been enabled, these controllers will enter 
Degraded Mode while this backup data is loaded into memory and then full access control will be resumed based 
on the last set of data downloaded from the CIM, as if CIM communications were lost and no power outage occurred. 
During Enhanced Offline Mode, up to 20,000 transactions and 5,000 alarms will be buffered to nonvolatile memory 
and will be uploaded to the CIM (alarms first) once communications are re-established. 

Transactions and Alarms 

Transactions are uploaded from the controllers to the CIM / mCIM. The CIM / mCIM writes the transactions to the 
SMS SQL database and receives a confirmation back from the database. The CIM / mCIM then transmits the 
transaction to the SP. The SP examines the transaction to determine if it is an alarm by reviewing the alarm labels 
and attachments. If the transaction is determined as an alarm, it is written to the SQL database and confirmed. The 
SP will then transmit the alarm to the associated alarm workstation(s) or alarm operator(s). Once the transaction is 
properly handled (acknowledged) by an SMS Operator, the details pertaining to the transaction are written to the 
SQL database. 
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C H A P T E R  1  

Introduction 

This section gives instructions on installing the Electronic License Key, SMS Software and User Login and details 
the System Launcher (on page 95) application. The steps in the installation may vary depending on the level of 
software you are installing. 

Operator's requirements 

1 You must be the owner of the SMS SQL database. 

2 You must have administrator rights to the PC and the SMS folder. 

If you meet all the requirements mentioned above, you can proceed with the SMS installation program. 

Note: While installing the SQL Server, make sure that the case sensitivity option is turned off. If this SQL 

setting is turned on, SMS installation will fail. 

Minimum System Requirements 

Single User / Client Workstation 

Á Processor: Intel Core i5 

Á Memory:  8 Gb Ram 

Á Disk Space: 120 Gb 

Á USB Port for SMS Distribution Media 

Á 10/100/1000 Base-T network card (NIC) - must be active for SMS licensing 

SMS does not support hosting a CIM or the SP on a multi-homed system (more than one active NIC). 

CIM - SP - Controller communications may be unpredictable on multi-homed systems. 

If NIC redundancy is required. Vanderbilt recommends teaming multiple NICs in the same system. 

Á Mouse, Keyboard & Monitor 

Installation and Getting Started 
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Á Operating System: 
64-bit Windows 8 Professional (except Home Edition) 
64-bit Windows 8.1 Professional (except Home Edition) 
64-bit Windows 10 Professional (except Home Edition) 
MS OLE DB Driver for SQL v18.3 (will be installed if necessary) 
MS ODBC Driver for SQL v17 (will be installed if necessary) 
 32-bit System DSN for ODBC Driver (will be created) 
.NET v4.8 (will be installed if necessary) 

Á Database Engine: 
SQL Server 2012 Express / Standard / Enterprise SP2 or newer 
SQL Server 2014 Express / Standard / Enterprise SP1 or newer 
SQL Server 2016 Express / Standard / Enterprise SP1 or newer 
SQL Server 2017 Express / Standard / Enterprise 
SQL Server 2019 Express / Standard / Enterprise 

SMS does NOT support installation in a SQL cluster environment 

The SMS Install Media Includes 64-bit SQL 2014 Express SP3 

Multiuser Server 

Á Processor: Intel Core i7 or Xeon 

Á Memory:  8 Gb Ram 

Á Disk Space: 500 Gb 

Á USB Port for SMS Distribution Media 

Á 10/100/1000 Base-T network card (NIC) - must be active for SMS licensing 

SMS does not support hosting a CIM or the SP on a multi-homed system (more than one active NIC). 

CIM - SP - Controller communications may be unpredictable on multi-homed systems. 

If NIC redundancy is required. Vanderbilt recommends teaming multiple NICs in the same system. 

Á Mouse, Keyboard & Monitor 

Á Operating System: 
64-bit Windows 8 Professional (except Home Edition) 
64-bit Windows 8.1 Professional (except Home Edition) 
64-bit Windows 10 Professional (except Home Edition) 
64-bit Windows 2012 Essentials, Standard or Datacenter 
64-bit Windows 2012 R2 Essentials, Standard or Datacenter 
64-bit Windows 2016 Essentials, Standard or Datacenter 
64-bit Windows 2019 Essentials, Standard or Datacenter 
MS OLE DB Driver for SQL v18.3 (will be installed if necessary) 
MS ODBC Driver for SQL v17 (will be installed if necessary) 
 32-bit System DSN for ODBC Driver (will be created) 
.NET v4.8 (will be installed if necessary) 

Á Database Engine: 
SQL Server 2012 Standard or Enterprise SP2 or newer 
SQL Server 2014 Standard or Enterprise SP1 or newer 
SQL Server 2016 Express / Standard / Enterprise SP1 or newer 
SQL Server 2017 Express / Standard / Enterprise 
SQL Server 2019 Express / Standard / Enterprise 

SMS does NOT support installation in a SQL cluster environment. 
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ASSA ABLOY IP-Enabled WiFi or PoE Locks 

Á ASSA ABLOY Door Server Router (DSR) host meeting ASSA ABLOY current specs (12/19/2019) 

Á Up to 128 Locks: 2 CPU Cores; 4 Gb RAM; 20 Gb HD 

Á 64-bit Windows 7, Windows 10, Windows Server 2008 R2, 2012, 2016 or 2019 

Á Up to 1,024 Locks: 4 CPU Cores; 8 Gb RAM; 20 Gb HD 

Á 64-bit Windows Server 2008 R2, 2012, 2016 or 2019 

Á Up to 2,048 Locks: 8 CPU Cores; 16 Gb RAM; 20 Gb HD 

Á 64-bit Windows Server 2008 R2, 2012, 2016 or 2019 

(SMS is certified for a maximum of 750 locks per DSR) 

Á ASSA ABLOY DSR v8.0.13 installed on a stand-alone host from SMS 

Optional SMS Web / Guest Pass Web Registration 

Á Multiuser Server Processor / Memory Specifications 

Á SMS Enterprise 

Á IIS Server v7.5 ï v8.5 on stand-alone host from SMS 

Á .NET Framework 2.0 

Á .NET Framework 4.0 / 4.8 

Á Installation assistance available via paid Vanderbilt Technical Support 

Á SMS Web release anticipated approximately 1 month after SMS Release 

Á DNS Reverse Lookup must be enabled across network to utilize SMS Web Portrait Monitor 

Virtual Server Support 

Á VMware ESX v4.1 through ESX v6.7 

Á Microsoft Hyper-V on Windows Server 2012 R2 or newer 

Á Guests Running on an SMS Supported Operating System 

Á Guests Meeting the same Minimum Requirements defined above 

The SMS license binds to the SP host system hardware properties. 

The SP host system virtual guest must be configured for static NIC and hard drive properties. 
SMS does NOT support vMotion or Live Migration for the SP host virtual system. 

SMS does NOT support installation in a Citrix or any terminal server environment. 
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License Key Requirement 

SMS v7.0.x requires a v7.0 Electronic License Key for all installations. 

Legacy License Keys, v6.0 - v6.5 Electronic Keys or legacy USB Keys (USB Dongle) are not supported. Electronic 
License Keys from v6.0 - v6.5 cannot be upgraded to the 7.0 format.  

SMS v7.0.x is installed with a one-time use 5-day unlimited electronic Installation License key. The v7.0 

Installation License Key will be updated with the hardware "fingerprint" of the SP host system on initial startup. 
The SMS License File (SMS.lic) must be provided to Vanderbilt after initial start-up and before the expiration of the 
5-day Installation License so a permanent license can be issued by Vanderbilt. The permanent v7.0 Electronic 
License Key can be acquired from Vanderbilt Industries Monday through Friday during normal business hours. 

See the Electronic License Key section in the Installation Instructions sub-chapter for details on how to acquire the 

permanent SMS Electronic License Key and replace the Installation License Key. The cost of the Electronic 
License Key is included with the purchase of the SMS software (or software upgrade). The v7.0 Electronic License 

Key will NOT be recognized by older versions of SMS. 

The v7.0 Electronic License Key will control the following features of SMS: 

Á SMS Edition: Select or Enterprise 

Á Maximum number of concurrent SMS client logins 

Á Maximum number of Guest Pass locations (configuration sets) which can be configured 

Á Maximum number of V-VMS cameras which can be configured as "Installed" 

Á Maximum number of non-Vanderbilt Online devices which can be configured as "Installed" 

Á Maximum number of Offline (local decision) devices which can be configured as "Installed" 

Á SMS API Connection authorized 
 

Installation Instructions 

Warning: 
Do Not Change the Hostname of The SQL Server Once The Database Engine Has Been Installed 
SMS Will No Longer Function And A Billable Tech Support Incident Will Be Required 
 
SMS does not support naming the SMS database using special characters or spaces in the name and does 
not support using a numeric character as the first character in the SMS database name. 

Software Install for Multiuser Server/Single User System:   
SQL NOT Pre-Installed on Target System 

1 Insert SMS v7.0.0 USB media. 

2 Browse to the SMS v7.0.0 media and run 7.0.0_SMS_Server_Install.exe. 



...   
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3 The SMS software Installation starts. 

REPLACE 

4 The first step in the installation process is determining the Operating System installed on the host.  If an 
unsupported Operating System is detected a message will be displayed and the installation will be terminated. 

5 Once the Operating System version verification is completed and no Microsoft SQL database engine is 
detected, you will be prompted to install MS SQL Express. 

 

6 Click OK. 
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7 Accept the Microsoft Database Engine License Agreement.  Click Next . 

 

8 The SQL Express database engine installer will start. The SMS database will be installed to a SQL Named 
Instance with the name "SMS". 



...   
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Note: The SQL Express Installation May Take A While To Complete. 

 

 

9 Once SQL Express installation completed, you will be prompted to reboot the system.  Click Yes. 

 

10 Login to the host system once reboot completes. SMS installation will continue. 
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11 SMS Software Installation will begin.  Click Next. 

REPLACE 

12 Accept the Vanderbilt SMS License Agreement.  Click Next. 

 



...   
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13 Accept the default Installation Location or enter an alternate location for the SMS program files. 

 

Note: The SMS Data folder location will be automatically be created as a sub-folder under the SMS Folder. 

The SMS Data folder must be shared from the server for multi-user SMS installations to allow client systems 

to access some SMS data not stored in the database. See Sharing the Data Folder below. 

14 Click Next. 
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15 Enter the Hostnames for the systems to host the SP and CIM. 
Accept the default values if the CIM and SP will be installed on this host. 

 

16 Click Next to begin SMS software installation. 

 



...   
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17 A dialog will display for confirmation of the SQL Server Instance for SMS database installation. The dialog will 
be pre-populated with the Instance name installed above and the standard Vanderbilt SMS credentials for the 
SQL Server local "sa" account (password = "SECAdmin1").  

 

18 Click Next. 
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19 Enter the SQL "sa" account password when prompted as shown below. 

The Vanderbilt SQL Express installation default value = "SECAdmin1". 

 

20 Click Next. 

 



...   
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21 Create the SMS master administrative login as shown below. 

Vanderbilt recommends the defaults (Login Name = SMSAdmin, Pasword = SECAdmin1). Click Next. 

 

22 SMS database creation will begin. Commands used to create the database are visible during this process. 
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23 Once SMS database creation completes, Click OK. 

 

24 Additional files will be copied to the SMS installation location. 

 



...   
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25 Enter the SQL sa account password which will be used to configure the SMS master administrative login 

entered above (SMSAdmin). 
Vanderbilt recommends accepting all default SQL / SMS administrative account values  

(Login Name = sa, Password = SECAdmin1).  Click Next. 

 

26 Confirm the SMS master administrative login entered above (SMSAdmin). 
Vanderbilt recommends accepting all default SQL / SMS administrative account values  

(Login Name = SMSAdmin, Password = SECAdmin1).  Click Next. 
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27 Click Finish. 

 



...   
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28 The Calendar Managed Intervals Management and SMS System Processor (SP) Services will be installed. 

Acknowledge Installation.  Click OK. 
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29 SMS Software Installation is completed. Click Finish. 

 

Software Install for Multiuser Server/Single User System:   
SQL Pre-Installed on Target System 

Note:  If using a pre-installed SQL server for SMS, verify: 
     Å Collation:  SQL_Latin1_General_CP1_CI_AS 
     Å Language:  English 
 
If these 2 conditions are not met, SMS may not function properly after installation. 

1 Insert SMS Distribution Media. 

2 Browse media and run 7.0.0_SMS_Server_Install.exe. 



...   
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3 The SMS software Installation starts. 

REPLACE 

4 The first step in the installation process is determining the Operating System installed on the host.  If an 
unsupported Operating System is detected a message will be displayed and the installation will be terminated. 

5 The next step in the installation process is determining the SQL Server version.   
SMS supports systems with SQL 2012 ï 2019.  
If the upgrade detects an unsupported SQL version installed on the host, the installation will be terminated. 

6 If a supported version of Microsoft SQL Server is detected, you will be prompted for SQL credentials which 
will be used during the installation process. 

Vanderbilt recommends using the default SQL administrative account, "sa", and the appropriate password. 

Enter the appropriate credentials and click Next. 
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Note:  If IT policy does not allow the use of the sa account, an account assigned the sysadmin Server Role 

must be provided. 

 

7 SMS Software Installation will begin.  Click Next. 

REPLACE 



...   
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8 Accept the Vanderbilt SMS License Agreement.  Click Next. 
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9 Accept the default Installation Location or enter an alternate location for the SMS program files. 

 

Note: The SMS Data folder location will be automatically be created as a sub-folder under the SMS Folder. 

The SMS Data folder must be shared from the server for multi-user SMs installations to allow client systems 

to access some SMS data not stored in the database. See Sharing the Data Folder below. 



...   

 

 Chapter 1    Installation and Getting Started 53 

 

 

10 Enter the Hostnames for the systems to host the SP and CIM. 
Accept the default values if the SP and CIM will be installed on this host. 
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11 Enter the Hostname and Instance (if desired) for the SQL Server host system. 
Accept the default value which should contain the system for which sysadmin credentials were entered above. 

 



...   
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12 Click Next to begin SMS software installation. 
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13 Enter the SQL "sa" account password when prompted as shown below. 

Alternately, enter the IT provided sysadmin account credentials. 

 



...   
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14 Click Next. 

 

15 Create the SMS master administrative login as shown below. 

Vanderbilt recommends the defaults (Login Name = SMSAdmin, Pasword = SECAdmin1). Click Next. 

Note:  If this account is changed, a SQL login with this name must NOT exist. 
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16 SMS database creation will begin. Commands used to create the database are visible during this process. 

 

17 Once SMS database creation completes, Click OK. 

 



...   
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18 Enter the SQL sa account password which will be used to configure the SMS master administrative login 

entered above (SMSAdmin). 
Vanderbilt recommends accepting all default SQL / SMS administrative account values  

(Login Name = sa, Password = SECAdmin1).  Click Next. 
Alternately, enter the IT provided sysadmin account credentials. 
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19 Confirm the SMS master administrative login entered above (SMSAdmin). 
Vanderbilt recommends accepting all default SQL / SMS administrative account values  

(Login Name = SMSAdmin, Password = SECAdmin1).   

Alternately, enter the same credentials used in Step 15 above.  Click Next. 

 

20 Click Finish. 

 



...   
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21 The Calendar Managed Intervals Management and System Processor (SP) Services will be installed.  

Acknowledge Installation.  Click OK. 
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22 SMS Software Installation is completed. Click Finish. 

 

 

Sharing the SMS Data Folder: 

Note:  The steps below are required for multi-user SMS configurations to allow client systems to access SMS data 
not stored in the SMS database (portrait image files, scanned signature files, etc.). 
 
The instructions below assume that SMS was installed in the default location (c:\program files (x86)\SMS\), if the 
SMS installation location has been changed, adjust the steps below accordingly. 
 
Depending on the Windows environment, Simple File Sharing may be disabled.  Configuration instructions for Simple 
and Advanced File Sharing are provided.  Use the instructions appropriate for the environment on the SMS server. 

Advanced File Sharing 

1 Open Windows Explorer and browse to the SMS installation folder (c:\program files (x86)\SMS). 



...   

 

 Chapter 1    Installation and Getting Started 63 

 

 

2 Right-click on the SMS folder and select Share with > Advanced sharing.... 
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3 Click the Advanced Sharing button in the SMS Properties dialog. 

 

4 Check the Share this folder option in the Advanced Sharing dialog.  The SMS folder name should be 

populated into the Share Name field. 

 



...   

 

 Chapter 1    Installation and Getting Started 65 

 

 

5 Vanderbilt recommends hiding the Windows share so it is not readily visible on the network.  Append a "$" 
after the share name to hide the share from public view. 

 

6 Click the Permissions button. Highlight the Everyone group under "Group or user names" and check Full 

Control in the lower section. 

7 Click OK to close the Permissions dialog. 

8 Click OK to close the Advanced Sharing dialog. 

9 Click Apply to close the Properties dialog. 

 

Simple File Sharing 

1 Open Windows Explorer and browse to the SMS installation folder (c:\program files (x86)\SMS). 



 

66 SMS Software Manual Version 7.0.0 

 

2 Right-click on the SMS folder and select Share with > Specific people.... 

 

 



...   
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3 Click in the drop-down and select Everyone, click the Add button. 
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4 Click the arrow adjacent to Everyone and change the Permission Level from Read to Read/Write.  Click 

the Share button. 

 

5 Click Done at the File Sharing confirmation dialog. 

The above steps configure the Windows Share permissions all users on the network.  Windows NTFS File System 
permissions are also required. 
The SMS installer configures the Windows File System NTFS permissions for the Local Group "Users" to Full 
Control. 
 
If local IT policy disallows use of the Local Groups "Users" and "Everyone", please contact your IT personnel for 
permissions configuration instructions. 

Software Install for Client Systems, CIM or SP Hosts: 

1 Insert SMS installation media. 

2 Browse and run 7.0.0_SMS_Client.exe. 



...   
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3 The SMS software Installation starts.  Click Next. 

 

4 The first step in the installation process is determining the Operating System installed on the host.  If an 
unsupported Operating System is detected a message will be displayed and the installation will be terminated. 
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5 Accept the default Installation Location or enter an alternate location for the SMS program files. 

 



...   
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6 Enter or browse to the path for the shared SMS Data folder, usually located on the SMS main server. 
The example below will differ from the path created above during server installation. 
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7 Enter the Hostnames for the systems hosting the SP and CIM. 

 



...   
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8 Enter the SQL Server Name, SMS database name & SMS master administrative Login credentials for the 
SQL Server host system. 
The Vanderbilt default credentials are SMSAdmin with password SECAdmin1.  
Replace the SQL Server Name below with the SQL Server hostname configured above. 
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9 Click OK to begin SMS client software installation. 

 



...   
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10 The Calendar Managed Intervals Management and SMS System Processor (SP) Services will be installed, 

but not enabled, on the client system.  Click OK. 
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11 SMS Software Client Installation is completed.  Click Finish. 

 

12 Vanderbilt recommends rebooting the client system when prompted. 

 

Configure Client Access to SMS Shared Data Folder 

SMS stores most data in the SMS SQL database.  However, some data (Portrait image files, scanned Signature 
files, etc.) are stored on the SMS Server Windows File System. 
 
Follow the steps below to configure each Client system for accessing the SMS Data folder Share configured above. 

1 Run the SMS Registry Entry application from the Start > Vanderbilt SMS menu. 

2 Select the System Information tab. 

3 Modify the Path name of the system data folder field and enter the UNC path to the SMS Share created 

above. 

4 Hidden Share (Advanced Sharing only): 



...   
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1. Enter \\servername\sharename$\data\  
(enter the SMS Server Hostname for the servername and the name configured above for sharename) 

2. Browsing for the SMS shared folder is not possible since the shared folder is hidden. 

 

3. Click OK. 

5 Visible Share: 

1. Enter \\servername\sharename\data\  
(enter the SMS Server Hostname for the servername and the name configured above for sharename) 

2. Alternately, the browse button to the right of the field may be use to browsing for the SMS shared folder. 
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3. Click OK. 

Door Service Router (DSR) Bridge Service Installation 

If Assa Abloy IP-Enabled Local Decision (offline) WiFI or PoE Locks will be used with SMS, the following additional 
installation steps are required. 

1 Assa Abloy certified installer will install and configure the Assa Abloy Door Service Router (DSR). 

SMS v7.0.0 Is Compatible with DSR v8.0.13 Only 

2 Work with an Assa Abloy certified installer lto configure and install the IP-Enabled Locks onto the network. 

3 Work with an Assa Abloy certified installer to ensure that the locks are communicating with the DSR. 

4 Install the SMS DSR Bridge service on the DSR host system by running DSRBridgeSetup.exe from the SMS 
Installation DVD under the Utilities\SMSDSRBridge\ folder. 

5 Use System Manager to install and configure the IP-Enabled Locks for use within SMS. 

Electronic License Key Installation 

Versions of SMS prior to v6.0 used a physical USB Key in order to enable specific SMS options on any given 
computer. In order for a computer to run SMS the USB Key had to be physically inserted in the computer running 
the SP service. Beginning with SMS v6.0 an Electronic License Key has replaced the USB Key. 

SMS v6.4 introduced a new "Installation License" which will be created on the initial System Processor (SP) startup 
and provide 5-days of unlimited SMS feature licensing for initial setup and installation of SMS without having to 
contact Vanderbilt for a license. 

A permanent license will be issued during Vanderbilt normal business hours upon Vanderbilt receipt of the "SMS.lic" 
file from the BIN folder on the SP host system and the Device Inventory Report (email both to 
SMSELicense@VanderbiltIndustries.com). 

 



...   
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Overview 

The SMS Electronic License contains a data structure, used as a key, and 
algorithms for securely creating, updating, and reading that data structure.  
The data structure (key) is bound to a piece of hardware which must interface 
with the computer in order for that computer to run SMS. That piece of 
hardware is a USB Key versions of SMS prior to v6.0. The process described 
herein, which has changed from v6.0 - v6.3 Electronic Licenses, removes 
SMS reliance on the USB Key and create an Electronic License Key which is 
stored on the computerôs hard drive, removing the need for the USB Key. The 
Electronic License is bound to a combination of the SMS System Processor 
(SP) host computerôs hardware and ensures that the Electronic License Key 
will only work on one specific computer. The Electronic License Key is 
compatible with VMware and Hyper-V virtual systems. It is not transferrable 
to another computer. 

In order to create an Electronic License Key:  

1 Install SMS v6.4.x or newer. 

2 Restart the system as instructed after installation or start the System 
Processor (SP) manually after database installation. 

3 The SP will create the "Installation License" which will allow unlimited 
access to SMS features for 5 days. The SP will create a Locking Code 
for the SP Host computer during this process. The Locking Code will 
be embedded in the encrypted License File (SMS.lic) located in the 
SMS BIN folder on the SP Host computer. 

4 Furnish the SMS.lic file and Device Inventory Report to Vanderbilt 
Industries via SMSElicense@VanderbiltIndustries.com within 5-days 
of installation. 

5 Vanderbilt Industries generates a unique License string from the 
Locking Code which will grant the customer's specific SMS options.   

6 The Customer uses Windows Explorer to copy the new SMS.lic file and 
replace the "Installation" SMS.lic file on the server or workstation 
running the SP to install the permanent license. 
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Installing the Electronic License Key 

Separate installation of an SMS License Key is not required before installing or upgrading to SMS v7.0.x. 

A v7.0 Electronic "Installation License" Key will be installed on initial startup of the SMS System Processor (SP) 
after installing SMS. 

Note: The new v7.0 "Installation License" will allow unlimited use of all SMS features, including unlimited Online 

and Offline Devices and V-VMS Cameras for a period of 5-days. 

Warning: The SMS "Installation License" will expire 5-days after initial startup of the SMS SP and CANNOT BE 
RENEWED. Send a copy of the SMS.lic file to Vanderbilt Industries at SMSElicense@Vanderbilt Industries.com 
along with a Device Inventory Report and SMS purchase confirmation within 5-days of installation to receive a 
permanent SMS License. 

Creating a Locking Code 

Prior versions of SMS required a separate utility to create a Locking Code for SMS Licensing. 

The Locking Code for SMS v6.4 and newer will automatically be created by the System Processor (SP) on initial 
startup. No additional action is necessary. 

The Locking Code will be embedded in the "Installation License" file created in the SMS BIN folder on the SP host 
computer. 

Transmit a copy of the SMS.lic file to Vanderbilt Industries at SMSElicense@Vanderbilt Industries.com along with a 
Device Inventory Report and SMS purchase confirmation within 5-days of installation to receive a permanent SMS 
License. 

Installing the License File 

Once you receive the License File (.LIC) from SMS Electronic License Processing, it must be installed. Follow the 
instructions below to install the License File.   

1 Login to Windows using an administrative account on the System Processor (SP) Host Computer. 

2 Stop the SP Service using Windows Service Manager (or issue "Net Stop SMS_SP32" at an administrative 
Command Prompt). 

3 Navigate to the BIN folder of SMS 

4 Copy the new SMS.lic file over the old SMS.lic file. 

5 Restart the SP Service using Windows Service Manager (or issue "Net Stop SMS_SP32" at an administrative 
Command Prompt) to implement the new license. 

Note: The SMS View SP Status application can also be used to display the permanent licensed features. 



...   
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Updating an Electronic License Key 

If the SMS System is to be expanded beyond its original License, either for more client workstations or additional 
features (such as Guest Pass, API or additional V-VMS cameras) then the current Electronic License Key will need 
to be updated to give the system access to the new features.   

To update the Electronic License Key: 

1 Navigate to the BIN folder of SMS 

2 Email the SMS.lic file to SMSElicense@VanderbiltIndustries.com to request the License Update. 

3 Installing the License File -- Follow the directions above in the Installing a License File section. Once 

completed the Electronic License Key will be updated.   

Note: Vanderbilt Industries must process the update request and send the new license file. This service is 

only provided during standard business hours Monday through Friday. The new system features will not be 
activated until the Electronic License Key has been updated. Send the current SMS.lic file to 
SMSElicense@VanderbiltIndustries.com. 
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Upgrade Instructions 

Software Upgrade for Multiuser Server/Single User System 

Note: Prior to performing the upgrade, discuss SQL backup procedures with your IT department. 

The SMS database upgrade MUST be performed on the system hosting the SQL database engine. 
The operator performing the upgrade must be the owner of SMS SQL database and must have full administrator 

rights to the host system and the folder where the SMS is installed. 

SMS License Update 

WARNING 
SMS v6.4 and newer will install a new format SMS Electronic License on upgrade from any previous version of 
SMS. See "Electronic License Key Installation" for details. SMS v7.0 Does Not support v6.0 - v6.5 Electronic or 
USB Dongle License Keys. 

Re-installing SMS v7.0 WILL NOT install a new "Installation License". A permanent SMS Electronic License 

MUST BE OBTAINED within 5-days of the initial install and startup of SMS v7.0. 
 
SMS Permanent License Requests Must Be Accompanied the Device Inventory Tool report. The report will insure 
that sufficient online and offline Device Licenses for currently installed devices are purchased and provided. 

Note:  The example system below happens to have the SP hosted on the same system hosting the SMS SQL 
database engine. 

SMS Server Upgrade 

1 Insert the SMS USB installation media on the SMS SQL database engine host system. 



...   
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2 Double-click the 7.0.0_SMS_Server_Upgrade.exe file. 

REPLACE 

3 Upgrade Prerequisite Checks: 

1. The upgrade installer will determine the Operating System installed on the host. 
If an unsupported Operating System is detected a message will be displayed and the upgrade will be 
terminated. Contact Vanderbilt Technical Support for upgrade / migration assistance (may be billable). 

2. The upgrade installer will determine the SQL Server version installed on the host.   
SMS supports systems with SQL 2012 ï 2019.  
If an unsupported SQL version is detected a message will be displayed and the upgrade will be terminated.  
Contact Vanderbilt Technical Support for upgrade / migration assistance (may be billable). 

3. Finally, the upgrade installer will determine the currently installed version of SMS. 
If an unsupported SMS version is detected a message will be displayed and the upgrade will be 
terminated. Upgrades to SMS v7.0.x can only be performed directly on SMS v6.1.x or above. Contact 
Vanderbilt Technical Support for upgrade / migration assistance (may be billable). 
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4 A reminder to backup the SMS database prior to the upgrade will be presented. 

If you have already backed up the SMS database Click No and skip to the next section. 

 

1. Click Yes to invoke the Database Maintenance Utility and create a current database backup. 

2. Enter the credentials for the SMS master administrative account. The Login Name should be pre-
populated. 

The Vanderbilt default credentials are SMSAdmin with password SECAdmin1. 

 



...   
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3. Select the Tools menu and click Backup Database Now. 

 

4. The Cancel & Save as well as the Exit buttons will be disabled during the database backup. 
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5. Select Exit (without saving) from the Tools menu once the backup completes (evidenced by the 

buttons becoming enabled). 

 

5 Re-run 7.0.0_SMS_Server_Upgrade.exe from the SMS v7.0 distribution media, as above. 

6 Select No to continue without backup up the SMS database. 



...   
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7 Click Next on the Welcome dialog to initiate the upgrade. 

REPLACE 
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8 Accept the Vanderbilt SMS License Agreement.  Click Next. 

 



...   
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9 The upgrade installation will begin. 
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10 Review the Release Notes, especially the Device Licensing changes implemented for v6.4.5 

Click Next. 

REPLACE 

11 The database upgrade process will begin. SQL statements executed will be visible as they are processed. 

 



...   
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12 Click Finish once the SMS database upgrade completes. 
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13 The remaining files will be copied to the SMS install folder structure. 

 

14 Enter credentials for an SQL sysadmin Server Role account at the Reset System Operators Database 
Login dialog. 

Vanderbilt recommends using the built-in SQL sa account (Vanderbilt default password = SECAdmin1). 
However, if your IT policy prevents using the sa account, enter the sysadmin credentials provided by your IT 
personnel. 

 



...   
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15 Click Next to initiate Operator Reset. 

 

16 Click Finish. 

 

17 You may see additional dialog messages regarding the Calendar Managed Intervals Management and SP 
Services and Database Maintenance Utility 
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18 Click Finish once the successful upgrade dialog below is displayed. 

 

19 Vanderbilt recommends rebooting the server when prompted. 

 
 



...   
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System Launcher 

The user can access the SMS modules using the launcher. The system launcher program can be customized by 
creating launcher groups. The modules available for a user are based on the user login. The icons representing the 
applications can also be re-arranged separately for each group. 

Note: The version of the database must match with the version of the System Launcher.  If there is a mismatch 

between these two, the System Launcher cannot be run. 

 

Note: System Launcher is two separate programs, LauncherV5.exe and LauncherGUI.exe.  This is not visible to a 

user except as a process in Windows Task Manager. 

Creating Launcher Groups 

1 Select Launcher Group > New Group. 

2 In the New Group window, enter a name for the group and click OK. The new group tab appears on the 

launcher window next to the all applications tab. 
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Default User ID and password 

SMS Software is shipped with default User ID and Password given below: 

User ID = "USR" 

Password = "Vanderbilt2020$" 

Note: the password is case sensitive and must be entered exactly as above; otherwise you may get an Access 

Denied message. 

1 From the desktop click on System Launcher icon. 

 

2 Enter your assigned user id and the password. The system launcher window is displayed. 

Note: The modules that are available on this screen depend on the security group assigned the privileges assigned 

to that group. See System Security chapter for further details. 

SMS v7.0 supports creating Operators that are linked to customer Active Directory user accounts which will use 
a trusted connection to the SMS SQL server in lieu of non AD-linked Operator SQL logins. Therefore, if an SMS 
AD-linked Operator is not the same AD user currently logged into Windows, all SQL operations and auditing will 
indicate the Windows logged user rather than the Operator logged into SMS. 

Adding applications to the Launcher Group 

Note: The applications in the All Applications factory provided tab cannot be modified. This tab always has all 

applications the current user has permissions to launch. 

1 To add applications to user created groups, select the new launcher group tab you want to add applications. 

2 Select the Launcher Group > Add Applications to Current Groupé menu item. You can also right 

click inside the group window and then select the Add Applicationséfrom the menu. 

3 Now select the applications you wish to add from the Search for a Launcher item window. Multiple 

applications can be selected by holding down the Ctrl key. Then click the OK button. The applications that 

are selected will now display in the new launcher group. 



...   
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Note: Duplicate applications cannot be added to the same group. 

Deleting applications from user created groups 

1 Select the launcher group you want to delete applications from.  Select the applications you want to remove 
from the group. You can select more than one application. 

2 Select Launcher Group > Delete Selected Items from Current Group menu item. You can also 

remove applications by pressing the Delete button on the keyboard. 

Note: Before deleting applications from the launcher group, the system will not display any confirmation 

message. 

Renaming a Launcher Group 

Follow these steps to rename a launcher group. 

1 Select the tab you want to rename. 

2 Select the Launcher Group > Rename Current Groupé menu item. You can also access this option 

from the right mouse click menu. 

3 You are prompted to rename the group. Enter the new name (up to 64 characters) and select the OK button. 
The group will now show its new name. 

Arranging the icons of a Group 

You can arrange the icons in each group separately. 

1 Select View > Arrange Icons by > Name option. This will sort the icons alphabetically.   

2 You can also select the auto arrange icons option. When auto arrange is turned off, the icons will stay where 
they were placed. Resizing the window does not change the position of the icons. There can also be space 
between icons. The Auto Arrange option is automatically enabled when a new tab is created. 

Icon - Views 

There are three different types of icon views: 

1 Icons - This view will display with a 32x32 pixel icon with the caption underneath it.  Icons can be dragged 

around in this view.  This is the default view of a new group. 

2 List - Icons will display with a 16x16 pixel icon to with the caption to the right of it. Icons will fill each column 

before going to the next.  Icons cannot be dragged with this view. 

Details - There are two columns in this view. Icons cannot be dragged with this view. Columns can be sorted 

by clicking the title of the column. 

First Column - Icons will display with a 16x16 pixel icon to with the caption to the right of it. 

Second Column -The description given to the launcher item in System Security. 

To change the icon view, follow these steps: 
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a) Select View menu group. You can also change the icon view by selecting the view buttons located next 

to the Log Out button. 

 

b) Select the appropriate icon view: Icons, List, or Details 

c) When auto arrange is turned on, the icons will automatically move to fit the window and there will be no 
gaps between icons. 

Launcher Group Properties 

Each launcher group can have their own set of properties. These properties include: 

Á Background image 

Á Background color 

Á Font Style, color, and size 

Follow these steps to setup the properties of a launcher group: 

1 Select the Launcher Group menu group. Select the Launcher Group Properties menu item. Alternatively, 
you can right click on the group window and then select the Properties menu item. This will bring up the 

Launcher Group Properties dialog. 

 

2 The first field in this dialog is the background image. The button Select Background Imageéallows the 
user to search for an image file (*.bmp, *.gif, or *.jpg). Once an image is opened, the Example field at the 
bottom of the dialog will display the image. You can adjust the brightness and contrast of the image using the 
slider. 

3 The Clear Background Image button clears the current image. The Example field at the bottom of the 

dialog will be updated with no background image. 

4 The Background Color option is used to set the color of the group window. 

Note:  If a background image is selected, the background color will not be visible. The image overrides the 
color. Using the background color control will bring up a color palette, allowing the user to select any color 
they want. Once a color is selected, the óExampleô field at the bottom of the dialog displays the new color. 

The next fields are the settings for the font of the icons. The font face, size, color and style can be selected 
using these options. 



...   
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5 The font combo box displays all the fonts currently installed on the users system. The user can select any font 

they wish.  The Size  option changes the font size. Six is the minimum, twenty four the maximum, and eight is 

the default.  The Color field changes the font color. This brings up the same dialog as the background color 

control. 

Note: You should not pick a font color that cannot be seen easily because of the background image or 

background color. The example field towards the bottom should help the user select an appropriate color. 

The font styles bold and italics can be changed by toggling the corresponding buttons.  Any changes to the 
font will be displayed in the example control allowing the user to see what the changes will do before actually 
applying them. 

6 Once the user is satisfied with the example shown, select the OK button. The Cancel button will exit the dialog 
without applying the changes. 

Rearranging Launcher Group tabs 

Launcher group tabs can be rearranged using a drag and drop approach. 

1 Start dragging by selecting the tab you want to move. 

2 Then drag the tab to the position you want to move it. It must be dropped onto the tab you want to change 
positions with. Release the mouse.  The tabs should be in their new spots. 

Recently Launched Applications 

The launcher now keeps a list of the last ten applications launched in a recently launched drop down box for quick 
access. The combo box is part of the toolbar. The most recently launched applications are on the top. 

To launch a recently launched application, follow these steps: 

1 Select the application in the recently launched drop down box. 

 

2 Click the lightning bolt button to the right of the drop down box. 

Note: The lightning bolt icon to the left of the combo box launches the application selected in the group 

window. 

3 Select the lightning bolt button to execute the application or select File > Execute option. 

4 You can also access all recently launched applications by following these steps: 

a) Select the File > Reopen menu group. 

b) Select the application you want to launch. 

Exiting Launcher 

1 To exit the launcher window either select the Exit the System Launcher button or select File > Exit 
option. 
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Logging out of the system 

Logging out the system prevents an unauthorized person from accessing the system at your security privilege level 
and ensures that the system attributes the operator activity to the correct operator. Logging out automatically closes 
every system function, except any open modules that are in the system start up window. 

1 To log out from the system, click on the Log Out  button on the launcher window. You will be prompted to 
confirm the action. 

2 Click Yes log off or click No if you want to cancel logging off. After you log off, the system will prompt you with 

the Log In window. This indicates that your workstation is still active with modules running. You can access 

the applications at any time you want by logging into the system. 

Note: Log out of the system when you leave the station unattended. 

3 If you want to exit from the system, close the launcher window. You will be prompted to confirm the action. 

4 Click Yes to exit from the system or click No to cancel the action. 
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Checking Database Space 

The Launcher now has the Database option at the top of the window.  The Database option allows the user to 
quickly view how much space is remaining in the SQL Database. When clicked on it opens a chart showing the 
database space used, remaining, and how much space is left for expansion.   

Depending on which version of SQL is running the SMS database, there are different space thresholds: 

Á SQL Express 2012 - 2019 have a maximum database size of 10 GB 

Á Full Version of SQL has no database size limit 

If the Database has enough remaining space the chart will show information in Green.  When the database is low 
but not critical, the chart will show in Orange, and when the database is critically low, the chart will show in Red.  
When a full version of SQL Server (non-Express edition) is in use, the chart will only show how much space is used 

and how free space is allocated.  To close the chart, just click the Close button or hit the red x in the upper right 

corning of the window. 

 
A database with enough remaining space  
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A database that is getting low on space 
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A database that is critically low on space 

Allocated/In Use - Displays how much space is being actively used by the database.  

Allocated/Not In Use - Displays how much space is being saved for use by the database but is not currently 

being used.  

Potential Expansion Space - Displays how much space is open for expansion of the database.  This option will 

not appear in Full versions of SQL.   

Note: Once the system has only 25% of usable space left in the database, this chart will be automatically displayed 

upon login to warn the user that the database is low on space.  

 

Customer support 

If you face any problems while installing this software, please contact the technical support for assistance. 

Technical support help line - 855-316-3900 

E-mail - techsupport@vanderbiltindustries.com 
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Hours of operation 

Our standard Technical Support hours are from 8.00 am to 8:00 pm Eastern Standard Time, Monday through Friday, 
excluding Vanderbilt Industries observed holidays. 

After hours calls and those placed on holidays will be directed to Technicians on a rotating basis. After dialing the 
main number, leave a message in the Technical Support voice mailbox and the message will be routed to the 
Technician on duty. 
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C H A P T E R  2  

Introduction 

The Registry Editor  contains SMS Registry Settings . The five tabs are System Information, System Processes, 
Database Connection, Report Database Connection and Alarm Monitor. The original settings are entered during the 
SMS Software installation and can be modified using this module. 

Note : As with any software product, incorrectly changing system settings can render your application inoperable. 
Please record all settings from all tabs before modifying any fields. If you have any questions, contact the Vanderbilt 
Technical Support team. 

This is a control module and only trusted SMS Administrators should be given privileges to access this module. 
Extremely important and confidential database criteria are contained on these tabs. 

Accessing the application 

1 Select Start > Programs > SMS > Registry Entry . 

Settings 

When the module is opened, the System Registry Settings are organized under five tabs. Use the arrows to scroll 

through the five tabs. The default tab is System Information and it will remain active tab until a different tab is 

selected. 

Registry Editor 
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System Information 

This tab contains the path and name of the SMS system folders. The example below shows the path of a single 
user system. The Executable and Help folders generally will reside on the local workstation while the System Data 
folder resides on the server in a Client\Server Installation. Use the expand button (ellipsis) to modify folder locations. 

 
 

System Processes 

The System Processor and Communication Interface Module computer names are identified here. These 

names are provided during the SMS installation and are also stored in the host file. 

CIM names are also defined in the System Manager  module. 
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Database Connection 

In the Database Connection tab, the Server Name, Database Name, Database Login, Database Password and Data 
Source are available. Use the local computer name as the server name on a single-user system. 
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A new selection has been added for "Service Login uses AD Account". If this option is selected, the Database Login 
and Password are not utilized and all SQL connections for all SMS services running on this workstation (SP, 
Gatekeeper, mCIM, DSR Bridge, Video Service, Calendar Managed Intervals Service and/or Report Launcher 
Service) will be made with the Active Directory service account configured for each service in the Windows Service 
Properties dialog, Logon tab (SP example shown below). 

 

The service account must be manually configured on the SQL Server with appropriate permissions to the SMS 
database AND full permissions to the SMS Data Folder. 

A new selection has been added for "Database Login uses AD Account". If this option is selected, the Database 
Login and Password are not utilized for SMS applications running on this workstation and database connections will 
be made with the Active Directory account for the SMS Operator. However, any SMS Operators using this 
workstation and running the Database Maintenance, System Security or the Report Launcher (Restore Archive 
History only) applications require elevated permissions outside the SMS database. 

SMS Operators (traditional SQL logins or Active Directory linked Windows logins) running Database Maintenance 
or Report Launcher Restore Archive History require "Database Login uses AD Account" DISABLED on the 
workstations running those functions. The Database Login SQL account (SMSAdmin) is required due to the elevated 
permissions required to manage SQL Agent Jobs. 

SMS Operators running the System Security application require the db_accessaadmin and db_securityadmin roles 
for the SMS database. 

System Security will assign the required elevated Operator permissions if the Operator's SMS Security Group 
contains access System Security. 

Report Database Connection 

The report setting information is stored in this tab. The Report Data Source  can differ from the Database Data 
Source  to use an alternate SQL Server for reporting. 

SMS v6.4.2 and newer use an ODBC SQL Connection for reports.  

The Report Database entry now contains the 32-bit ODBC DSN instead of the Report Database Hostname. 
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Update the Report Database location by using Windows tools to update the 32-bit DSN. 

 

A new selection has been added for "Service Login uses AD Account". If this option is selected, the Database Login 
and Password are not utilized and all SQL connections for all SMS services running on this workstation (SP, 
Gatekeeper, mCIM, DSR Bridge, Video Service, Calendar Managed Intervals Service and/or Report Launcher 
Service) will be made with the Active Directory service account configured for each service in the Windows Service 
Properties dialog, Logon tab (SP example shown below). 
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The service account must be manually configured on the SQL Server with appropriate permissions to the SMS 
database AND full permissions to the SMS Data Folder. 

A new selection has been added for "Database Login uses AD Account". If this option is selected, the Database 
Login and Password are not utilized for SMS applications running on this workstation and database connections will 
be made with the Active Directory account for the SMS Operator. However, any SMS Operators using this 
workstation and running the Database Maintenance, System Security or the Report Launcher (Restore Archive 
History only) applications require elevated permissions outside the SMS database. 

SMS Operators (traditional SQL logins or Active Directory linked Windows logins) running Database Maintenance 
or Report Launcher Restore Archive History require "Database Login uses AD Account" DISABLED on the 
workstations running those functions. The Database Login SQL account (SMSAdmin) is required due to the elevated 
permissions required to manage SQL Agent Jobs. 

SMS Operators running the System Security application require the db_accessaadmin and db_securityadmin roles 
for the SMS database. 

System Security will assign the required elevated Operator permissions if the Operator's SMS Security Group 
contains access to the System Security. 

Report Database DSN 

Administrative Permissions Are Required to Update the ODBC System DSN 

Use Microsoftôs 32-bit ODBC Data Source Administrator: 

1. Launch an administrative command prompt 
2. Execute ñC:\WINDOWS\SysWOW64\odbcad32.exeò 

 

3. Select the ñSMS_ODBCò entry and click ñConfigureò 
4. Modify the ñWhich SQL Server do you want to connect to?ò value and enter the 

correct SQL Server and SQL Instance name for the alternate SMS report 
database. 
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5. Click ñNextò. 
6. Select ñSQL Server authentication using a login ID and password entered by 
the userò. 

7. Enter the SMSAdmin or equivalent SMS database credentials if you want to 
test the DSN connection before saving. 
The Login ID and Password from the SMS registry will override these values 
within SMS. 

 

8. Click ñNextò. 
9. Click ñNextò. 
10. Click ñFinishò. 
11. A configuration confirmation dialog will be displayed. 
12. If the report database is online, click ñTest Data Sourceò; then click ñOKò 
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13. Otherwise, click ñFinishò. 
14. Click ñOKò. 

The DSN Must Be Updated on all SMS Workstations That Will Execute Reports 

 

Alarm Monitor 

The Alarm Monitor tab provided options for configuring Alarm Monitor notification behavior for the current 
workstation. 
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C H A P T E R  3  

Introduction 

This chapter explains the methods that the system administrators can use to implement and configure the settings 

for SMS. These settings are configured through System Settings module. The purpose of these settings is to 
automate certain processes for devices, badge creation, image capture and handling, expiration indicators, area 
states and door types. It also provides the system administrator with additional levels of security and control. You 
may want to make selections depending on your work need. 

Note: You need to close System Settings application after making any changes in the settings for the change to 

take effect. 

Accessing the application 

1 Open the SMS launcher by double clicking on the launcher icon on your desktop or go to Start > Programs 
> Vanderbilt SMS > SMS Launcher 7.0. Enter your assigned user ID and password. 

In the System Launcher (on page 95 ) window, double click on System Settings icon. 

There are ten (10) different tabs available in this module to configure the default settings. 

Á General  

Á Cardholder Images 

Á Signatures 

Á Online Credentials 

Á Offline Credentials 

Á Area States and Door Types 

Á Badge Printing 

Á Advanced Search 

Á Campus Locks 

Á AD Integration 

System Settings 
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General 

The General tab is divided into the following sections; Expiration Indicators, MRO Settings, Area Access 
Default Date and Cardholder Definition Settings. 

 

Expiration Indicators 

1 Days in Advance to Indicate Expiration - The data entered in this field determines how many days in 
advance you want the system to notify you that a cardholderôs access control rights expiration date is 
approaching. Specific color schemes are used to indicate the access control status. 

For example, if you enter two (2) in this field, the color indicator changes from green to yellow two (2) days 
before the expiration date. Once the expiration date has passed, the access control information field displays 

in red. Indicators are found in the Cardholder Definition (on page 274) and System Manager (on page 
136) modules. 
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MRO Settings 

Apply MRO Set Security when Executing MROs from alarm monitor and graphics -- Security 
Permissions on overrides are determined at the Override Set level and do not affect individual Override Tasks.  If 
an Operator can view overrides at the Override Task level, that Operator's security permissions will not affect what 
overrides are viewed.  If the Operator can only view Override Sets then the Operator's security permissions will 
affect what overrides are viewed.  This setting is used to determine whether an operator can view overrides at the 
Task or Set level when accessing the Override Tasks sub-menu of the Alarm Monitor and Alarm Graphics 
application.  Click on the check box to check (enable) and un-check (disable) the feature. 

Á Unchecked (disabled) -- All individual Override Tasks associated with a reader will be displayed in the 

Override Tasks sub-menu and security permissions will not apply.   

Á Checked (enabled) -- Only Override Sets associated with the reader will be displayed in the Override Tasks 

sub-menu and security permission will apply.  

Area Access Default Date 

When area access is assigned in the Cardholder Definition application, the system automatically assigns the value 
of the activation date. The Area Access Default Date section of System Settings allows the operator to modify this 
default date assignment. The default date can be modified after the cardholder is assigned access.  

The three default date options are: 

Á Previous Date - will set the area access activation date to the current date minus one day 

Á Current Date - will set the area access activation date to the current date  

Á Next Date - will set the area access activation date to the current date plus one day 

Redundant Direct Area Access Cleanup 

Assignment of Area Access can be duplicated by directly assigning a Cardholder to an Area (Direct Area 
Access) and by also linking a Cardholder to a Category or Area Set (Linked Access) and may result in 
duplicate entries in the SMS database. These duplicate records do not affect the Cardholders access, 
but they can affect overall system performance. If access is being migrated from Direct Area Access to 
Linked Access, it might be beneficial to remove the duplicated Direct Area Access records leaving only 
the access records assigned via Linked Access. Click ñPerform Cleanup Nowò to remove duplicate Direct 
Area Access records from the SMS Database. 

This operation can take a long time and affect SMS system performance while underway. 
Vanderbilt recommends performing this operation during slow or off-peak hours. 

Cardholder Definition Settings 

This section is used to set the Cardholder Definition application settings.  

Enable Vanderbilt Enrollment Reader 

Check this option to retrieve the Encoded ID of a card and save it to the database using an enrollment reader device. 
This automated process is useful when multiple cardholders are being added to the system. The users can save 
time because additional keystrokes are avoided and it eliminates the possibility of typographical errors. 
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Á Com Port - Use this drop down menu to specify the Com Port of the enrollment reader.   

Use Default Expiration Date 

Check this option to set a default expiration date for cardholder access. Using the calendar available from the drop 
down menu, choose a date that will be used globally for all new cardholder access expiration. 

Duplication Policy 

The options under Duplication Policy determine the effects, if any, that the Security Permission of the Operator will 
have on Area Access, Cardholder Categories and UDFs when duplicating cardholders.  See the Cardholder 
Definition chapter for details on duplicating a cardholder.  

Select which option to use:  

Á Permit - All Area Access, Cardholder Categories and UDF records are duplicated without checking the 

security permissions of the Operator. 

Á Limit - Only Area Access, Cardholder Categories and UDF records for which the Operator has read/write 

permissions (or greater) are duplicated. 

Á Block - If the Operator does not have read/write (or greater) permission to every Area Access, Cardholder 

Category and UDF record to be duplicated, none are duplicated. 

If Area Access, Cardholder Categories and UDF records are blocked fully or partially from duplication due to this 
feature, a warning will appear in Cardholder Definition informing the Operator of the security conflict. 
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Cardholder Images 

The settings under this section are used for image editing and enhancement. This window is divided into two 
sections. 

Á Image Handling (on page 117) 

Á General Image Capture Settings (on page 118) 

 

Image Handling 

1 Default Image Capture Device - Use this dropdown box to select the Image Capture Device that will be 

the default used by SMS when capturing an image.  

2 Image Normalize Modifier -The value entered here determines the number of background color levels 
that can be removed. The default is 20. This field is used when transparency is turned on for an image 
annotation. 
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3 Transparency Color - Click on the expand button to open the color palette. The color selected here will be 

used as the background color to show the transparency effect. 

4 Signature Normalize Modifier -This option eliminates the halo pixels that surround a black and white 

signature. The recommended setting is 100. 

5 Cropping Height and Cropping Width - Enter values for height and width of the cropping rubber band 

(crop box) in the empty fields. 

General Image Capture Settings 

1 Allow Cropping Box to be Moved and Sized - Cropping is a feature that enables portions of an image 
to be trimmed and removed from the original image. When this box is checked, the user can drag, resize and 
reshape the crop box. To activate the crop box in the Cardholder Image screen, click Show Cropping Rubber 
Band icon on the tool bar. 

Drag and resize the crop box using the sizing handles located in the corners and along the edges of the red 
dotted lines. The Crop Box dimensions should match as closely as possible the height and width of the 
Cardholder Image Annotation that was created in the Badge Creation module. This reduces and removes any 
white space around the image on the badge. 

To remove anything outside the red dotted lines, click the Crop Image icon on the tool bar. To save the location 

of the crop box in the Cardholder Definition program, right click within the crop box and select Save Crop 

Box Location. 

2 Automatically Crop after Image Capture - Auto crop is used to select a portion of an image, then 
enlarge and crop it to create a new image. It will crop a portion of the original image and make that portion the 
new saved image when a picture is captured using a TWAIN device or FlashbusMV driver interface. 

When using this feature, it is recommended that no checkmark be placed in the ñAllow Cropping Box to be 

Moved or Resizedò. Once your crop dimensions have been saved (right click in Image View dialog box in 

the Cardholder Definition program and select Save Crop Box Location) turn the Auto Crop feature 

on by placing a checkmark in the box. 

The Crop Rubber band will be in a fixed position. Use the Crop Image icon in the Cardholder Image screen 

in the Cardholder Definition program to create a new image. The cropped portion of the original image is 

contained within the red dotted lines. 

3 Automatic Image Enhancement Utility on Image Crop - Place a checkmark next to this option to 
enable it. When a picture is cropped the Portrait Enhancement Utility displays 15 different views of the same 

portrait. The contrast feature can be adjusted by using the Increase and Decrease buttons on the bottom 

left section of the Portrait Enhancement Utility screen. To select one of these images, simply click in the 

picture. 

4 Enable View Menu Option - Check this option to enable the View menu option to see the actual image in 

the Cardholder Image window. 
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Signatures 

This section is used to set the source option for the location of signature files.   

 

Default Signature Capture Device - Use this dropdown box to select the default method that signature files 

will be entered into SMS.   

COM PORT - If using a signature pad to input signatures, click on this drop down menu to assign the signature 

padôs COM PORT (the port to which the signature pad is connected to capture the signature). 
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Online Credentials 

In this section you can find the settings for enrollment reader, credential issuance, and PIN calculator. 

 

Enrollment Reader Setting 

1 Enable Enrollment Reader - Check this option to retrieve the Encoded ID of a card and save it to the 
database using a reader device. This automated process is useful when multiple cardholders are being added 
to the system. The users can save time because additional keystrokes are avoided and it eliminates the 
possibility of typographical errors. 

2 Enrollment Reader - Use the ellipse button to open the Select Reader sub window. Highlight the reader 

and click OK to assign the reader. 



...   

 

 Chapter 3    System Settings 121 

 

 

Credential Issuance Settings 

1 Retire Active Credentials on Insert of new Credential Record - Check this option to enable the 
functionality to retire active badges when adding a new badge record. Retiring a credential takes away the 
access control privileges of that particular badge. This feature ensures security in case a cardholder loses 
his/her badge. This also prevents a cardholder from having more than one active badge at a time. The operator 
can retire the lost badge and assign a new badge to the cardholder. If you check this option, when you assign 
a new badge to an existing cardholder, a window pops up giving you an option to retire the existing credentials. 

2 Enter Encoded ID and Stamped ID Later - This option allows the user to create a blank badge (a badge 
without an encoded ID and Stamped ID). In the Cardholder Definition program, while adding credential 
information the user gets an option to enter the encoded ID and Stamped ID later. 

3 Auto Generate Stamped ID - Check this option to make the system generate the Stamped ID 

automatically. 

4 Stamped ID Modifier - Enter a number in the empty field. When you assign a credential to a cardholder, 
the system calculates the Stamped ID or Encoded ID automatically. If you add Encoded ID, the system adds 
the value that you entered with the Stamped ID Modifier value and creates the Stamped ID. For example if 
your Stamped ID modifier is 10 and the Encoded ID is 250, your Stamped ID will be 260. 

It works the opposite if you enter Stamped ID. In this case, the value will be subtracted from the Stamped ID 
modifier and creates the Encoded ID. For example if your Stamped ID modifier is 10 and the Stamped ID is 
250, your Encoded ID will be 240. 

Note: The Stamped ID Modifier feature will only work if the user is using the Encoded ID input method. 

This feature cannot be used with the Raw Data input method. 

5 Credential Insert Partial Automation Mode - Place a check mark in the box to enable partial 
automation feature. When the Add Credential option is selected on a new cardholder record, a blank credential 
record (a credential record without a Stamped ID and Encoded ID) will be automatically generated. 

Note: In partial automation mode, Encoded ID and Stamped ID will not be generated, and must be entered 

manually. To enable the badge automation features, you need to first select the option Enter Encoded ID 
and Stamped ID Later. To generate badges automatically, you need to have a user-defined field linked to 

a badge technology and badge layout using UDF Cross Reference program. 

6 Credential Insert Full Automation Mode - If this option is enabled, when you create a cardholder in the 
Cardholder Definition program, as soon as you capture a cardholder image a blank credential record is 
created. 

Note: Badge Insert Full Automation feature also works in conjunction with the UDF Cross Reference 

Program. 

7 While inserting a new credential record default to the last used badge layout - Selecting this 

option forces the system to default to the last used badge layout. 

8 Magstripe Credentials Input Method - There are three options; Encoded ID Only, Raw Data Only, 

Encoded ID or Raw Data. See Offline Credential Settings section for more details on this option. 

9 Card Formats Used in the System-  Before creating any Magstripe or Proximity CM Credentials, the 
card formats used for these credentials must be selected here.  Click on the expand button to add, delete and 
modify the card formats used in the system. 

Note: For details on adding the card formats refer to the Offline Credential Settings section. Custom card 

formats can be created using Card Format Editor program. 
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10 Pin Calculator Setting: Use Encrypted - Check this option to automatically use SMS Encryption to 

calculate a PIN for the Keypad ID field in the Cardholder Definition program. The encrypted number is 
based on the cardholderôs Encoded ID number. If unchecked, the system will use standard encryption for the 
Keypad ID number. 
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Offline Credentials 

The Offline Credential Settings tab is used to set the default values for offline locks.  This tab contains two 

sections. 

Á Global Offline Credential Settings (on page 123) 

Á Current Workstation Offline Credential Settings (on page 126) 

 

Global Offline Credential Settings 

This section contains all the offline credentials settings that are applicable to the entire system. 

Note:  Only users with Administr ative  rights to the System Settings  module are able to modify these settings. 
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1 Minimum PIN Length -  This is the minimum PIN length a user can have when defining a PIN offline 
credential.  The PIN Length can be between three (3) and eight (8) digits.  The default is eight (8) digits. The 
following is a chart of the possible amount of unique PINs according to the PIN Length. 

PIN Length Possible amount of unique PINs 

3 125 

4 625 

5 3125 

6 15625 

7 78125 

8 390625 

2 Auto Retrieve PIN Length -This is the length that an automatically generated PIN will use. You can now 

auto-generate PIN numbers in the Offline Credential Definition dialog in Cardholder Definition by 

selecting the credential technology as PIN, and then clicking the Auto Retrieve button. This feature will use 

the minimum PIN length specified here. The default is eight (8) digits. 

Note: This setting applies only to PINôs; it does not apply to Keypad IDôs. 

3 Minimum Keypad ID Length -  Specify the minimum length required for the Keypad ID. The value can be 

between 3 and 8 digits. The default is 4 digits. 

4 Stamped ID Modifier-  Enter a number in the empty field. When you assign a badge to a cardholder the 
system calculates the stamped ID or encoded ID automatically. If you add encoded ID, the system adds the 
value that you entered with the Stamped ID Modifier value and creates the stamped ID. For example, if your 
Stamped ID modifier is 10 and the Encoded ID is 250, your stamped ID will be 260. It works the opposite way 
if you enter stamped ID. In that case, the value you entered will be subtracted from the stamped ID modifier 
and creates the encoded ID. For example if your Stamped ID modifier is 10 and the Stamped ID is 250, your 
encoded ID will be 240. 

Note: The Stamped ID Modifier will only work if the user is using the Encoded ID input method. If the user is 

using the Raw Data input method, then it will do nothing. 

5 Automatically create an offline credential when an online credential is created - If this setting 
is enabled, when an online credential is created in the Cardholder Definitions program, a corresponding offline 
credential is also automatically created. 

The following criteria must be followed in order for this feature to work: 

a) The above option in System Settings must be selected. 

b) The Encoded ID must be retrieved using the enrollment reader. After automatically retrieving the credential 
information, the user must not manually change Encoded ID, Credential Technology, and Issue Code. 

c) The user creates a new online credential with an Encoded ID using Cardholder Definitions. Keypad ID is 
optional. This feature will not work with credentials created with no Encoded ID. 

d) When the user saves the online credential using the Credential Definition dialog, the application verifies 
that the same cardholder does not already have an offline credential with the same Encoded ID and 
Keypad ID. If the user already has an offline credential that meets these criteria, then the process stops 
and no offline credential is created. 

e) If an Issue Code is in use by the online credential, it must be supported by the offline credential.  If it is not 
supported, an offline credential will not be created and the user will be notified via an error message.    

f) The system verifies if the cardholder already has the same offline credential. If not, the system will attempt 
to create it.  If an error occurs, the user will be notified of this error with a message explaining the reason 
why the auto offline credential creation feature failed. 
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Note: For further information on Magstripe template, refer to the System Manager chapter. 

6 Card Formats Used in the System-  This setting is used for creating proximity and Magstripe credentials 

for CM Locks. This helps the user to enter the Encoded ID manually. 

a) Click on the expand button, and all the formats used in the system are displayed. You can add, delete and 
modify the card formats used in the system. 

b) Custom card formats can be defined using the Card Format Editor program. 

c) To add a new Card Format Used in the System, select the browse button on the Card Formats Used 
in the System window. 

d) It opens the Card Format Definition window. 

 

e) Click on the expand button next to the Card Formats field.  It opens the following window.  Click on the +  

button on the toolbar to open the Card Format Editor window. Click the browse button, and the Select 
a Card Format window opens. Highlight and select a card format and click OK.  The record appears on 

the Card Formats Used in the System window.  Click Close.  You can see the record in the System 
Settings>Offline Credential Settings>Card Format Used in the System field. 

f) You will not be able to select card formats that are already added. The available Proximity, Magstripe and 
Wiegand card formats are displayed. In the list of card formats, you will see a description and the badge 
format caption. Wiegand badge format is the same as proximity. Select the format you want to add and 

click OK. 

g) Once the card format is selected, you have the option of associating a site code with it. In the previous 
step, if you have selected a Proximity card format (Wiegand), you must enter a site code. To associate a 

site code, type in the site code value. To save the card format, just use the Save button. 

If the site code field is left blank, the Encoded ID input method cannot be used. Only the raw data method 
or auto retrieving the credential will be allowed. Once the first Magstripe credential is created, the system 
will prompt you to save the site code extracted from that card for the card format. 

The site code range will vary depending on the card format chosen. For example, if ñLocknetic 16 digits 
mag card w/7-d site codeò is chosen, then the site code can be between 0 and 9,999,999, but if ñVanderbilt 
34-bit ï Wiegandò is chosen, the site code must be between 0 and 4095. 

Once the card format and site code are entered, click Save to save the information in the system. The 
user can define as many card formats as they want, following the instructions above, but when multiple 
card formats are defined, the user must auto retrieve the Encoded ID using a CM Lock and a CIP. If only 
one card format is defined for proximity, the user can enter the encoded ID manually or use the auto 
retrieve method. 

The same rule applies to Magstripe credentials. If only one Magstripe format is defined in the system, 
then the user can enter the Encoded ID, raw data, or use the auto retrieve method. If multiple Magstripe 
formats exist, then the user can only enter the raw data or use the auto retrieve option. 
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When defining multiple proximity formats, two formats with the same number of bits cannot be defined at 
the same time. For example, the format ñHID 37-bit (16 bits for card id)ò cannot be defined when the 
ñHID/ProxIF 37-bitò has already been defined. You will get an error message.  

h) The same rule applies to Magstripe formats too. You cannot add two Magstripe formats with the same 
number of characters. 

A brief note on site codes 

Only one site code can be defined for a single card format. When creating credentials using the Encoded ID 
method, this site code will be used to construct the raw data for that card. If you happen to have the same 
card format with different site codes, you must use the auto retrieve option or enter the raw data for the card. 
If you use the Encoded ID method, the credential will receive the site code that was defined in the Card Format 
Definition window. If you enter the raw data or use the auto retrieve option, the system extracts the site code 
from the card. This is the reason why these methods allow different site codes. 

7 Magstripe CM Credentials Input Method -  This setting is used for creating CM lock credentials in 
Cardholder Definition. The drop down menu has three items. Encoded ID Only, Raw Data Only, and Encoded 
ID or Raw Data. 

 

a) Encoded ID Only -  When this method is selected, the user can only enter the Encoded ID when creating 
Magstripe CM credentials in Cardholder Definition. The user will see the caption ñEncoded IDò above the 
text box. For this method, you enter a small number, 10 digits or less, that is written on the card, usually 
on the back side. When the Encoded ID method is used, the raw data is automatically generated using 
the Encoded ID entered and the Site Code defined for that format (See section 1 above). The ñVanderbilt 
Encoded Cardò has the Encoded ID printed on the back. So this method should be used for those cards. 

b) Raw Data Only -  When this method is chosen, the user will only have the option of entering the raw 
data when creating Magstripe CM credentials in Cardholder Definition. The user will see the caption ñRaw 
Dataò above the text box. For this method, you enter all the data from the Magstripe track. This will be a 
long string, up to thirty seven (37) digits, and can contain numbers and a few symbols. The ñLocknetic 16 
digits mag card w/7-d site codeò has the raw data written on the front of it so this method should be used 
for those cards. 

c) Encoded ID or Raw Data -  When this method is chosen, the user can use either of the above two 
options. The user will see two radio buttons on the CM Lock Credential Definition screen. One is for 
Encoded ID and one is for Raw Data. If Encoded ID is chosen, the user must enter the Encoded ID. If 
Raw Data is chosen, the user must enter the raw data. If the user enters the Encoded ID and then switches 
to the Raw Data method, the field is cleared and vice versa. However, there is one exception; if the user 
automatically retrieves the Encoded ID, and then switches to the Raw Data, the user will see the raw data 
for the card that was just auto retrieved and vice versa. 

Note: The selection of the input method only applies while creating new credentials. When editing existing 

credentials, you can always see just the encoded ID. 

Current Workstation Offline Credential Settings 

1 Offline Enrollment Reader COM Port -  Select the com port that the enrollment reader is attached. 

2 Offline Enrollment Reader Time -out -  This is used for auto retrieving the Encoded ID. If you donôt swipe 
the card within the time frame specified here, the enrollment reader operation will be cancelled. You can set 
the time-out period as a value between 5 and 120 seconds. 



...   
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Area States and Door Types 

This section provides a list of all the area states and the door types that have been defined in the database. The 
selections made in this window will set the defaults for Area Access Templates that are assigned to Areas and Area 
Sets in the System Manager program. Place a check mark in the box to select individual items or use the buttons to 
Select All or Deselect All. 
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Badge Printing 

This section contains the default badge print options and the default dossier print options. You can also set the 
default printers and queues. 

 

Badge Default Print Options 

1 Send Badge To Default Printer -  Check this option to set a default printer for printing badges. Whenever 

the user prints a badge, the system will automatically send the data to the default printer. 

2 Send Badge to Selected Printer -  This option forces the user to select a printer from the list whenever 

you print a badge. 

3 Send Badge To Printer Queue -  In the Cardholder Definition program the user has an option to send 
the badge directly to the printer or a queue. This option allows you to send the badge to the queue and print 
later. Badge Queue is the module where badges are stored prior to printing. Badges in a queue can be printed 
individually or in batches. 



...   
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Dossier Default Print Options 

1 Send Dossier to Default Printer - This option allows the user to set a default printer for printing dossier 

reports. Whenever the user prints a dossier the system will automatically send it to the default printer. 

2 Send Dossier to the Selected Printer -  This option allows the user to select a printer from the list 

whenever you print a dossier. 

3 Send Dossier To Printer Queue -  In Cardholder Definition program, the user has an option to send 
the dossier directly to the printer or a queue. This option allows you to send the badge to the queue and print 
later. 

Badge Queue is the module where dossiers are stored prior to printing. Dossiers in a queue can be printed 
individually or in batches. 

Default Printers 

1 Default Badge Printer -  Click on the expand button to set your default printer. If you have selected Send 
Badge To Default Printer option, whenever you print a badge, the system will send the data to the printer 

you have selected here. 

2 Default Dossier Printer - Click on the expand button to set your default printer. If you have selected Send 
Dossier To Default Printer option whenever you print a dossier the system will send the data to the printer you 
have selected here. 

Default Queues 

1 Default Badge Queue -  Click the expand button to select a queue for sending badges. The operator has 
to define queues using the badge queue program. Whenever the user sends a badge to the queue, the system 
will automatically send the data to this particular queue. 

2 Default Dossier Queue - Click the expand button to select a queue for sending dossiers. The operator 

has to define queues using the Badge Queue  program. Whenever the user sends a dossier to the queue, 
the system will automatically send the data to this particular queue. 
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Advanced Search 

In this section you can set the start and end time of the badge creation and badge printing. The system uses this 
information when you perform advanced find functionality. 

 

1 Search for Badges Created Between -  The user can set the start and end time of the badge creation 

here. In the Cardholder Definition program, when the user performs an Advanced Search, the time set 
here will automatically appear in the related fields. The program defaults to 12 AM and 11.59 PM. When you 
run the query, the system will search, and display badges created between 12 AM and 11.59 PM during the 
dates you have specified here. 

2 Search for Badges Printed Between -  In the Cardholder Definition program, when the user 
performs an Advanced Search, the start and end time set here will automatically appear in the related fields. 
The program defaults to 12 AM and 11.59 PM. When you run the query, the system will search and display 
badges that are printed between 12 AM and 11.59 PM between the dates you have specified in the search 
criteria. 



...   
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Campus Locks 

Follow these steps to specify the campus lock settings. These settings need to be specified properly in order to 

encode a campus Magstripe card. Open the System Settings  module. Select the tab Campus Lock Settings . 

 
 

Global Settings 

The first section is the global section. These settings are applied globally throughout the system, and can only be 
changed by an operator with administrative rights to System Settings. 

Á Magstripe Track Number to Encode -  This is the track number of the Magstripe cards that the system 
uses while encoding a card. The user can select Track 1, Track 2 or Track 3. 

Á Note: The actual campus locks come pre-defined with a specific track so this setting must match their setting. 

Á Magstripe Encoder Coercivity  -  The three options in this drop down box are High, Medium, and Low with 
High being the default.   This option must match the Magstripe badges the customer buys. Otherwise it will 
not encode properly and may damage the cards. 
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Á Low coercivity  -  As the name implies, low field energy is used to write data into the magnetic stripe of 
an ID card designed for low-energy encoding. Low-coercivity encoded cards are best used for medium-
use, non-critical, security applications. One of the main benefits of using low-coercivity cards is the low 
cost. 

Á High coercivity -  High-coercivity uses strong magnetic field energy to write data into the magnetic stripe 
of an ID card designed for high-energy encoding. High-coercivity encoded cards are best used in high-
usage environments such as secured installations, where the long-life of the data on the magnetic stripe 
is of extreme importance. High-coercivity cards are resistant to data loss due to the high level of energy 
used to encode them. It is important to use the appropriate encoder-type printer with the appropriate 
coercivity cards. For example, if you use a low-coercivity encoder printer with high-coercivity cards, the 
field intensity created by the encoder will not be enough to permanently polarize the receptive material of 
the card. The magnetic stripe will rapidly lose its encoded information. 

In the opposite case, in which a high-coercivity encoder is used with low-coercivity cards, the magnetic 
field created by the encoder will saturate the magnetic stripe of the card, rendering it useless, and the 
printer will not be able to verify the card. 

Á Site Code -  Select a site code. You need to specify the site code before defining Campus Lock Credentials. 

Á Automatic PIN Length  - This new field is used by Cardholder Definitions, when inserting a new Campus 
Lock credential. The PIN field will automatically be filled in with a random pin number with the length from the 
Automatic PIN Length field. The user can either use this PIN or enter a new one. 

Á Temporary Card Maximum Range (Days from the current date)  - This setting is used within 
Cardholder Definitions when an operator wants to create a temporary campus lock credential for a cardholder. 
For example if this is set to seven (7), then the temporary card can be valid for seven (7) days from the date 
of issue. The minimum is one day and the maximum is thirty one (31) days. 

Á Encode Programming Card -  

Current Workstation Settings 

These will only take effect on the current workstation.  These can be changed by operators who have Read/write 
permissions to System Settings application. 

1 Campus Lock Encoder COM Port - Specify the COM Port the encoder is connected to.  This only applies 
to workstations that have an encoder connected.  Valid values are one (1) to two hundred and fifty five days 
(255). 

2 Campus Lock Encoder Time -out -  This is the amount of seconds it will take the encoder to time-out while 
waiting for a card to be placed into it.  Valid values are five (5) to one hundred and twenty (120) seconds. 

Card Encoder Utilities 

This section has four different functions you can perform with the Card Encoder . 

1 Read Card -  Clicking this will read the track the system is using from a card that is placed into the encoder.  
The data will be displayed in XML format.  Only operators with administrator permissions to this application 
can perform this operation. 

2 Erase Card -  This will completely erase a card that is placed into the encoder.  It will erase all the tracks of 

the card.  Only operators with administrator permissions to this application can perform this operation. 

3 Eject Card -  This option will take a card out from the encoder. 

4 Replace Programming Card -  This button is used to replace old programming credentials with a new 
one. All old programming credentials will no longer work once this card has been swiped at the locks or the 
once the locks are re-programmed. This button will only be enabled in an initial programming credential was 
already created.  After the programming credential is successfully encoded, the user is informed that they 
must register the credential at all locks that do not have it already registered. 



...   
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5 Encode Programming Card -  This function is used to create a master credential that can be used to 

program Cl locks (both legacy and AD250).  Insert the card into the reader and click on the Encode 
Programming Card button.  Once the card is successfully encoded, follow the instructions below to register 

the credential.  

Note: These buttons are only enabled if the user has administrator rights to System Settings. 

Instruction to Register a Programming Credential 

For a legacy CL lock, follow the instructions below.  

1 Open the back of the lock.  

2 On the electronics board, press and release the INI button THREE times.  The red LED will light and remain 

on.  

3 Present the "master" credential to the reader.  The green and red LEDs will alternately flash indicating 
acceptance.  

For a Schlage AD250 CL lock, follow the instructions below.  

1 Remove the lock's inside cover.  

2 While pressing the Inside Push Button, press and release the Tamper Switch 3 times within 5 seconds. 

The IPB red led and left red Schlage LED will turn on. 

3 Insert and remove a "master" magnetic stripe card into the lock.  The IPB red LED and left Schlage red LED 
will turn off.  The Schlage LEDs will toggle green / red 5 times to indicate acceptance of the master card. 

Note: If the card was not a master credential, or was not read correctly, then the Schlage Red LEDs will flash 

2 times, signifying that the master credential was not changed.  

After manually programming the master credential, any previous master credential Card or default master PIN is 
deleted from the lock. 
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AD Integration 

The System Security application now allows linking an SMS Operator to an Active Directory user. If an SMS Operator 
is linked to an Active Directory user, a Windows login will be created on the SMS SQL server and a trusted SQL 
connection will be used for all Operator database access and the Operator login to SMS will use the Operators 
Active Directory credentials. 

The upper half of the Active Directory Tree sub tab allows selecting specific AD container objects that will filter AD 
user searching in the System Security application. Containers to search must be selected for System Security to 
display Active Directory users. 

Highlight an OU or container and click the Select button which will copy the selected item to the lower half of the 
screen. A container object can also be de-selected to remove the filter. 

Items listed in the lower half of the screen will be the only items searched by System Security. If no items are 
selected, System Security will search the entire domain with the permissions of the current Windows user. 

The current Windows user must have sufficient permissions to search the Active Directory for objects containing 
AD users who will become SMS Operators. 
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The Active Directory Search Settings sub tab allows configuration of System Security Active Directory user search 
parameters and can be used to tailor the search experience. 
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C H A P T E R  4  

Introduction 

System Manager is a friendly tool that helps to integrate and categorize your unique company data as well as 
simultaneously monitor and maintain a secure working environment. It helps to define and setup your areas, time 
schedules, device locations, site codes, callback numbers and hardware which control access for all personnel. 

Special attention should be paid to security permissions assigned to this module in the System Sec urity  
application. 

Accessing the application 

1 Open the System Launcher (on page 95) software by double clicking on the SMS icon on your desktop. 

2 Enter your assigned user id and password.  In the Launcher window, double click on the System Manager 

icon. 
 

System Manager 
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Working with System Manager 

Overview 

The System Managerôs main screen is subdivided into three sections for ease of use as well as for the quick display 
of the specified characteristics of your data. The three sections are named the options bar, the tree view and the 
grid view. The options bar is located on the left side of the screen and contains shortcut buttons that quickly opens 
the tree and grid tabs that are associated with its topic. 

These three sections are linked with each other; one section often necessitates definition and clarification in another 
section. 
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The eight features available in the options bar are Area; Area Access; Cardholders; Time Zones, Holidays and Lock 
Downs; Hardware Map; Site Codes; Card Formats and Callbacks. Selecting any one of these panels reveals a set 
of options that are linked to the other two window sections. 

Note: Site Codes and Callbacks options have been split into separate selections in v6.4 and the new Card 
Formats option applies only for Authentic Mercury Controllers. 

The next section is a set of tabs called tree window. Each tab of the tree displays descriptions. The plus icon prompts 
you to create new records. To move up and down the tree, use the arrow icons. 

The bottom section of the System Manager is the information grid. This window consists of tabs that allow for the 
creation of the parameters of the definitions created in the tree grid. For example, as depicted above, if you wish to 
create a time zone interval that allows for security access every day of the week and all holidays, you can create 
the definition in the tree view and then specify the extent of that definition in the grid view.  The status bar shows the 
total number of the records displayed in the grid. 

The definitions created in the tree view often necessitate further description and parameters in the grid view. For 
instance, when you define a time zone in the timezone tree tab, verify that you have also completed the timezone 
intervals located in the grid view. 

Note: Any programming method we show throughout the chapter may not necessarily be the only way to 
accomplish the respective task, but will probably be the easiest. As with all SMS modules, there are several ways 
to accomplish the same task. The quickest way is to use the Options Bar feature which brings the appropriate tabs 
in the Tree and Grid windows forward. Drop down items are available under the Edit and View Menus, tabs are used 
to individually select Tree and Grid View windows. Hot keys are enabled. 

 

Timezone Intervals 

The Timezone Intervals  determine the cardholder's area access time. The system comes with two factory 
provided timezones. The first one is Always which means 24 hours, 7 days a week and Holidays. The second 
provided Timezone is Never, meaning access is allowed at no time and no days. Online system allows unlimited 
timezones, but for an offline system you can define only sixteen intervals per lock. 

The fields with asterisks (*) are required fields. 

1 To create a Timezone, select Timezones, Holidays and Lockdowns on the options bar. 

2 Click on the Timezone Intervals button. The Timezone Tree tab in the tree view is brought forward as well 

as the timezone interval tab on the Information Grid. 

3 Click the plus sign (+)  on the time zone tree tab and add a timezone definition. 



...   
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4 Select the Calendar Managed Intervals option if desired and the Timezone will be used for Automatic 

Overrides only. 

 

1. If the Calendar Managed Intervals option is selected, an additional option, Holidays Observed, will be 

displayed. 

2. Select the Holidays Observed option if Holidays should apply to this Timezone. 

Note: Regular Timezones allow the application of Holidays by individual Timezone Intervals. Calendar 

Managed Intervals require specification of Holiday application for the entire Timezone, not individual 
Timezone Intervals. 

5 Click on Save and Close  to save the definition and close the window and click on Save and New  to save 

the definition and create a new one. Click on Close  to exit the window without saving the definition. 
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6 Standard Timezones (non Calendar Managed Intervals) will display the information grid window as below: 

 



...   
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7 Timezones with Calendar Managed Intervals will display the information grid as below: 

 

Working with Standard Timezone Intervals 

1 Click on the + sign on the information grid window to define a timezone interval. 

2 Set your Interval Start  time and Interval Stop  time (you can use the up and down arrows or enter the time 

directly in the fields) and select the individual Days applicable for this Interval. 
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3 Click on Save and Close  to save the definition and close the window and click on Save and New to save 

the definition and create a new one. Click on Close  to exit the window without saving the definition. You can 
always modify the definition by double clicking on the record or by selecting the record and clicking the edit 
button on the tool bar. The change is reflected in the database. 

Multiple intervals can be defined for a single timezone for the online system. The system does not allow you 
to define timezones that spans midnight (11.59.59 PM). The interval stops at 11.59.59 PM. The system will 
not allow access for 1 second, but you can define a second interval that starts at 12.00.00 AM. The number 
of intervals allowed for a timezone on an online system is unlimited. 

Note : Offline locks support timezones with two intervals only if the timezone interval spans midnight on 
successive days. The first interval must stop at 11.59.59 PM and the second interval must start at 12.00.00 
AM. Any other interval is invalid for offline locks. The timezones that are attached to offline locks can be 
modified, but system does not allow you to delete timezones that are attached to offline locks. 

Working with Calendar Managed Timezone Intervals 

Timezones with Calendar Managed Intervals may be used for Automatic Overrides only. 
Timezones with Calendar Managed Intervals will NOT be available for Area Access assignment. 
Timezones with Calendar Managed Intervals may NOT be used with CM or CL Locks 

1 The default calendar view for the Calendar Managed Timezone Interval is a week vie showing Monday thru 
Sunday 12:00 AM to 11:59 PM. 

2 Use the mini-calendars at the right side to select and highlight multiple days to change the main calendar view 
(e.g. click the first day of the month and drag to select and entire month to change the calendar to a Monthly 
view). 

 



...   

 

 Chapter 4    System Manager 143 

 

 

3 Select any single day to change to a Day view. 

 

4 Up to 6 weeks may be displayed at once. 

5 Click the arrows to the left and right of the top month in the mini-calendars, or click the month to navigate to 
the desired starting month 

6 Creating or modifying Calendar Managed Intervals is similar to working with Calendar appointment in 
Microsoft Outlook. 
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7 Create a new Interval by double-clicking in the calendar view or right-click in the calendar view and select 
"New Event", "New All Day Event" or "New Recurring Event" as desired. 

 

8 This menu may also be used to navigate to a new date as indicated. 

9 Enter the Subject (description of the Interval). 

10 Select the Start Date and Time and End Date and Time. 

Only the Start and End Date and Time values are used by SMS. 
Data in all other fields will be retained and displayed to aid in Operator identification of Calendar Managed 
Intervals but is not used by SMS. 
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11 If an Interval (Event) was not created as a Recurring Interval (Event), the Recurrence button at the bottom 
of the Interval (Event) can be used to change a single occurrence Interval (Event) into a recurring Interval 
(Event). 

 

12 Edit the recurrence settings as desired and click OK. 

13 Click OK to save the new Interval (Event) and it will be displayed on the Calendar view. 

14 Recurring Intervals will display with a circular arrow icon and Subject on the appropriate dates. Hover the 
mouse over an Interval to display the details in a tool tip. 
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15 Non-recurring Intervals will display with the Start Time and Subject on the appropriate date. 

 

16 Add additional Intervals as desired using the same process. 

17 Double-click any Interval to edit its properties; including making exceptions to recurring Intervals. 

Once a Calendar Managed Interval Timezone is created and saved, the Intervals are converted a regular Timezone 
Intervals corresponding to the next 7-days and downloaded to the SMS controllers as appropriate for any AROs 
assigned the Timezone. 

Nightly, the SMS CMI Service, running on the SP host system, will advance all Calendar Managed Intervals for 

the next 7-day interval and download updated data to the SMS controllers. 

The SMS CMI Service is a critical new SMS component and AROs assigned Timezones with Calendar 

Managed Intervals May Not Operate as Expected if the SMS CMI Service is Not Running. 
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Areas and Area Sets 

An Area  is a space or group of spaces that have secured entry ways (e.g. door, gate and turnstile). An Area can 
consist of one reader or a number of readers and can be identified at one location or over several locations consists 
of door types and Area States. 

Areas should be laid out as efficiently as possible. The layout depends on access privileges and the physical layout 
of the building. If there are three lobbies in your enterprise and all employees have access to all three lobbies, then 
it should be defined as one area such as the General Access Area or Main Lobby Area.  These areas can have 
multiple readers, as the cardholders are given access to areas not to the readers. This avoids same cardholder 
records being downloaded to the controller board multiple times and thus wasting the memory space. The area 
access can be controlled based on timezone, door type and area state. 

Areas have State and can be placed into any one of eight (8) states (normal, lock-down, strike and 5 user defined 

states.) Area State  determines who has access to that area during a specific condition or state. For instance, if an 
area is placed in ñstrikeò, only those cardholders who have access during a strike are given access to the area. To 
change the name of an Area State or rename a user defined Area State, select the Area States from the Edit menu. 

 

Area Access 

Vanderbilt recommends using Access Manager for all access management. 
 
Some access management functions may continue to performed via the System Manager application as in 
previous versions of SMS.  However, the Access Manager application consolidates all these functions, adds new 
access management functionality and provides a more rich access management environment.  Offline Lock 

access may now be granted in the same manner as Online Lock access:  include the Offline Lock in an Area 

(with or without Online Locks) and grant access for the Cardholder or Category to the Area (or Area Set). 
 
Access management functions in the System Manager application may be removed in future versions of SMS. 

 

The Area Access option is located in the options bar. This option provides a way to view the Cardholders and devices 
that are attached to an Area. 

1 Readers provide access to Areas -  Displays the readers defined in the system by Area.  Click View > 
Grid Windows > Devices > Readers by Area or Area Access > Readers Providing Access to Area .  
There is no maximum limit to the number of readers that can provide access to the same area.  However, you 
can only select one Area per reader when defining the reader device. 

2 Cardholders with access to an Area -  Displays the Cardholders who have access to an Area.  Select the 

Area and click on Area Access > Cardholders with Access to Area or View > Grid Windows > 
Cardholders > Cardholders by Area . 

An Area Access record is generated for every cardholder permitted in the area.  Cardholders are granted 
Area Access in several ways.  The drag and drop feature is the quickest way to accomplish area access 
assignments. Cardholders can be dragged and dropped into Areas or an Area Set.  Hold the control key down 
to make multiple selections.  An Area or Area Set can be dragged and dropped into a cardholder category 
thereby granting every member of the category area access rights to a particular Area or to the Areas that are 
currently members of the Area Set.  
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Area Sets are groups of Areas to be used as an organizational tool.  An Area can be in more than one Area 
Set.  Area Sets determine the permissions the operators have over Areas.  When an Area is created, it is 

automatically added to All Areas (factory provided Area Set).  Later, the administrator can assign it to the 
appropriate Area Sets as per your company needs.  When you add a new reader to an existing Area, the 
reader will automatically have access to that Area.  When a new Area is created then dropped into an existing 
Area Set, Cardholders of that Area Set are automatically granted access to the new Area. 

3 Contacts attached to an Area  - Displays the contacts attached to an Area.  Select the Area and click on 

Area Access > Contacts attached to Area or View > Grid Windows > Devices > Contacts by Area . 

4 Relays attached to Area -  Displays the relays attached to an Area.  Select the Area and click on Area 

Access > Relays attached to Area or View > Grid Windows > Devices > Relays by Area . 

Navigating Linked Access 

System Manager also provides new functionality to jump directly to Access Manager in the appropriate location for 
editing linked access. 

1 Select Area Access selection from the option bar. 

2 Select Cardholders with Access to Area. 

3 Select the Area Tree tab in the tree view. 

4 Select one or more Areas in the tree view. 

5 Select the Cardholders with Access to Area tab in the grid view. 

6 Right-click on a Cardholder access record with linked access: 

7 The context sensitive menu will display with several options including 2 pertaining to the linked access: 

Á Go to Access Link P.O.V. - Category: CategoryName  

Á Go to Access Link P.O.V. - Area Set: AreaSetName 



...   
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Each option will launch Access Manager opened to the appropriate linked access source  

(either the Category or Area Set which caused the linked access to be granted to the selected Cardholder) 

 
 

Defining Area Sets 

1 Click Areas on the option bar. The option bar for areas expands. Click on Areas by Area Set . 

2 Click the + plus sign on the tree window. The Area Set Definition  window opens. Enter an Area Set 

description and notes associated with it. The Description must be unique. Click Save  and New  for creating 

another area set or click Save and Close to complete the process. 

3 To modify an Area Set, select the Area Set and double click on it or click on the Edit button from the tool 

bar. 

4 To delete an area set, highlight it and press delete on the keyboard or click the - (minus) sign on the System 

Manager window. A confirmation message is displayed. Click Yes to continue and No to cancel the process.  

Note : Deleting an area set will remove any access granted by a link to that area set.   
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The Areas by Area Set window displays, the Areas that belong to the selected Area Set and information 
regarding Area State, Timezone, Area Access Activation and Area Access Expiration. 

 
 

Defining Areas 

1 To define your Areas, click on the Areas Panel in the Options Bar, and click the + sign in the Area Tree tab. 

Offsite is an Area that is already pre-programmed by default (factory set). 

2 Clicking the + sign opens the Area Description window. As an example, we can create an Area Definition 

called Lobby. The Description of the Area must be unique. Select the Area Type. You can select, Normal, 

Two Person Area (Scheduled), Two Person Area (Team). Refer to the Two Person Rule (on page 393) 

chapter to know more about this feature. The Area Type cannot be edited. 



...   
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You will notice in this window, you can also select the Area State, which is a means of defining who can 

access that Area while it is in that state. In this instance, we will use the default state of Normal Access.   

 

3 Select the New Areaôs Initial Area Sets window opens. Click on Add Area Sets. The Search for Area 
Sets window opens. Highlight the Area Sets to which you want the Area to be a member and click OK. Return 

to the window titled Select Area Initial Area Set. Click Finish. 

4 Define additional Areas as desired by repeating the above steps. 
 

Copying Areas to Area Sets 

At any time, you can supplement Area Sets with various Areas you have defined. This function is accomplished 

through Copy Areas  to Area Sets  wizard (Edit > Copy Areas to Area Set) There are two modes to this wizard; 

Basic mode  and Advanced mode . 

Basic Mode 

The basic mode lets you copy areas to area sets and creates an area access template that will be used for area 
access. In the basic mode all the areas copied to area sets uses same values for time zone, access activation and 
expiration time and dates, area states and door types. 

1 Click on the Copy Areas to Area Sets  button on the All Areas  tab of the grid view section (Edit > Copy 
Areas to Area Set ). 

2 The Select Area Sets  window opens. Click on Add Area Sets  to select Area Sets that the Areas are copied. 

Note: The Change the wizard mode  button (this button is located at the bottom left corner of the window) 

allows you to choose between the basic and advanced modes. 

 Important : Changing the wizard from Advanced mode to Basic mode will clear all the selections. 

3 Change the wizard to Basic mode. 
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4 Select the Area Sets you wish to copy the Areas. Click OK. The Area Sets you selected here are displayed 

in the Select Area Sets window. Now you can see that Remove Area Sets and Next  buttons are enabled. 

Click Next to continue. 

5 The Select Areas window opens. Click Add Areas to copy areas to area sets. 

6 A window opens that allows you to select the Areas you want to add to the Area Sets . Select the Areas and 

click OK to continue (hold down the Ctrl key to select multiple Areas together). 

7 Click Next . 

8 A summary of your actions is shown. Click Finish . 

Advanced Mode 

The Advanced mode allows you to copy Areas to Area Sets in one Window. 

1 Follow step 1 in the basic mode section. 

2 Change the mode of the wizard to Advanced. The following window opens. Click Add Area Sets. 

3 A window displays the area sets you created. Select the area sets you want to attach the Areas. Click OK. 

4 The area sets you selected are displayed in the Copy Areas to Area Set wizard. Highlight the area set 

into which you want to attach areas. The Add Areas button is enabled. Click on that button to select the 

areas to be added in the selected area sets. Click OK. 

5 The Area Sets and areas you have copied are displayed.  

6 Click Next. 

7 A summary of your actions is shown. Click Finish . 
 

Cardholder with Access to Area 

The user can run a search for cardholders by category or Area Access. The user can then take the results and add 
them to another area or area set using the drag and drop method. Follow these steps to drag and drop cardholders 
to areas and area sets. 

1 Click on the All Cardholders tab located in the lower pane of the System Manager main window. 

2 Click on the binoculars to search for cardholders. 

3 In the Advance Find of Cardholders  window, click on the button Area Access  or Categories. 

For example, here we have selected Area Access as our criteria. Click on Add Area. All the Areas defined 

in the system are displayed in a different window. 

4 You can select the Areas by running a search and click OK. 

5 Once you click OK on the Select Areas window, the Areas you selected will be added to the Search for 

Cardholders window. Click Find Now. All the cardholders attached with the selected Areas are displayed in 

the main window of the system manager. 



...   
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6 Select and highlight the Area that you want to copy the cardholders. Then select the cardholders and drag 
and drop to the Area you selected. 

 
 

Deleting Areas 

1 If you want to delete an Area, select and highlight the areas you want to delete. 

2 Click the delete button on your keyboard or click on the minus (-) sign on the System Manager main window. 

You get a confirmation message. Click Yes to continue. 

You cannot delete the Areas that have cardholders or other devices attached to them. When you press delete, 
the program checks if there are devices and/or cardholders attached to them. A window pops up telling you 
exactly which devices and/or cardholders are attached. The Areas that cannot be deleted are automatically 
unselected from the grid. The Areas that do not have cardholders and/or devices attached will be deleted. 
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Controller Groups 

A Controller Group is set up to allow Controller Group Antipassback between the Vanderbilt VSRC, VSRC-M and 
VSRC-A based controllers (VSRC, VRCNX-R, VSRC-M, VRCNX-M, VSRC-A or VRCNX-A). If Antipassback is not 
in use, or if there are no VSRC, VSRC-M or VSRC-A based controllers in the system, there is no need to set up a 
Controller Group.  See the Antipassback section for details on the antipassback feature.   

The Antipassback field in the Definition form is on by default and cannot be modified. A maximum of 4 controllers 
can be assigned to a single controller group. A controller can only reside in one group but the software will allow a 
controller to be moved from one group and into a different group.  

Antipassback credential status is communicated using board to board messaging via TCP/IP socket connection to 
reduce network stress. In the event of network interruption of one or more boards within the group, the system will 
sync the boards that are communicating and antipassback will be reset to neutral for all credentials. 

Note: The Domain Suffix must be the same for all controllers in a Controller Group. If a controller is added to a 
group that controller will inherit the Domain Suffix of the group. Controllers in a Controller Group can not have their 
Domain Suffix changed in Controller Definition, it must be changed in the Controller Group section. Contact your 
network technician for details on the effects of changing the Domain Suffix.   

Requirements and Specifications 

The following details the requirements and specifications that must be met in order for a controller to be part of a 
Controller Group:  

CIM 

Á All controller boards in a single group must be attached to the same CIM.  

Domain Suffix 

Á All controllers residing in a Controller Group must have the same domain suffix.  

Á A Controller Group will inherit the domain suffix of the first controller board that is added to the group. 

Á All subsequent controllers added to a Control Group will inherit the Control Group Domain Suffix regardless 
of what was previously defined as the controller domain suffix. 

Á Controller boards and Controller Groups do not require a domain suffix therefore it is possible to add four 
controllers with no domain suffix to a controller group that has no domain suffix. 

Recommendation 

Á Vanderbilt recommends that controller group boards be attached to the same network switch. 
 



...   
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Defining a Controller Group 

1 Select Controller Group from the Areas options tab or click the Controller Groups tabs on the upper 

and lower grids.  

 

2 Click the plus button "+" to open the Controller Group Definition form.  
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3 Enter the Group Description and Notes.  

Note: By default Antipassback is enabled and cannot be modified. 

4 Leave the Domain Suffix field blank for now.   

Note: Domain Suffix cannot be entered until one controller has been added to the controller group. A 
message will display if you attempt to type in this field.  It is not required to use a Domain Suffix. If controller 
boards do not have a Domain Suffix then the Controller Group will remain unpopulated. 

5 The Controller Group has been defined.  Click Save and Close if this is the only Controller Group being 

defined or click Save and New and follow the above steps to define another Controller Group.   
 

Adding Controllers to a Controller Group 

Before a controller can be added to a Controller Group it must be defined in System Manager.  See the Define 
Controllers section for details on how to define a Controller.  Only four controllers can be added to a group.  The 
System will not allow you to add more than the maximum.   

Note: Only VSRC, VSRC-M or VSRC-A based controllers (VSRC, VRCNX-R, VSRC-M, VRCNX-M, VSRC-A or 

VRCNX-A) can be added to a Controller Group.   

To add a controller to a Controller Group:  

1 In System Manager select the Controller Group tab.  

 

2 Select the desired Controller Group.  



...   
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3 Click the Copy Controllers to Controller Groups  button on the upper-grid tool bar. The Controller 
Selection window will open.   

 

4 Click on the Controllers tab.  

5 Select the controller to be added to the group. Multi selection is available by holding down the Ctrl key on 

your keyboard and highlighting several controllers.  

6 Click on OK.   

Á If the controller is not already part of a Controller Group and there is no Domain Suffix conflict the window 
will close and the Controllers will be added to the group (see image at bottom of section).   

Á If the controller is part of another Controller Group a Warning window will open:  

 

Á Click Yes.  The window will close and the controller will be removed from the old group and added to the 

current group (see image at bottom of section).  

7 If the controller had a Domain Suffix differing from that of the Controller Group a Confirm window will open:  

 

Á Click Yes. The window will close and the controller will have its Domain Suffix updated to match the 

controller group and it will be added to that group.   
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8 Select Controllers in Group in the Grid View to see that the desired Controllers are now members of the 
selected Controller Group. 

 

To view a controller's definition window, highlight the controller on the lower grid and double click or highlight it and 

click Edit icon on the tool bar. The Controller Definition window will open and the Controller can be modified.    

 

 

Removing a Controller from a Controller Group 

To remove a Controller from a controller group:  

1 Open System Manager.  



...   
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2 Click on the Controller Group tab.  

 

3 In the bottom grid, select the controller to be removed.  

4 Click the remove button "-".  The Confirm window will open.  

 

5 Click Yes. The window will close and the controller will be removed from the group.  
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Holidays and Holiday Sets 

Holiday Sets are a means of organizing access for employees on both standard workdays and holidays. Creating 
Holiday Sets is particularly useful for international corporations that may have multiple locations and thus need to 
recognize the different holidays of the countries they are in. 

For example, a company with locations and employees in the United States and England will have to differentiate 
its holiday schedule and verify that its employees in England do not have access denied to them on the 4th of July 
which is a holiday for U.S employees. 

You can create as many individualized holidays as necessary and thus set the kind and degree of access to any 
given employee. 

1 To create a Holiday Set, click on the Timezones, Holidays and Lockdowns tab in the Options Grid 
section. Then click on the Holiday Sets tab in the Tree View Section. Click on the +  sign to define the 

Holiday Set. 

2 For this example, we will create a Holiday Set named "American Holidays" Set. Click Save and Close to 

close the window or click Save and New to create another holiday set. 

3 Now, you can define the holidays that are going to be associated with this Holiday Set. 

Note:  Menu and other buttons work in the same way as it works in the time zone definition. The advanced 

find feature allows you to save the search criteria and use it quickly at a later time. Right click on the record 
to select or un-select all the records. 

4 Choose the Holidays tab under the Timezones, Holidays and Lockdowns panel in the Options Bar. 
This opens a tab in the Information Grid called Holidays. Click on the + sign and create a holiday definition for 
Thanksgiving. 

 

5 Specify the start and stop dates of the defined Holiday. This feature is useful especially for corporations that 
have more than one consecutive day as holidays. 

Note: This feature (specifying start and stop dates for a holiday definition) works only with controller boards 

which have firmware version 5.72 or greater. If the controller you are using does not support this feature, the 
system displays an error message. 



...   
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6 Click on the down arrow to display the calendar. Choose the dates. Click Save and Close to close the 

window or click Save and New to define another holiday. 

7 Then you will see your newly defined holiday for Thanksgiving appears in the Information Grid. Select 
Thanksgiving and drag it to the selected American Holiday Set above in the Tree Grid. You will be prompted 
with a confirmation message that asks ñAre you sure you wish to copy the selected Holidays to the selected 

Holiday Sets?ò Click Yes. 

8 To verify that the holiday is in the holiday set, click on the newly defined holiday set in the Tree Grid section 

and then click on Holidays in the Options Bar and all the holidays for that set appears below in the 

Information Grid section. 

You can also create all your holiday sets and holidays separately and then select and drag the Holidays from 
the Information Grid section to any Holiday Set you want them to go into in the Tree View Section. To move 
multiple records to a holiday set at the same time, select the records and hold down the right mouse click at 
the last selection. Then drag and drop the records to the Holiday Set. 

 

Lockdowns (CM Locks) 

Lockdowns allow for a door to be secured Sunday to Saturday at a specific time. It only has one time interval. 
Cardholders will still be able to gain access based on their credentialôs offline function. A door that is in the Lockdown 
state can be opened by sending an Automatic Override. This feature is currently available only for CM locks. A total 
of eight (8) Lockdowns and Automatic Overrides can be added to a lock and may not be exceeded. Lockdowns 
cannot be duplicated on the same lock or an error message is displayed. The user can add or remove Lockdowns 
to a lock. 

1 To define a Lockdown, select the Lockdowns from the Timezone, Holidays and Lockdowns tab. New 

Lockdowns can be defined also from the CM Lock Definition window. 

2 From the Tree View section, click the + sign to add a lockdown. The Lockdown Definition window opens. 
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3 Enter a definition for the Lockdown and notes related to it. Select the Lockdown Time by using the up and 
down arrow. You can also enter the time directly in the field. Select the days by checking the boxes next the 

days. The door will be secured on the days selected here at the time you have specified. Click Save and 
Close to save the information and close the window. Click Save and New to save the information and 

define a new Lockdown. Click Close to close the window and cancel the Lockdown definition. The grid section 

displays the Lockdown interval of the selected Lockdown in the tree view. 

Note: The system will not allow you to attach Lockdowns with the same time schedule or overlapping 
schedule on offline locks. If a Lockdown is scheduled at 10 AM on Monday and Tuesday on Lock 1, you 
cannot again schedule a Lockdown on that lock at the same time for Tuesday and Wednesday since there is 
a Lockdown already scheduled at 10AM on Tuesday. 

 

Editing Lockdowns 

Lockdowns can be edited by double clicking on the record from the System Manager main window tree view. It 

opens the Lockdown Definition window; you can make modifications and save the record. 

 

Deleting a Lockdown 

The user can also modify or delete a Lockdown from the tree view. Double-click on the record and the Lockdown 
Definition window opens allowing modification. Select the record and click the - sign from the tool bar to delete 
the record. If the Lockdown is attached to any lock, the system warns the user before deletion and prompts the user 
to confirm the deletion. 

 

Cardholder Categories 

Cardholder Categories allow the user to group the cardholders for granting access or assigning permissions. This 
feature also works as a filter which allows users to find the cardholders and allow access easily. 

Note: Vanderbilt recommends using different Categories for assigning Access versus granting Permissions (i.e. 

Accounting-Access vs. Accounting-Permissions) 

1 Click on Cardholder Categories from the Options bar. Click the + sign on the tree window and Cardholder 
Category Definition window opens. Enter a description and the notes related to it. The Description of the 

category must be unique. Click Save and Close to complete the step or Save and New to define another 

call back number. Click Close to close the window without saving the definition. 

 
 



...   
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Callback Numbers and Callback Sets 

If you have a modem attached to a controller you need to define a callback numbers. When an alarm occurs, the 
controller calls the numbers that are defined as the callback numbers and the SP sends the alarm to the appropriate 
workstation. Call back numbers can be attached to callback sets. You can define multiple callback numbers to the 
same controller board and add them to a callback set. To define a callback set, follow these instructions. 

1 Select Callbacks on the option bar. Click on Callback Numbers By Callback Set tab. 

2 On the Tree window, click on Callback Sets. Click on the +  icon. The Callback Set Definition window 

is displayed. Add the description of the callback set you are going to define. Add notes if any. 

3 Click Save and Close to complete the step or Save and New to define another callback set. Click Close 

to close the window without saving the definition. 

4 To add a callback number, click on the Callback numbers tab on the Options bar. 

5 On the Grid window click on the add icon (+). 

6 The Callback Number Definition window is displayed. Enter the description, notes and the phone number 

that you want the controller to dial. Click Save and Close to complete the step or Save and New to define 

another call back number.  Click Close to close the window without saving the definition. 

7  You can copy the callback numbers to callback sets using the drag and drop feature. 
 

Site Codes and Site Code Sets 

Every site can be assigned a number ranging from 1 to 1,000,000. Cardholders may be assigned one of these 
numbers for a specific site while the same number will not allow access to another site. Assigning site codes provides 
extra security that stops the cardholders with same encoded ID entering different sites. 

When site codes are programmed and downloaded to the controller, the board checks for validity of that site code 
against the card that has been read. If the site code does not match with what is stored on the board, then access 
is denied to the cardholder. It can be used for readers that have been programmed for degraded mode. Degraded 
mode is used to continue to allow reader access when the controller board loses data communication with the reader 
interface. Therefore, lost communication does not interfere with access being granted because site codes are 
downloaded and retained in the reader interface memory. 

Cards that are purchased from Vanderbilt Industries have the site codes encoded on the card. 

1 To create site codes and site code sets, click on the Site Codes tab in the Option Bar section. Selecting 

Site Codes tab opens the Site Code Sets  tab in the Tree Grid and the Site Codes tab in the Information 

Grid. 

2 Select the Site Code Sets tab in the Tree Grid section and then click on the + sign to add a new site code set. 

3 The Site Code Sets definition window opens. Enter the description and notes for your new site code set. 

For example create a Site Code Set called Yourco. 

If you check the new Yourco Site Code Set, it will be highlighted and then ready if you choose to drag any 

Site Codes into it. 

4 To create a site code, click on the Site Code tab in the Options Bar section and the Site Code tab on the 

Information Grid opens. Click on the + sign. 

5 The Site Codes Definition window opens. Enter the description and notes for the new site code. For 

example, create a site code called Building One. 



 

164 SMS Software Manual Version 7.0.0 

 

After you create your site codes, you can select them one by one and drag them from the Information Grid 
view section to the Tree View section and drop them on the Site Code Set you want them to belong. You get 

a confirmation message. Click OK. 

To select multiple site codes to drop in a site code set, first place a checkmark next to the Site Code Set. 
Then hold your control key down while highlighting the site codes. Drag the selected site codes and drop them 
in the site code set. 

 

Hardware Definitions 

The Hardware Map section is where you define your Workstations, CIMs (Communications Interface Modules), 
CIM Ports, Controllers, Readers, Contacts, Relays, CM Locks, Campus Locks and Direct IP Locks. The number of 
CIMs you need depends on the rate of Transactions the CIM will process and how many Controllers are connected 
(up to a maximum of 64). 

SMS v6.4 introduces support for the Authentic Mercury Controllers and provides options for configuring mCIMs 
(Mercury Communications Interface Modules), mCIM Ports and peripherals connected to the Authentic Mercury 
Controllers in a manner analogous to peripheral configuration for Vanderbilt Controllers. The number of mCIMs you 
need depends on how many rate of Transactions the CIM will process and how many boards are connected (up to 
a maximum of 256).  

Unlike the CIM, which is a Windows Application that must be running in a logged in account, the mCIM is a Windows 
Service which runs in the background and can be set to automatically restart if the host computer is restarted similar 
to the System Processor (SP) Service. The mCIM, as a Windows Service, does not provide a user interface for 
Controller status messages like the CIM application. A future version of SMS will include an mCIM Viewer for 
providing a real-time status interface for the mCIM and connected Authentic Mercury Controllers. 

DNS 

If setting the system up for DNS it is important to remember that the system does not allow partial DNS set up;  all 
applicable hardware must be set up for DNS in order for the system to function.   

Á Workstations, CIMs and Controllers must be configured properly with correct Hostname and Domain Suffix, 
for DNS to function. The Hostname must be identical to the NetBios/machine name for CIMs and Workstations.   

Á Any PIM-400-485-SMS devices defined in the system must have a matching value entered into their Domain 
Suffix field.   

Á Contact your network technician for help setting up the system with DNS. 
 



...   
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Define a Workstation 

1 To define a workstation, select hardware map from the Options bar. Click on Edit Workstations. Click on 

the + Sign. The Workstation Definition window opens. 

 

2 Select User Alarm Workstation to receive the alarms in the alarm monitor or the alarm graphics. The E-
mail Recipient Workstation is where you receive the e-mails of alarms. 

Note: E-mail settings are defined using the System Processor module. Please refer to System Processor 

chapter for further details. 

3 Click on the expand button to select an operator. The operatorôs user id is inserted into the field. 

4 Select a holiday set. 

5 Select a time zone.  

6 Click Save and Close to complete the step or Save and New to define another workstation. Click Close 

to close the window without saving the definition. 
 

Define CIM (Vanderbilt) 

1 To edit or create CIM information, click on the Hardware Map in the Option Bar and then select the Edit 
CIM tab. All the defined CIMs appears in the Tree Grid section on the Hardware Map tab.  

2 Click on the + sign or double click on a selected CIM to open the CIM Definition window.   

3 Select a CIM Type (Vanderbilt or Mercury). The remaining options are different depending on the type of 

CIM selected. The example in this section is for a Vanderbilt CIM. See Define mCIM for an example of 

defining a Mercury CIM. 
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4 Enter the Description and Notes for the CIM. 

 

5 Click on the expand button to select a location. This is the location where the CIM resides. When you click 

the expand button the Select an Area window opens. 

6 Select the number of I/O Port expansion. 

7 Select a Holiday Set. 

8 Select the Report Update Complete Transactions check box to enable reporting of Database Changes 

(recommended for diagnostic purposed only when requested by Vanderbilt Technical Support). 

9 If using DNS (Optional): 

a) Enter the NetBios/machine name of the CIM in the Hostname field.  

b) Enter the Domain Suffix in a the Domain Suffix field.  

Note: Contact your network technician for details on correct Hostname and Domain Suffix.   

10 Select the Installed check box to install this CIM in the system. 

Note: De-selecting Installed check box un-installs all the devices attached to this CIM. 

11 If you have un-installed the CIM, and want to re-install it, select the Reinstall All Devices check box. It will 

re-install all the devices associated with this CIM. 

12 Click Save and Close to close the window or click Save and New to define a new one.   Click Close to 

close the window without saving the definition. 
 



...   
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Define CIM Port 

Now we need to define the CIM ports that the controller will use to communicate to the CIM. 

1 To define the CIM Port information, click on the Edit CIM Ports tab in the Options Bar section. CIM Port 
Definition window opens. 

2 Select a CIM Port Type (Vanderbilt or Mercury). The remaining options are different depending on the type 

of CIM Port selected. The example in this section is for a Vanderbilt CIM Port. See Define mCIM Port for 

an example of defining a Mercury CIM Port. 

 

3 Enter a Description and Notes (if desired). 

4 Click on the expand button to select the CIM that is attached with this CIM Port. 

5 Select the COM Port that is communicating to the CIM, typically TCP/IP or ñNetworkò. 

6 Select the baud rate (communication speed) from the drop down menu if a serial connection is used. 

7 Select the check box if you are using a dial-up connection and you have a modem attached. 

8 Select the Installed check box to install this CIM Port. 

Note: You need to always select the Installed check box. De-selecting this check box un-installs all the 

devices attached to this CIM Port. 
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a) If you have un-installed the CIM Port and want to re-install it, select the Reinstall All Devices check 

box. It will re-install all the devices associated with this CIM Port. 
 

Define mCIM 

1 To edit or create mCIM information, click on the Hardware Map in the Option Bar and then select the Edit 
CIM tab. All the defined CIMs appears in the Tree Grid section on the Hardware Map tab.  

2 Click on the + sign or double click on a selected CIM to open the CIM Definition window.   

3 Select a CIM Type (Vanderbilt or Mercury). The remaining options are different depending on the type of 

CIM selected. The example in this section is for a Mercury CIM. See Define CIM for an example of defining 

a Vanderbilt CIM. 

4 Enter the Description and Notes for the mCIM. 

 

5 Click on the expand button to select a location. This is the location where the mCIM resides. When you click 

the expand button the Select an Area window opens. 

6 If using DNS (Optional): 

a) Enter the NetBios/machine name of the CIM in the Hostname field.  

b) Enter the Domain Suffix in a the Domain Suffix field.  

Note: Contact your network technician for details on correct Hostname and Domain Suffix.   



...   
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7 Select the Installed check box to install this mCIM in the system. 

Note: De-selecting Installed check box un-installs all the devices attached to this mCIM. 

8 If you have un-installed the mCIM, and want to re-install it, select the Reinstall All Devices check box. It 

will re-install all the devices associated with this mCIM. 

9 Click Save and Close to close the window or click Save and New to define a new one. Click Close to 

close the window without saving the definition. 

Define mCIM Port 

Now we need to define the mCIM ports that the controller will use to communicate to the mCIM. 

1 To define the CIM Port information, click on the Edit CIM Ports tab in the Options Bar section. CIM Port 
Definition window opens. 

2 Select a CIM Port Type (Vanderbilt or Mercury). The remaining options are different depending on the type 

of CIM Port selected. The example in this section is for a Mercury CIM Port. See Define CIM Port for an 

example of defining a Vanderbilt CIM Port.  

 

3 Enter a Description and Notes (if desired). 

4 Click on the expand button to select the mCIM that is attached with this mCIM Port. 
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5 Select the appropriate TLS Security options: 

a) Select the Required check box to enable TLS encryption. 

b) Select the Certificate Verification check box to require CA verification of the TLS certificate. 

6 Enter the TCP Port Number (Vanderbilt recommends accepting the default value). 

If a Vanderbilt CIM and a Mercury mCIM will be running on the same host system, the mCIM TCP Port must be 
changed. Vanderbilt recommends setting the mCIM TCP Port to 5001 in this situation. All Authentic Mercury 
controllers attached to the mCIM must be configured with the identical setting in order to communicate. 

7 Select the Installed check box to install this mCIM Port. 

Note: You need to always select the Installed check box. De-selecting this check box un-installs all the 

devices attached to this mCIM Port. 

a) If you have un-installed the mCIM Port and want to re-install it, select the Reinstall All Devices check 

box. It will re-install all the devices associated with this mCIM Port. 

Define Controllers 

The following 2 sections will outline the steps required to configure either Vanderbilt or Authentic Mercury 
Controllers. 

Vanderbilt Protocol Controllers 

Á Communicate to a CIM which downloads Access Control data and uploads Transactional data from connected 
devices. The CIM stores the Transactions into the SMS database and distributes them to the System 
Processor (SP) for determination if any Transactions should be processed Alarms and further distributes them 
as required to Transaction Monitor, Portrait Monitor, Alarm Monitor or Alarm Graphics clients. 

Á A single CIM can communicate with up to 64 Vanderbilt protocol controllers depending on the Transactional 
activity processed by the controllers. In a highly busy system, a lower Controller to CIM ratio may be required 
to avoid overloading the CIM. 

Á A new "CIM Type" option is now available in System Manager. Vanderbilt protocol controllers only 
communicate to a Vanderbilt CIM. 

Á Likewise, a new "CIM Port Type" option is also available in System Manager. Vanderbilt CIMs communicate 
via a Vanderbilt CIM Port. 

Authentic Mercury Protocol Controllers 

Á Communicate to an mCIM which downloads Access Control data and uploads Transactional data from 
connected devices. The mCIM stores the Transactions into the SMS database and distributes them to the 
System Processor (SP) for determination if any Transactions should be processed Alarms and further 
distributes them as required to Transaction Monitor, Portrait Monitor, Alarm Monitor or Alarm Graphics clients. 

Á A single mCIM can communicate with up to 256 Authentic Mercury Controllers depending on the Transactional 
activity processed by the controllers. In a highly busy system, a lower Controller to mCIM ratio may be required 
to avoid overloading the mCIM. 

Á Authentic Mercury protocol controllers only communicate to an mCIM using an mCIM Port. 

Á System Manager contains a new option to define a Cardformat Set. Authentic Mercury protocol controllers 
do not contain built -in card formats like Vanderbilt Protocol controllers. Card formats must be configured 
and downloaded to Authentic Mercury protocol controllers by creating a Card Format Set and specifying the 
desired Card Format Set in the controller definition. 

Á Authentic Mercury protocol controllers also require configuration and specification of a Site Code Set. 



...   

 

 Chapter 4    System Manager 171 

 

 

Á Authentic Mercury protocol controller configuration requires the controller serial number.  

Á Badge technology is not auto-detected for Authentic Mercury protocol controllers like for Vanderbilt Protocol 
controllers and must also be downloaded. Therefore, Authentic Mercury protocol controllers do not support 
credentials that are assigned an SMS custom badge technology. The Vanderbilt provided Magnetic Stripe, 
Proximity and PIN Only badge technologies are the only ones supported. 

Á Authentic Mercury protocol allows for a maximum of 16 Card Formats with an associated Site Code to be 
downloaded to any controller. SMS does not currently provide a mechanism to link Card Format and Site 
Code as required by the Authentic Mercury protocol. Therefore, each Card Format contained in the Card 
Format Set assigned to a controller will be matched to each Site Code in the Site Code Set assigned to the 
same Authentic Mercury protocol controller and downloaded to fill the 16 available slots on the controller. 

Vanderbilt Controllers 

Follow the directions below to Define a Vanderbilt Controller.  

Note: Controllers that have been added to a Controller Group (see Controller Group section for details) can not 
have their Domain Suffix changed in Controller Definition, it must be changed in the Controller Group section.  
Contact your network technician for details on the effects of changing the Domain Suffix.  

1 To define a controller, click on the Edit Controllers tab in the Option Bar. In the Information Grid the Edit 
Controllers tab opens. Click on the + sign. The Controller Definition window opens. 
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2 Enter a Description and Notes. 

3 Click on the expand button to select the CIM Port or parent controller to which the controller is attached. If you 
are defining a parent controller select the I/O port. If it is a child, select the parent controller. 

4 Select the Location (Area) for this controller. This is used to identify the location of the controller for trouble 

shooting. 

5 Select the Controller Model (VRCNX-M, etc.).  

Note: Some options will be grayed out and unavailable after selecting the Controller Model and I/O Port. 

These options do not apply to the type of Controller selected or type of Communications. 

6 If you are using a dial-up connection, select the Callback Set for this controller. 

7 Select the Site Code Set for this controller. Degraded mode works only if you specify the site codes. 
Degraded mode allows cardholders with specific site codes to access the areas even if there is a 
communication failure between CIM and the controller.  

8 Select the Holiday Set. 

9 Select the Locale Timezone. 

10 If you are using network connection enter the IP Address or Host Name. 

11 If using DNS (Optional): 

a) Enter the Hostname in the IP Address or Host Name field.  

b) Enter the Domain Suffix in the Domain Suffix field. 

Note: Contact your network technician for details on correct Hostname and Domain Suffix.   

12 Enter the IP Port Number (Vanderbilt recommends accepting the default value). 

13 If you are using a dial up connection enter the Phone Number.  

14 Enter the Parent Channel and Board Address (if applicable). 

15 Select the Scheduled Timezone (only if using a modem) for refreshing the controller memory 

automatically. 

16 Select the Network Device Type (if applicable). 

17 Administrative Level Password is used to login to an external IP module (if applicable) to configure the 

module in the case of disaster recovery.  

18 Access Level Password is used also to login to an external IP module (if applicable). 

19 Select the Installed check box.  

20 De-selecting the Installed check box un-installs all the devices attached to this controller. 

21 If you have un-installed the controller and want to re-install it, select the Re-install All Devices check box. It 
will re-install all the devices associated with this controller. 

22 Click Save and Close to close the window or click Save and New to define a new controller. Click Close 

to close the window without saving the definition. 
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Scheduled Updated for Controllers 

This feature lets you schedule automatic updates for Vanderbilt dial-up controllers at specific time zone intervals. 
To program this feature, first you have to define a timezone. After defining the timezone, configure controllers that 
you want to update automatically. This feature works hand in hand with the CIM and the Controller. The CIM dials 
up the controller at scheduled intervals. 

Follow these steps to program Scheduled Updates for Vanderbilt controllers. 

1 Define a time zone in the System Manager. 

2 Assign Intervals. 

3 In the System Manager, click on the Hardware Map button. 

4 Edit the CIM PORT Definition window. Make sure that the Modem Attached check box is checked. 

5 Select the dial up controller. Edit the Controller Definition window. 

6 Enter the phone number for the scheduled updates. Select the time zone that you have defined for the 
scheduled updates. Each dial up port on the CIM checks the time zone on a regular basis. When a timezone 
goes active, the CIM PORT checks each of the controllers attached to that CIM PORT to find out whether its 
dial-up controller is scheduled for update during that particular time zone. Controllers scheduled for update on 

that time zone are queued for dialing. Each CIM PORT begins dialing whenever there are controllers in the 

dialing queue and the modem is not in use. The CIM simultaneously dials on all dial-up ports. 

7 Click Save and Close. 
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Authentic Mercury Controllers 

Follow the directions below to Define Authentic Mercury Controllers.  

Note: SMS v6.4.2 includes support for the VMRC-1 and VMRC-2 Authentic Mercury Controllers only. However, the 

VMRC-1L and VMRC-2L are supported when programmed as the VMRC-1 and VMRC-2, respectively and configured 
for Backwards Compatibility Mode. Additionally, the VMRC-4 is supported when programmed as a VMRC-2 and 
configured for Legacy Mode. Additional Authentic Mercury Controller support will be included in future versions of 
SMS or via future SMS v6.4.2 patches.  

1 To define a controller click on the Edit Controllers tab in the Option Bar. In the Information Grid the Edit 
Controllers tab opens. Click on the + sign. The Controller Definition window opens. 

 

2 Enter a Description and Notes. 

3 Click on the expand button to select the mCIM Port or parent controller to which the controller is attached. If 
you are defining a parent controller select the I/O port. If it is a child, select the parent controller. 

4 Select the Location (Area) for this controller. This is used to identify the location of the controller for trouble 

shooting. 

5 Select the Controller Model (VMRC-2).  

Note: Some options will be grayed out and unavailable after selecting the Controller Model. These options 

do not apply to the type of Controller selected. 
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6 Select the Site Code Set for this controller.  

7 Select the Card Format Set for this controller. 

Authentic Mercury Controllers will NOT grant Access without both a valid Site Code Set and valid Card 
Format Set defined and assigned. 

8 Select the Holiday Set. 

9 Select the Locale Timezone. 

10 If the Channel 2 RS-485 Port will be in use select communications speed. 

11 Enter the controller Serial No (required). 

12 Select the Installed check box.  

13 De-selecting the Installed check box un-installs all the devices attached to this controller. 

14 If you have un-installed the controller and want to re-install it, select the Re-install All Devices check box. It 
will re-install all the devices associated with this controller. 

15 Click Save and Close to close the window or click Save and New to define a new controller. Click Close 

to close the window without saving the definition. 
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Define VSRC 

The VSRC Single Door controller is both a controller and a reader in one. To set up the VSRC the user will need to 
first set up the controller aspects and then the reader aspects. Configuration of the VSRC-M or VSRC-A is similar 
to the example below but allows up to 2 reader definitions per controller.  

Note: VSRCs that have been added to a Controller Group (see Controller Group section for details) can not 
have their Domain Suffix changed in Controller Definition, it must be changed in the Controller Group section.  
Contact your network technician for details on the effects of changing the Domain Suffix.  

1 Set up your CIM Definition  

 



...   

 

 Chapter 4    System Manager 177 

 

 

2 Define your CIM Port Definition  

 

3 Add your VSRC controller and attach to the CIM port definition. Use the new controller model: VSRC Single 
Door Controller. 
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Note: Make sure the VSRC has been configured on the network prior to entering the values here.  See the 

installation manual for details.  

 

4 If using DNS (Optional): 

a) Enter the Hostname in the IP address or Hostname field.  

b) Enter the Domain Suffix in a the Domain Suffix field.  

Note: Contact your network technician for details on correct Hostname and Domain Suffix.   

5 Add a VSRC Reader and attach it to the VSRC controller. 



...   
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Note: The VSRC template can be used to create all triggers, action items, AROs and MROs. 

 

6 Once defined, click on the Save and Close button.  
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Below is an example of the VSRC Reader Definition if the template has been used:  

 

 

 

Define VSRC-300 

The VSRC-300 is a software defined variant of the VSRC. The VSRC-300 allows connection of up to 8 Schlage 
AD-300 locks.   

Note: VSRCs that have been added to a Controller Group (see Controller Group section for details) can not 
have their Domain Suffix changed in Controller Definition, it must be changed in the Controller Group section.  
Contact your network technician for details on the effects of changing the Domain Suffix.  

1 Set up your CIM Definition as described under Define VSRC. 

2 Define your CIM Port Definition as described under Define VSRC. 

3 The VSRC-300 controller will be attached to the a CIM port definition. Use the controller model: VSRC-300. 
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Note: Make sure the VSRC has been configured on the network prior to entering the values here.  See the 

installation manual for details.  

 

4 If using DNS (Optional): 

a) Enter the Hostname in the IP address or Hostname field.  

b) Enter the Domain Suffix in a the Domain Suffix field.  

Note: Contact your network technician for details on correct Hostname and Domain Suffix.   

5 Add AD-300 locks and attach them to the VSRC-300 Controller. Remember that AD-300 readers will default 
to Channel 2 and the Reader Address will be one number more than defined with the SUS (Schlage Utility 

Software). Example: If the SUS defined the AD-300 lock as Address 0, then it would be defined as Address 

1 in SMS.  See the SMS Installation Manual for details.   
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Note: There are various templates the user can select depending on AD-300 model type. The templates will 

create all triggers, action items, AROs and MROs. 

 

6 Once defined, click on the Save and Close button.  
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Below is an example of the VSRC-300 Controller Definition if the template has been used:  

 

 

 

Define VSRC-400 

The VSRC-400 is a software defined variant of the VSRC. The VSRC-400 allows connection of a single PIM400-
485-SMS which can then communicate with up to 16 Schlage AD-400 wireless locks.   

Note: VSRCs that have been added to a Controller Group (see Controller Group section for details) can not 
have their Domain Suffix changed in Controller Definition, it must be changed in the Controller Group section.  
Contact your network technician for details on the effects of changing the Domain Suffix.  

1 Set up your CIM Definition as described under Define VSRC. 

2 Define your CIM Port Definition as described under Define VSRC. 

3 Add your VSRC-400 controller and attach to the CIM port definition. Use the new controller model: VSRC-
400. 
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Note: Make sure the VSRC has been configured on the network prior to entering the values here.  See the 

installation manual for details.  

 

4 If using DNS (Optional): 

a) Enter the Hostname in the IP address or Hostname field.  

b) Enter the Domain Suffix in a the Domain Suffix field.  

Note: Contact your network technician for details on correct Hostname and Domain Suffix.   
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5 Add the PIM400-485-SMS controller and attach it to the VSRC-400 controller. The channel of the PIM400 will 
default to 2 and cannot be altered. The address of the PIM400 will be one higher than what was defined in 

the Schlage Utility Software (SUS). Example: If the SUS defined the PIM400 as Address 0, then it would be 

defined as Address 1 in SMS.  See the SMS Installation Manual for details. 

 

6 If using DNS (Optional): 

a) Enter the Domain Suffix in a the Domain Suffix field.  

Note: Contact your network technician for details on correct Hostname and Domain Suffix.   

7 Add AD-400 locks and attach them to the PIM400-485-SMS. Any AD-400 lock that is attached to the PIM400 
will use channel address 2.  
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Note: There are various templates the user can select depending on AD-400 model type. The templates will 

create all triggers, action items, AROs and MROs. 

 

8 Once defined, click on the Save and Close or Save and New button.  
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Below is an example of the VSRC-400 Controller Definition if the template has been used: 

 

 

 

Define VMRC-2 

See Define Controllers - Authentic Mercury Controllers. 

 

Define a Reader 

SMS v6.5.0 Supports only Schlage Locks, the VRI-1, VRI-2 and VMRC-2 Onboard Readers attached to the 
Authentic Mercury protocol VMRC-1 / VMRC-2 Controllers. 

The Vanderbilt provided reader template for Authentic Mercury protocol controller connected reader interfaces 
utilize the Mercury protocol built-in Access Control Reader (ACR) model for control of physical reader functionality 
and does not provide for independent granular control of all reader functionality in the same manner as SMS 
provides for Vanderbilt protocol controller connected readers (i.e. LED timing, individual contact reporting, 
individual relay activation, etc.). The templates should not be modified except for relay activation timing (LED 
timing automatically follows relay timing) as any other changes will cause the reader to operate incorrectly, if at 
all. More granular control may be provided in a future version of SMS. Modification of reader triggers and action 
items, except for GO Relay Duration, is not supported. Non-reader associated Contact triggers and Relay action 
items can be programmed. Actions targeting the Go Relay are not recommended by Mercury and may provide 
unexpected results 

1 To define a reader click on the Edit Readers tab in the Options section and the Edit Readers tab in the 

Information Grid becomes active. Click on the + sign. 
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2 The Reader Definition window opens. A reader and a relay must be defined/programmed for door control 
functionality. If the use of a contact input for the reader is required, then a contact must also be 
defined/programmed. 

 

3 Enter a Description and any additional Notes desired. 

4 Select the controller that the reader is Attached To.  

5 Select Provide Access To Area. Click on the expand button to open the Select an Area  window. Highlight 

the area and click OK. 

6 Select the Reader Model. If you are defining a reader for a Schlage VIP lock, select Schlage VIP Lock as 

the reader model. 
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Note:  If a non-Vanderbilt reader model is selected, the status of Online Device Licensing is checked. 

If Online Device Licensing is exceeded by adding this reader, a warning will be displayed adjacent to the 
Installed check box and you will be unable to save the reader definition unless the Installed check box is 
cleared. 
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7 Select the Reader Type. Custom reader types can be defined using Reader Type Definition window 

(Edit > Reader Types). 

 

In Enabled Reader -  Use this type to stop people from tailgating. If the user does not swipe the card 
at the entry reader, that person will not be given access to any area in the building that is secured by the 
In Enabled Reader. 

Antipassback Reset Reader -  Swiping a card at this reader resets the card to neutral. 

Muster Reader - This reader is used for creating evacuation reports.  

8 Select the Door Type through which the reader is giving access. 

9 Enter the Antipassback Time. See the section below for further information about Antipassback. 

10 Select the Channel Number that the reader is connected to on the controller. 

Note: All the devices wired to any controller channel must support the same communications protocol (i.e. 

Vanderbilt VRINX, Vanderbilt-M VRI-1 or VRI-2, Aperio and Schlage devices may not be mixed on the same 

controller channel). 

11 Select the Reader Address configured on the reader using jumpers/switches. 

The use of both reader interfaces on a Vanderbilt VRI-2 requires defining/programming two (2) separate VRI-2 
readers in SMS. Reader 1 on the any VRI-2 must be programmed at an odd address (1, 3, 5, 7) and Reader 2 
on the same VRI-2 must be programmed at the next sequential even address (2,4,6,8) on the same controller 
channel. 
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Antipassback 

Antipassback is a function that prevents cardholders from passing their card to another person for illegal entry 
(commonly used at car park barriers and turnstiles). With this feature enabled, once the same Encoded ID s 
presented at an entry reader that Encoded ID must then be presented at an exit reader before it can be used again 
at the entry reader.  The same applies to an exit reader in that once an Encoded ID is presented to an exit reader 
that Encoded ID cannot be used again at an exit reader until it has been presented to an entry reader. If a card is 
presented twice in a row at the same type of reader, no access will be granted. The Transaction Monitor will display 
an antipassback violation transaction. 

Antipassback is supported for readers contained within the same Area on the same Authentic Mercury protocol 
controller. Configuration of Area based antipassback requires the issuance of the Controller Antipassback Reset 
MRO after configuring the Area Entry and Exit Readers. Access will not be granted to the controller antipassback 
area until this MRO is issued. 

Antipassback Time - This is the time in minutes that the system will reset the cardholder's Antipassback state to 
neutral. For example, if a card is swiped at an entry reader and antipassback time is set to 10 minutes, the In/Out 

status of the card will be reset to neutral after 10 minutes and access can be granted at that reader without passing 

through and exit reader first. 

Note: Each reader can have a different Antipassback time applied to it.  

Global Antipassback - Global antipassback is used with a parent/child setup and participating Entry and Exit 
readers attached to these boards. It works with controller Firmware V5.50 and higher. Every controller board in the 
parent/child set up that has entry or exit readers attached must have dip switch 5 open. When a valid entry occurs, 
the cardholder is registered as ñInò and a message is sent to the parent controller board. The parent board then 
forwards the message to all its child boards to update this personôs Antipassback state. 

Controller Group Antipassback - Controller Group Antipassback is used with up to four VRCNX-R/M and 
VSRC/VSRC-M controllers that are attached to the same network switch and connected to the same CIM and 
participating Entry and Exit readers.  It works with Firmware V2.81 and higher.  To function a Controller Group must 
be defined in the SMS System Manager application.  Up to 4 controllers can be assigned to a single controller group.  
Antipassback credential status is communicated using board to board messaging via TCP/IP socket connection to 
reduce network stress.   Each controller attached to the same Controller Group is aware of all other controllers in 
their group.  A controller can only reside in one group.  In the event of network Ethernet interruption of one or more 

boards within the group, Antipassback will be reset to neutral for all credentials.  See the Controller Group section 

for more details.    

1 Enter the channel number in the controller to which this reader is attached. 

2 Enter the channel address. 

3 Select the reader template. (See the section below for further information). 
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Reader Template 

A Reader Template is a collection of attributes assigned to a Reader (i.e. Contact and Relay definitions along 

with associated Event Triggers and Actions and Overrides. Vanderbilt provides common Reader Template 
configurations which may be assigned to Readers. Any Reader configuration can also be designated as a user-

defined Reader Template when there are additional Readers that use the same or very similar Relay, Contact, 
Event Trigger and Override configurations. A template duplicates the information so that it does not have to be 
redefined each time a new reader is added to the database. A reader template can be used if you have 16 readers 
attached to one controller board and they use related programming, for example. Once you have programmed the 

first reader, it can be defined as a Reader Template. The template assignment process offers choices to duplicate 

specific features of the Reader Template. 

SMS v6.4.5 restricts the available Vanderbilt provided Reader Templates for any Reader to those known to be 

compatible with the Reader model selected. All user-defined Reader Templates are also available for 

assignment to any Reader model. Vanderbilt recommends caution assigning user-defined templates created for 

one Reader model to another since the Reader many not function properly. 

Vanderbilt recommends assigning the "No Device" Reader Template to any Reader model prior to changing 

its previously assigned template to make sure all previous template attributes are removed. 

Defining a Reader as a Template 

Follow these steps to define a Reader as a template: 

1. Define a reader you want to set as a template. 

2. Go to System Manager main window, select Edit > Reader Templates . The Reader Templates 
Definition  window opens. 

3. Click on the Add Readers as Templates (+) button. The Select Readers to add as Templates  

window opens. 

 

 

4. Select the Reader you want to set as template. 
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5. Click the Add As A Templates  button. 

6. Enter a Description for the template and any additional Notes desired. Click OK. 

7. The selected Reader appears in the Reader Templates list. 

8. Double-click on any record or select Edit Current Record from the toolbar to edit the definition (if 

desired). 

9. Vanderbilt configured templates are available for Wireless, VIP and standard Readers. Contacts, 

Relays, Event Triggers and manual Overrides are pre-configured. Additional information on each 

template is available in Reader Definition > Notes .  

10. Launch System Manager > Edit Readers .  

11. Select a Reader Template from the grid view.  

12. Double-click on a record to open it and review the Notes. Any attribute of the template can be modified if 
desired. A warning and confirmation will be presented if modifying a Vanderbilt provided template. 
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Assign a Reader Template 

1. In the Reader Definition window, click in the Reader Template field or select the ellipsis adjacent to this field 

to display a list of the available templates. 

2. Highlight and select a template and click OK. If the templates available here do not match your specific 

requirements, select "No Device" and click OK. The Contacts, Relays, Event Triggers and 

Overrides for this Reader will have to be manually defined. 

 

3. If a template was selected, the Template Choices window displays when the Reader Definition is 

saved allowing a choice of the Reader attributes to be duplicated from the template. Select the desired 

attributes choose OK. 
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Degraded Mode 

Degraded Mode is an operating state for the Reader Interface (RI) which, when set, allows access by evaluating 
just the site codes. The reader enters degraded mode if the operator has enabled degraded mode and the reader 
interface has lost communication with the controller. 

In this situation, the VRINX notices the card presentation and realizing that it has no communication with the VRCNX-
R, checks to see if the badge has proper site codes. It energizes the relay if the site code matches. When using 
Degraded Mode, an alarm for ñLost link to Readerò should be programmed to alert alarm workstations that 
communication between the board and reader interface has been interrupted. 

1 Select the Guest Sign In Reader checkbox if this reader is assigned for automatically signing in the guests 

in the Guest Pass System* application. 

2 Select the Guest Sign Out Reader checkbox if this reader is assigned for automatically signing out guests 

in the Guest Pass System* application. 

3 Auto Relock - This option resets the triggers (contacts and relays) on a particular event and relocks the 

door. 

4 Select the Installed  check box to install this reader in the system. 

Note: Deselecting the Installed check box uninstalls all the devices attached to this reader. 

5 If you deselect the Installed check box, the reader and the associated devices are uninstalled. Then the 

Reinstall all Devices checkbox becomes active. Select this option to reinstall all the devices in the system. 
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Contact Definitions 

1 Click on the Edit Contacts tab in the options bar. The Edit Contacts tab in the Information Grid becomes 

active. Click on the + sign to define a new contact.   The Contact definition window opens. 

 

a) Enter a description for the contact and the notes attached with it. Make sure that you describe what kind 
of a contact you are defining. E.g. REX (Reader Exit Request), DOD etc. 

b) Next select the reader or controller based on where this contact is attached. 

c) Select the location (Area) for this contact. 

d) Select the contact type. 

REX (Reader Exit Request) - REX is a contact type that has a ñNormally Openò state.   It is recommended 

that REX be used as Input 1 when adding contacts to the database. 

DOD (Door Open Detect) DOD is a Contact Type whose state is ñNormally Closed.ò It is recommended 
that a DOD be used as Input 2 when adding contacts to the database. 

IPB (Interior Push Button) - IPB is a contact type that has a Normally Open state.  It is recommended 
that IPB be used as Input 4 when adding contacts to the database.  See the Internal Push Button section 
below for details.   

e) The Associated Elevator Reader selector is disabled. It will become enabled for contact definition if 

the contact type is an elevator call button. 

f) Alarm Samples - The VRCNX-R board will sample contact points by measuring voltage on the line. It 
measures the voltage on each point, one after the other. Alarm Samples are the number of consecutive 
measurements that must be made before deciding that the state has changed from secure to alarm or 
alarm to secure. 
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g) Fault Samples - This is the number of samples to be done between reporting trouble/ open short and 
contact secure. The fault sample is usually a higher number to ensure against measurements taken at the 
moment that a point is either opening or closing. 

h) Parallel Resistor - Enter the number of Ohms of the Parallel Resistor in this field. A single resistor in 

parallel with the contact should be used when the contact point is normally open. 

i) Series Resistor - Enter the number of Ohms of the Series Resistor in this field. A single resistor in series 

with the contact should be used when the contact point is normally closed. 

j) Debounce Period - This is the period of time that must elapse before reporting a second alarm on the 
same point. The debounce period is used to inhibit the reporting of alarms over and over. For example, 
the debounce period is set to 10 seconds. A person walks down the hallway. The motion detector is 
triggered and Contact Active is reported. The point returns to secure and then active again, etc. At the end 
of 10 seconds, the state of the contact is reviewed. If the contact is still active, nothing more is reported 
until the contact is secured. 

k) Input Number - This is the contact number on the Reader Interface. Specify the contact point that is 

used for this contact. 

l) Verify Status - This checks the status of the door and sends a signal to the contact point once the door 
comes out of the automatic override state. For example if the automatic override time ends at 5.00 PM 
and the door is still open, the system gets a Door Held Open alarm. 

m) Normally Open - If this option is checked ñNormally Openò be the normal state of the contact point. The 

contact reports alarms if the contact is in the ñNormally Closedò state. 
 

Internal Push Button 

When defining an VSRC, VRINX, AD-300 or AD-400 using Templates the user now has the option to select 
functionality for the Internal Push Button (IPB).  The IPB can be set to trigger either a Toggle or LockDown MRO, 
depending on the Template selected.   

Toggle - if the IPB Toggle template is selected for any of the above devices, the IPB will toggle the door open upon 

being pushed and resume normal operations when pushed a second time.  See the MRO section for details.  

LockDown - if the LockDown template is selected for any of the above devices, the IPB will put the door into 
Lockdown upon being pushed and resume normal operation upon being pushed a second time. See the MRO 
section for details.   

Passthrough - Passthrough is not a state but an option in the LockDown MRO.  The Passthrough option makes 
it so that a cardholder with Antipassback disabled will function as a passthrough cardholder; they will be able to gain 
entry to a door in the LockDown state.  This feature can be disabled by editing the default Event Trigger.  See the 
Event Trigger section for details.   

 

Contact Point Supervision using Parallel and Series Resistors 

Contact points are supervised to detect any tampering with the equipment, including breaks and/or shorts in the 
cable between the reader controller and the supervised input point. Resistors allow the controller to distinguish 
between a contact opening and closing compared to a circuit opening or shorting. 

Note: Please refer to the SMS Hardware Manual for more information on Contact Point Supervision. 

Parallel and Series resistors are used with contact point supervision. 
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Define a Relay 

1 To define a relay, click on the Edit Relay tab in the Options View section. The Relay Definition window 

will open. Enter the required information. Note that the Associated Elevator Reader selector is disabled. 

It will become enabled for relay definition if the relay type is an Elevator Floor Select. 

  

a) Description -Type in the name of the respective relay you are configuring, 

b) Notes - If necessary, write any pertinent information about this relay. 

c) Attached to Which Controller or Reader - Define the controller or reader to which the relay is 

attached. 

d) Location - Define the location of the relay. 

e) Relay Type - Select the type of the relay. If this relay is used for an elevator, change this to Elevator 
Floor Select. The system provides eleven factory set relay types. The relay types can be added, modified 

or deleted using Edit>Relay type. 

f) Relay Number - Enter the number of the respective relay. 
 

Access Under Duress Transactions 

Access Under Duress is a feature by which a person entering an area under threat may signal an alarm at the 
console by entering a PIN number which is exactly one greater than his/her assigned PIN number (keypad ID). For 
example, if the PIN number is 1234, entering 1235 will generate an ñAccess Under Duressò transaction as opposed 
to a ñValid Accessò transaction. The firmware must be modified to support this option. 

At the moment, we only expect to support this feature with the VRCNX-R and VRINX boards. These are the points 
to be noted while defining an access under duress transaction. 

1 Define a keypad reader. 



...   
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2 Select the reader type as Standard Reader. 

3 Check the box near the option Keypad Reader. 
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4 Define the event trigger for the reader. 

 

5 Select Access Granted Transactions as the transaction group. 

6 Next select Access Under Duress as the Transaction. 

 
 

How to Alarm an Access Under Duress Transactions 

If you present your card and enter your assigned pin number on the keypad, you will get an access granted 
transaction. To get an access under duress transaction you should add 1 to your pin number. For example if your 
pin number is 6425 you should press 6426 to get access under duress. If the pin number is 2999 you should enter 
3000 to get an access under duress transaction. 

 



...   
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Entry and Exit Under Duress 

In the similar way you can define Entry Under Duress and Exit Under Duress transactions. The reader type that is 
used to define these transactions should be entry or exit readers. You should also choose appropriate transactions 
(Entry Under Duress and Exit Under Duress) while defining the event triggers. The user can signal these alarms by 
entering one number greater than their assigned pin numbers. 

 

Event Triggers 

Once you have entered all your information for your readers, contacts, and relays, an event trigger must be assigned. 

An Event Trigger is a transaction that must have an action, a command and a device associated with it. 

Triggers are critical because they determine what will happen when an event (or transaction) occurs. For example, 
a cardholder presents a card at a reader and expects to be granted access to an area. Presenting the card is a 
transaction. However, specific actions must be defined to send commands to a device or devices to allow the door 
to open. 

Event Triggers are made up of two parts, the Event Trigger and the Action Items for the Event Trigger. Triggers 
need to be programmed for every function that you want that device to do. 

1 The Trigger Action Order in the examples that follow is not the only order that should be followed. Your 
specific device functionality determines the order of the Trigger Actions. To program the Triggers, go to the 

Hardware Map section and select the device that you want the trigger for, then select the gear icon. 

2 The Event Trigger window opens. 
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3 First we will define the event trigger for this reader. Click on the + sign on the upper part of the window. The 

Event Trigger Definition window opens. 

 

4 Enter a Description, notes and select a Transaction Group, which will be Access Granted Transactions. 

5 The Transaction Group will in turn determine the type of transactions that are offered. Click on the expand 

button to select a transaction group. 

6 Click on the expand button to select a transaction. 

7 Select the time zone you want the trigger to function in by clicking on the expand button. Click Save and 
Close. 

8 Click OK to return to the main Event Trigger screen. 

9 Now we will program Actions that are associated with the transaction. In the Actions Item section of the 

Event Trigger main window, click on the + sign. Enter your Description. 

10 To select the specific device that this action is going to effect, click on the expand button near the Device 
Action Affects field. Click on the expand button and select a device. Click OK. 
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11 Next, click on the expand button near the Command field to select a command for the device. For this 

example, we will choose Energize Relay.  The duration setting sets the amount of seconds the relay will be 
energized. In this example the duration is set for 3 seconds, if zero (0) is entered then the relay will be 
energized forever, which means the relay will be always energized. 

 

12 The next Action Command that needs to program is the command to turn the LED Green.  Program the 

Duration Setting for three seconds to synchronize it with the Energize Relay setting. 
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13 If we are using a contact input off of the reader, then we have to program actions for that DOD contact. Select 
the contact that is going to be the DOD. 

 

There are two Commands that have to be programmed for the DOD Contact. The first is Contact Reporting 

Disabled. This prevents the Contact Active transaction, which may be an Alarm, from being sent for the 

amount of time that is set in the Duration of Seconds field. Again set the Duration time for 10 seconds. 

14 The second Action Item Command is Contact Trigger Disabled. This command prevents any device that 
is attached to that contact, such as a bell above a door, from being enabled for the amount of the Duration 
Time. 

The Duration Time is set at 10 seconds, the same as the Contact Reporting Disabled Action that was done 

previously. 

Event Triggers for Authentic Mercury Protocol Attached Devices 

Programming for individual contact inputs and relay activation for the VI-16IN input modules and VI-16O output 
modules when connected to an Authentic Mercury protocol controller is performed in the same fashion, using 
the same commands, as when these devices are connected to a Vanderbilt protocol controller. 

Programming of unused Authentic Mercury protocol controller connected reader associated (controller onboard, 
VRI-1 or VRI-2) contact inputs and relay activation is performed in a similar fashion to how performed as for 
Vanderbilt protocol controller connected devices. However, the reader associated contact inputs and relays are 
only available for programming once the reader is defined, whether the reader itself will be used. Contact and 
Relays cannot be directly attached to Authentic Mercury protocol controllers as they can for some Vanderbilt 
protocol controllers. These are accessed by selecting the Contact from the Hardware Map in System Manager 
and clicking the gear icon in the lower left corner of the Contact Definition dialog. Reader level Triggers (Valid 
Access, etc.) can be accomplished for Authentic Mercury protocol controllers using the Universal Triggers 
application. Reader level Triggers for Authentic Mercury protocol controller attached devices will be implemented 
in a future version of SMS. 



...   
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Triggers and associated Action Items are only supported for devices attached to the same controller, like 
Vanderbilt protocol controller device Triggers and Action Items. Authentic Mercury protocol controllers, like 
Vanderbilt protocol controllers, do no support controller-to-controller communications (except for Vanderbilt 
protocol controller support of Controller Groups for antipassback). Configuring an Action Item for an Authentic 
Mercury protocol controller attached device based on a Trigger from a device attached to different Authentic 
Mercury protocol controller will product unexpected results and is not supported. Action Items targeting the Go 
Relay on Authentic Mercury protocol controller connected reader interfaces are not recommended by Mercury 
and can produce unexpected results. 

A subset of Triggers and Action Items are currently supported; additional Triggers and Action Items will be 
incorporated later. Triggers or Action Items currently supported are listed below. Note that to use the Push Button 
Override (PBO) contact as a Trigger for Authentic Mercury Protocol controller attached devices, the Contact 
Type must be changed to General Purpose in the Contact Definition dialog and the only valid Transaction Types 
are Contact Active or Contact Secure. Likewise, the Internal Push (IPB) Button contact for an Authentic Mercury 
protocol controller attached device, reports only Contact Active or Contact Secure (like for a Vanderbilt protocol 
controller attached reader with an ñIPB Inactiveò template applied). 

Valid Triggers  Valid Action Items 

¶ Contact Active 
 

¶ Energize Relay 

¶ Contact Secure 
 

¶ Release Relay 

¶ Door Forced Open 
 

 

¶ Door Held Open 
 

 

¶ Request to Exit Activated 
 

 

¶ Tamper Switch Violation 
 

 

¶ Tamper Switch Secure 
 

 

Disabling Internal Push Button (IPB) Options 

The IPB functions defined in the IPB templates for the VSRC, VRINX, AD-300 and AD-400 devices can be altered 
by changing the event triggers (see the IPB section of the Manual Overrides chapter for details on the IPB MROs). 

 

Allow Master Passthrough - This trigger specifies that any Cardholder with Anti-passback disabled is able to 
open a door that is in LockDown mode.  To make it so that no cardholder can enter a reader in LockDown mode, 
delete the Allow Master Passthrough Trigger.   

Allow MRO Overrides - This trigger specifies that either the Toggle or LockDown states can be altered by an 
MRO sent from SMS.  Deleting this trigger will make it so that the reader, once the IPB has been engaged (in either 
Toggle or LockDown) it CANNOT be affected by MROs.    
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Define CM Locks 

SMS allows the user to create offline reader devices (locks) within hardware definitions. The offline readers do not 
directly communicate with the host controller. So it is necessary to do manual programming at the reader location. 
The user can create necessary downloadable files and upload to a pocket PC. The data is transferred to a PDA by 
connecting to the serial communication port of the PC or via a USB port for the AD-200 Series and CT-5000. The 

files required for programming the locks are generated to a folder using the Offline Lock Interface Module. The 

programming of doors is accomplished by connecting a CIP (Computer Interface PAK) from the laptop/palmtop to 

the iButton ports of the lock or to the USB port of the lock for AD-200 Series and CT-5000. 

Follow these instructions to define a CM lock: 

Note: The user needs at least read only permissions to the System Manager item for offline locks to see the offline 

locks defined in the system. 

1 In the option bar, select Hardware Map > CM Locks. 

2 In the Grid window Offline Locks tab is activated. Click the + sign (insert button). 

3 The CM Lock Definition window opens. This dialog allows the user to define new locks, and modify existing 

definitions. 



...   
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Note:  The status of Offline Device Licensing is checked. 

If Offline Device Licensing is exceeded by adding this lock, a warning will be displayed adjacent to the 

Installed check box and editing of all fields will be disabled until the Installed check box is cleared. 
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4 The window defaults to CM Lock Details tab. 

 

a) Description  - Enter a description for the offline lock you are defining. 

b) Notes  - Enter notes associated with it. 

c) Model  - Click the browse button to select the model of the lock. On the Select a Model window, choose 

the correct model by highlighting it and click OK. 

d) Area  - Select the area the lock is providing access to by clicking the expand button. You can create a new 

area by clicking on the plus button (+). On the Create Area Definition  window, enter a description. Area 
Type, Maximum Occupancy Count and Area State fields displays factory set information. 

Note: Assigning an area is for organization and security purposes only, and is not used for assigning access 
privileges to the lock. Giving a cardholder access to an area does not give him/her access to offline locks. In 

the System Security program, When permissions to the All Areas  Area Set under Area Set permissions 

is set to Read Only or None, the Add Area button on this window is disabled. 

e) Locale Timezone  - Click the browse button to select a locale timezone. 

f) Relock Delay  - Specify the number of seconds required to relock the lock. 

g) Card Types - Select the technology supported by the lock. You need to select at least one of the available 

technologies (Card, IButton or PIN).  If you select the option Card, the radio buttons for Magstripe and 

Proximity credentials are enabled.  Select the credential technology that you are going to use for this 
particular lock.  It is very important to select the appropriate technology, because you cannot mix Magstripe 
and Proximity credentials on one lock.  So, while adding access records for this lock, the system allows 
you to add only those credentials with the technology you have specified here for the lock. 



...   
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Once a credential has been added to the lock, both the Proximity and Magstripe radio buttons are inactive. 
This prevents modification of the Lock credential technology type after a credential is attached.  In order 
to modify the credential technology after a credential has been added, the credential has to be removed 
first. 

 

h) Magstripe Template - Each lock can use its own Magstripe template. Click on the browse button to 
select a template. If the user changes a template that is already in use, the CM Lock credentials that are 
entered manually will be affected.  This field defaults to Default Template.  Also note that if you have 
selected Proximity as the credential type, the Magstripe Template field is disabled.   

Note: For further information on Magstripe Template, refer to the Magstripe Template Definition section 

in this chapter. 

i) Automatic Over rides Credential Enabled  - If this option is selected, the automatic override will be 
enabled only with a valid card swipe. For example, if a door is scheduled to open at 8 AM, that door will 
not unlock until there is a valid access transaction. This feature is useful at the event of unknown factors 
like heavy snow etc. and the door need not be opened at the scheduled time. 

Note: If the dialog is in edit mode when the user attempts to uncheck a technology that is supported by the 

lock (Card, iButton, or PIN) and the lock currently has credentials attached to it with the technology, the user 
will get an error message and will not be able to uncheck the box. The user must remove all of those 
credentials from the lock before modifying the information. There is a number next to the checkbox that lists 
the number of credentials attached to the lock that uses this technology. 

5 The Installed option must be checked in order for the lock to become active in SMS. 
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6 Next, you need to attach time zones to this lock. You can attach a maximum of sixteen (16) time zones per 

lock. Select the Timezones tab on the CM Lock Definition window. 

a) Select the + sign to add time zones. All the time zones (with single intervals) defined in the system are 
displayed. Use the Search feature to easily locate time zones. The user can select and add multiple time 

zones at the same time. Click OK. 

Note: While defining Offline Lock Access, if you select a timezone that is not attached to the lock, the lock 

will not be available for granting access. 

7 Now you need to attach holidays to the offline lock.   You can attach up to thirty two (32) holidays per lock. 

Select the Holidays tab on the CM Lock Definition window. 

a) Select the + sign to add holidays. All the holidays defined in the system are displayed. Use the Search 
feature to easily locate holidays. The user can select and add multiple holidays at the same time. Click 

OK. 

b) Select an offline function to apply to the lock. 

Á Passage - The offline device will allow access during the specified holiday. 

Á Secured - The offline device will be locked and will not allow access through the door during the specified 

holiday. 

Á Secured Lock Out - The lock will not allow access, but will allow people with special credential to go 

through the door during the specified holiday. 

8 Now add the Automatic Overrides to the lock. Clicking the + sign opens the Automatic Override 
Definition window. Define the override and attach the timezone during which you want to unlock and lock 
the door. The system allows you to attach a timezone with multiple intervals to an ARO, only if the timezone 
interval is a spanning midnight timezone.  A maximum of eight (8) automatic overrides and lockdowns are 
allowed per lock. Once the total number of lockdowns and automatic overrides reaches the maximum number 
(8), a new record can be added, but the user will have to replace it with an existing lockdown or automatic 
override.  

Note: CM locks do not allow the attachment of multiple AROs with same time schedule. The system also 

does not permit AROs with overlapping time schedule attach to CM Locks.  E.g.  If there is a timezone attached 
to a lock with Monday - Friday; 10 AM - 5 PM schedule, the system does not again allow users to attach an 
ARO with overlapping schedule (e.g. Friday - Monday; 8 AM - 11 AM), because the time and day overlap on 
Monday and Friday between 10AM and 11 AM. 

9 Now select the lockdown you want to attach to this lock. Click the + sign. The Select Lockdown window 

opens. 

 

10 Click on the expand button near the Lockdown field to select a pre-defined lockdown. The Create 
Lockdown button allows you to define a new lockdown.  Note that you cannot attach lockdowns with the 

same time schedule to an offline lock.  See the Lockdown Definition section for further details. 

11 Select Save and Close to save the information and close the dialog. Select Save and New to save the 

current information and enter new information. Select Close to close the dialog. 
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Note:  No information is saved until the user clicks the Save and Close, Save and New, or Save buttons. 

If the user exists without saving, they will lose any selected holidays or time zones that were added or removed 
during that session. 

This Grid displays all CM locks defined in the system that the user has at least read only permissions to. 
These permissions are determined by the area the lock is attached to. If the user has no permissions to the 

area the lock is attached to, they will not be able to see that lock. This rule is applicable to the option CM 
Locks by Area Tree also. 

 

Adding Credentials to the Lock 

If a lock is using only Magstripe and Pin credentials, while adding credentials, only those credential types are 

available for selection.  Click the  button (Create access records for selected records) located on the grid 

window of System Manager, the Offline Lock Access Definition window is displayed.  Select the timezone at 
which access is allowed.  Click the + sign in the Offline Credentials section, and only those type of credentials that 
are specified in the CM Lock Definition window are available for selection. 
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If you select multiple locks that support both Magnetic Stripe and Proximity Credentials for defining offline access, 
the offline credential tab lists both the type of credentials, but will attach only supported credentials to the 
corresponding lock.  A report will be generated for the failed attempts to add credentials to the lock. 

If a lock has mixed card credential types such as a proximity and Magstripe credential attached on one lock, when 
upgrading the system, neither the proximity nor Magstripe radio button is selected.  The user is given the option to 
determine which type of Card credential the lock should use.  The user is informed of the number of Magstripe and 
Proximity credentials that is in use, and is prompted to select either Magstripe or Proximity credential types in order 
to save modifications to the lock.  When the user clicks the Save button, he/she is prompted to remove invalid 
credentials from the lock.  Based on the credential type selected, the user can remove the conflicting credentials 
from the lock. 

Select the checkbox Only show normal function in order for the Search to find only credentials with Normal 
function. 

 

 

View Access Records 

Follow these instructions to view the access records for a particular CM lock: 

1 Select an offline lock from the Grid and then right click to bring up a menu. Select View Access Records 
option. 

 

2 You can also access this option by clicking the View selected device access records button on the 

navigation bar. 

3 The system displays access records attached to the selected offline lock. 

Note: The user must have read/write permissions to both System Manager and to the System Manager 

security item Edit Offline Locks, in order to insert, update, or delete access records in this dialog. 

 

Editing CM Lock Definition 

1 To edit a lock definition, select CM Locks from the Option bar and double click on the definition you want to 

edit from the Grid view. You can also select View > Grid Windows > Devices > CM Locks > View All 
CM Locks. 
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2 The CM Lock Definition window displays the selected definition. Make the necessary changes and, click 

Save and Close. 

 

Also, a button to Create a new CM Lock duplicating information from the current lock is available at the bottom 

left corner of the window.  Click on this tab to open the Duplicate CM Lock  window.  This feature is discussed 
in the Duplicate CM Lock Definition  (on page 215) section. 

Note: The duplicate option is only enabled during edit mode. When performing a duplicate option, only saved 
information will be duplicated. If a lock was changed and then not saved and then duplicated, the new lock 
will receive the duplicated lockôs last saved information. 
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Editing Timezone Intervals for CM Locks 

The user can modify the timezone intervals that are attached to a lock. Double click on the record you want to modify 

and make necessary changes in the Timezone Interval Definition window. Save your record. 

Timezones with one interval 

While the system allows to modify the time, days and holidays attached to a lock, it does not allow the user delete 
any of this information. If the timezone has only one interval, it cannot be deleted. Intervals can be deleted only if 
the timezone has two intervals. 

Timezones with two intervals 

For timezones spanning midnight, the system will not allow the user to modify the interval time that starts at 12.00 
am and ends at 11.59.59 pm.  The start time of the first interval and the stop time of the second interval can be 
modified regardless of whether it is attached to a lock or not.   In order to modify the weekdays of the timezone that 
spans midnight, you need to delete one interval, change the weekdays of the existing interval, and then add the 
second interval. 
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Duplicate CM Lock Definition 

The duplicate feature allows users to duplicate all the properties attached to a lock along with the area access rights. 

Note :  In order to copy properties of a lock to another lock, both locks must be of the same model and must use the 
same credential type. 

1 Select a CM Lock and click on the Duplicate Selected Record  button located in the toolbar. This opens the 

Copy/Duplicate CM Lock  window. This window is also accessible while editing a CM Lock (double click on 
a lock definition). 
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There are two ways to duplicate the lock.  The first option is creating a new lock duplicating the properties of 

an existing lock by using the New Lock  button. 

2 Click on the New Lock  button, and the New Lock Properties section is enabled.  Enter a description for the 
new lock. 

Create New Area  - Enable (enabled by default) this option if you want to create a new area for the new lock.  

Enter the description for the new area in the field.  By default the New Lock Area  field will be filled with the 
New Lock name + Area.   

Example: If the new lock is named Reception Desk then when the cursor is put into the New Lock Area field 
it will automatically say Reception Desk Area.   
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Note: If user does not have at least read/write permission, they cannot add a new area. 

3 Copy Access Privileges  - This option allows you to copy the access privileges of the existing lock to the new 

lock. Click Save and Close .  The CM Lock Definition  window opens with the new lock information you 

entered Copy/Duplicate CM Loc k  window.   

 

Explore all the tabs available on this window to verify that all the properties of the existing lock are copied to 
the new lock.  You can update any of this information, and the Save and Close button will be enabled to 
update your changes in the system. 
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Also click on the View Access Records  button (System Manager>Hardware Definitions>CM Locks>Grid 
section) to view the access records that are copied from the existing lock.  You can also add/remove more 
credentials to this lock by using the appropriate toolbar icons (+ or - signs). 

 

4 The second option is copying the properties and access privileges of a lock to another existing lock(s). Select 
a lock that you want to copy, and open the Copy/Duplicate CM Lock window.  Click on the Copy Lock button.  
Now click on the + sign and add the lock(s) you want to update. Clicking the X button removes the selected 
lock(s) from the list. 
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5 Click Save and Close .  The following confirmation message is displayed.   

 

6 Click Yes to copy the settings and access of the selected lock to the target locks.  The properties and access 
privileges attached to the target locks will be overwritten. Once you click Yes, a confirmation message shows 
the number of locks that are updated. 

 

Define IP Locks 

SMS allows the user to create offline (local decision) Direct IP reader devices (locks) from Assa Abloy within 
hardware definitions. The local decision locks contain an embedded controller which is programmed from SMS via 
Assa Abloy's Door Service Router (DSR) using the TCP/IP protocol. 

The Assa Abloy IP-Enabled local decision Locks are available with standard 802.11 WiFi or Power over Ethernet 
(PoE) TCP/IP connectivity. WiFi locks will communicate with the DSR on a set schedule except for events configured 
in the DSR to alarm which will wake the lock and report. The PoE locks will communicate events to the DSR as they 
occur. The SMS DSR Bridge Service (installed on the DSR host system) will communicate events and programming 
data in near real-time between the Assa Abloy DSR and SMS. Events reported from the IP-Enabled locks will display 
in the Transaction Monitor application if they are reported within 5 minutes of the current time. All IP-Enabled lock 
events are recorded in Transaction History. 

Follow these instructions to define an Assa Abloy IP-Enabled local decision (offline) lock: 

Note: The user needs at least read only permissions to the System Manager item for offline locks to see the offline 

locks defined in the system. 

Manual Entry of IP Lock 

1 In the option bar, select Hardware Map > Direct IP Locks. 

2 In the Grid window Offline Locks tab is activated. Click the + sign (insert button). 

3 The Add IP Lock window opens. This dialog allows the user to define new locks, and modify existing 

definitions. 
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Note:  The status of Offline Device Licensing is checked. 

If Offline Device Licensing is exceeded by adding this lock, a warning will be displayed adjacent to the 

Installed check box and editing of all fields will be disabled until the Installed check box is cleared. 
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4 The window defaults to Details tab. 

 

a) Description  - Enter a description for the IP lock you are defining. 

b) Notes  - Enter notes associated with IP lock. 

c) Serial Number - Enter lock Serial Number from the sticker on the lock or from Assa Abloy Lock 

Configuration Tool (provided by Assa Abloy certified installer) 
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d) Area  - Select the area the lock is providing access to by clicking the expand button. You can create a new 

area by clicking on the plus button (+). On the Create Area Definition  window, enter a description. Area 
Type, Maximum Occupancy Count and Area State fields displays factory set information. 

e) Relock Delay - Specify the number of seconds required to relock the lock. 

f) Extended Relock Delay - Specify an additional number of seconds required to relock the lock when 

special access is specified (i.e. handicapped access). 

g) Held Open Delay - Specify the number of seconds the lock can remain open before a Held Open event 

is generated 

h) Exit Bar Dogged Open Delay - Specify the number of seconds an exit bar (if lock is equiped with one) 

can remain dogged before a Held Open event is generated 

5 The Installed option must be checked in order for the lock to become active in SMS. 

Automatic Entry of IP Lock 

Perform any SMS database change or restart the SMS DSR Bridge service to cause the DSR Bridge Service to 

sync the SMS and the DSR databases once a certified Assa Abloy installer has configured the IP Locks 
using the Lock Configuration Tool (LCT) and verified that all locks are communicating withe the 
Assa Abloy DSR. 

1 New / Unknown IP Locks will display as Unconfirmed in the LCT. 

 

2 An SMS database change or DSR Bridge service restart will load any new or unknown IP Locks with their 
Serial Numbers into SMS and the locks will be displayed in the Direct IP Locks / Offline Locks tab. 
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3 Locks will be entered as "Assa Abloy Local Decision Lock SN" followed by the lock Serial Number. 
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4 Double-click the newly discovered Lock to edit the Description. Note the Serial Number is now populated 

and lock details are displayed. 
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5 The Installed option must be checked in order for the lock to become active in SMS. This action will also 

cause the lock to become confirmed by the DSR. 

 

6 SMS will now also sync any Description change to the DSR which will also be reported in the DSR Support 

Tool once synced. 
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Configure IP Lock Settings 

1 Select the Area the lock is providing access to by clicking the expand button. You can create a new area by 

clicking on the plus button (+). On the Create Area Definition  window, enter a description. Area Type, 
Maximum Occupancy Count and Area State fields displays factory set information. 
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2 Set the Relock, Extended Relock, Held Open and Exit Bar Dogged Open delays as desired (see 

descriptions above). 
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3 Select the Holiday Set tab to add a Holiday Set to the IP Lock. 
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4 Select the Automatic Overrides tab to add automatic overrides to the IP Lock. 
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5 Select Enabled by First Person In on the Details tab if Automatic Overrides should be enabled by the 

first Valid Access credential presented to the lock during the Override Timezone. 
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6 Select the Wireless Connection Schedule tab (for WiFi locks only) to configure the sync schedule for IP 

Enabled WiFi Locks. 

 
 

Define Campus Locks 

Refer to the section on Campus Locks for further information on defining Campus Locks. 
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Magstripe Template Definition 

SMS allows the user to define a Magstripe Template. The Magstripe template field allows the user to enable up to 
16 of the 37 digits of the Magstripe template. Enabled digits will display in blue to indicate they are enabled. The 1 
or 2 digits representing the issue code display in red. The issue code is 1 or 2 of the enabled digits. If the digits are 
not enabled, then the issue code offset is not valid. 

Follow these steps to define a Magstripe template: 

1 In the System Manager main window, select Edit>Magstripe Template. 

2 The Magstripe Template dialog opens. This allows the user to insert, modify, and delete Magstripe 
templates.  Factory set templates display in a light blue color. These templates cannot be deleted and, 
only the Description and Notes fields can be modified. 

3 Select the + sign. The Magstripe Template Definition  dialog allows the user to define a new template. 

a) Enter a description (this is a mandatory field) and notes for the new template.   The description field allows 
a maximum of 64 characters. The notes field allows a maximum of 255 characters. 

b) Enable the digits that you want to use for the Magstripe card. Enabled digits will display in blue to indicate 
they are enabled.  If the user attempts to enable more than 16 digits a message is displayed. 

c) The user can enable or disable the issue code offset by using the Issue Code Offset Enabled checkbox. 
The 1 or 2 digits representing the issue code will display in red. If the digits are not enabled, then the issue 
code offset is not valid. If the issue code offset is enabled, there is a user friendly control which helps the 
user select one.   

d) To unselect all the digits of the template, right click and select the menu item Deselect All , which disables 
all the selected digits. 

 

e) The caption below the issue code offset control displays what the issue code is. 
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Note: Only the odd positioned digits can be selected as the issue code offset because of limitations of the 

firmware. 

f) The Save and Close  saves the current record and then closes the dialog. The Save and New  button 

saves the current record and then creates a blank one. The Close button closes the dialog without saving 
the current record.  The grid supports all the basic functions (sorting, column resizing and moving, column 
saving, and exporting the data). 

Note: The dialog saves the size and position when closed and re-opened. 

 

Editing a Magstripe Template 

1 To edit a template, select the record and double click on it. The Magstripe Template Definition window 

displays the current record. Make your modifications and, click Save and Close . 

Note: When you make changes to a Magstripe template that is already in use, you get a warning message 
saying how many locks and credentials are affected. If you continue with the change, the Magstripe CM Lock 
Credentials that were enrolled using the auto retrieve button will have their encoded ID re calculated with the 
new template. If the credentials were manually entered, no changes are made to the encoded ID and the 
credentials are invalid. 

 

Deleting a Record 

1 Select the record you want to delete, and select the minus (delete the current record) sign from the tool bar. 

2 To delete multiple records at the same time, select the records by holding down the shift key and select the 
minus sign. 

 

Refresh 

The refresh button allows the user to manually refresh the grid if needed. The grid does automatically refresh when 
the user performs tasks, but the tool bar icon can be used in case another user makes a change. 

Note: The user must have Read/Write to System Manager in order to add, modify, or delete records. 

 

Device Status 

Device status provides the operator a view of a single devices state at any point in time. The user has the option of 
requesting and receiving status from reader, relay or contact. The status is displayed in a dialog box when it is 
received. 

1 Select a device (relay, reader, contact) and click the View Device Status icon located at the lower section 
(grid section) of the main window of System Manager or highlight a device record, right click and select 

Device Status option. 

2 The Device Status dialogue is initiated in order to retrieve the most recent status for that device. Closing 
and re-opening the dialog requires status to be requested again; therefore, the fields display a message that 
says, the system is currently retrieving the device status until it has received the status or has timed out until 
the status is retrieved. 



...   
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However, opening the dialog initiates the device status request for the selected device automatically. 

 

Status can only be requested from a single device at a time. There will be no grid display of status for multiple 
devices. Transaction Monitor displays transaction when device status messages are sent to the System 
Manager application. 

 
 

Editing records 

In System Manager edit menu allows you to edit area states, door types, contact types, reader types, relay types, 
badge technology, badge status and reader templates. 

Note: While editing a record the records that are factory set come up in sky blue color. You cannot insert new 

records or delete existing records in area states and door types. 

1 Area State  - Opens the Area State Definition window that displays all Area States that have been defined. 
Examples are normal, strike and lock-down. Additions and deletions are not permitted. Modifications can be 
made in this window. 

2 Door Types  - Opens the Door Type Definition window that displays all Door Types. Additions and deletions 

are not permitted. Examples are pedestrian and car park barrier. Modifications can be made in this window. 

3 Contact Type  - Opens the Contact Type Definition window that displays all Contact Types. Examples of 
contact types are REX and DOD. Additions and deletions are not permitted. Modifications can be made in this 
window. 

4 Reader Types  - Opens the Reader Type Definition window that displays all Reader types that have been 
defined. Examples are standard reader, entry reader or muster reader. Additions, modifications and deletions 
can be made in this window. 
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5 Relay Types  - Opens the Relay Type Definition window that displays all Relays that have been defined. 

Additions, modifications and deletions can be made in this window. 

6 User Types (see "Defining User Types" on page 627) - Opens the User Type Definition window. The user 

can enable and label required user types. This option is associated with Campus Locks. 

7 Badge Technologies  - Opens the Badge Technologies window that displays all Badge Technologies such 
as magnetic stripe and proximity. Additions and modifications can be made in this window. Deletions are not 
permitted. 

8 Reader Templates  - Readers are designated as templates when you have additional readers that will use 
the same or very similar relay, contact, event trigger and override information. A template will duplicate the 
information so that it does not have to be redefined each time a new reader is added to the database. 

 

View 

The View menu offers two drop down options, Tree Windows and Grid Windows. Each of these options offers 
additional sub window selections. The Tree Windows are the top tabs of the main screen. The Grid Windows refer 
to the tabs of the Information Grid that are located on the bottom section of the main screen. The user can open an 
individual window or can display several pop up screens using this feature. 

1 Tree Windows - The drop down options display pop up screens for the Area Tree, Area Sets, Callback 

Sets, Cardholder Categories, Hardware Map, Holiday Sets, Site Code Sets and Time zones. 

2 Grid Windows - This option includes sub windows for specific features. 

3 Areas - Offers All Areas and Areas By Area Set. 

4 Cardholders - All Cardholders, Cardholders By Category and Cardholders by Area 

5 Devices - All Readers, All Contacts, All Relays, Readers By Area, Contacts By Area, Relays By Area. 

6 Time Zones - Intervals In Time Zones, Edit Time zone Intervals and Holidays. 

7 Callbacks - Display the Available Callback Number window. 

8 Site Codes - Displays the Available Site Code window. 
 

Search 

1 Click on Search and select Find to search for a timezone. The following window opens. 
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2 The Advanced Find feature helps the operator to customize the search function. The operator can define 
the searches and save them for a later use. The saved search criteria is displayed only for the operator who 
defined it. 

Using Advanced Find, you can build the search criteria by selecting appropriate entries from the drop down 
list box and entering specific value in the value field. You have to select a specific field name, condition and 
a specific search value. 

Advanced Find feature uses Boolean logic to create complex and highly precise searches. Boolean logic uses 
three connecting operators (NOT, AND OR) to narrow or broaden a search or exclude a term from the search. 

It is the process of linking criteria to narrow or expand a search through the use of NOT, AND or OR. 

The Advanced Find feature helps the operator to customize the search function. Operator can define the 
searches and save them for a later use. The saved search criteria is displayed only for the operator who 
defined it. 

3 Click on the Advanced Find tab located on the top of the Search window. 

4 In the Advanced Find window define the criteria you want to use. 

a) If you want to search for Area ID=10, you need first select left parenthesis from the list box. 

b) Parenthesis can be used to create nested search clauses. Using the Parenthesis one can override the 
standard order of priority (left to right) for each Boolean statement in the search. 

c) Select Area ID as the Field Name. 

d) Select equal to (=) as the condition. 

e) Enter the value as 10. 

f) Provide the closing parenthesis at the end. 

g) If you would like to specify additional search condition you can select AND/OR from the list box. 

h) If you enable the NOT check box the search result will display all the records except the ones mentioned 
in the NOT search criterion. 

E.g. if you want to search Area IDs between 10 and 20 and between 25 and 30 you can define the search 

criteria as follows. Use the double parenthesis to nest a search clause. 

((Area ID>10) AND (Area ID<20)) 

 OR ((Area ID>25) AND (Area ID<30)) 

When you run the search you will get records corresponding to area ID values 11 to 19 and 26 to 29. 

5 When you are satisfied with the description, click Add to List button. If the criteria is not valid, it is displayed 

in red under the Where Clause section. When the criteria becomes valid the font color changes to black. 

6 Highlight the criteria and select Save as from the file menu. The User Searches window is displayed. The 
existing Searches are displayed on this window. Now you can either select an existing search and overwrite 
it or create a new search. To create a new search, click the plus icon. Enter a description for the new search 

in the Definition window. Click Save and Close. 

7  In the User Searches window the new search is listed. Click OK to return to the Search Criteria tab. 

8 Click the drop down arrow to the right of the Advanced Find button. In the drop down list you can see your 
saved user searches. Click on the one you defined now. The search results are displayed in the window. You 
can define as many searches as you want. Each criterion you define should be different from the rest. 
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Exporting Cardholder Search Results 

Cardholder search results can be exported to your hard drive from the All Cardholders tab in the following 

formats:.xml, html, txt, csv (comma separated value). 

To export search results to your hard drive, 

1 Run a search and right click on the search results. 

2 Click the Export Results option from the menu. 

3 Choose the directory to which you want to save the results. Give a file name. Click the drop down menu to 
choose an available file format. 

4 Click Save to complete the action and the search results will be saved in your system. 
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C H A P T E R  5  

Introduction 

Access Manager is a tool that allows the user to add Cardholders to Categories, add Areas to Area Sets, 
and assign access in a linking pattern between all of these objects.  It is a dynamic association allowing later updates 

to propagate through the structure.  If an Area is added to an Area Set then all Cardholders (and Categories) 

with access to that Area Set will then have access to the newly added Area.  Also, if a Cardholder is added to a 

Category then that Cardholder gains access to everything that the Category has been granted access.  If the 

access of a Category is updated so is the access for all members of that Category.  Attributes, such as Timezone, 
expiration date, offline credential functions, etc. are assigned via the linking process allowing for more dynamic 
structures.   

Note:  In order for an operator to be able to grant membership and access, proper security group permissions are 

required.  See the appendix: Security Privileges for Managing Access for details.  

Vanderbilt recommends using Access Manager for all access management. 
 
Some access management functions may continue to performed via the Cardholder Definition and System 
Manager applications as in previous versions of SMS.  However, the Access Manager application consolidates 
all these functions, adds new access management functionality and provides a more rich access management 
environment. 
 
Access management functions in the Cardholder Definition and System Manager applications may be removed 
in future versions of SMS. 

Accessing the application 

1 Open the System Launcher (on page 95) software by double clicking on the Vanderbilt SMS icon on 

your desktop.  

2 Enter your assigned user id and password.  In the Launcher window, double click on on the Access 
Manager icon.  

 

Access Manager 
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Overview 

Access Manager allows an operator to group Cardholders into Categories and Areas into Area Sets.  The 

grouping operation creates links between Categories / Cardholders and Areas / Area Sets.  These links are 

now dynamic, allowing later updates to one object, such as a Category or Area Set, to affect other objects or 

properties to which the objects are linked. 
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Grouping 

As the above diagram demonstrates, there are two types of grouping:   

Á Cardholders can be grouped into Categories 

Á Areas can be grouped into Area Sets 

When a Cardholder is added to a Category that Cardholder is said to be granted membership to that Category.  

When an Area is added to an Area Set it is said to be granted membership to that Area Set. Attributes are not 

set with membership.  

Example 1 :  New employee, John Doe, has been hired as campus security.  The operator places him in the 

"Campus Security Officers" Category.  John is now a member of the "Campus Security Officers" Category.  No 

attributes are defined.  

Example 2 : The North Building has added a new cafeteria which has been added as a new Area called "Cafeteria, 

North Building".  The operator adds this Area to the Area Set "North Building".  The "Cafeteria, North Building" 

Area is now a member of the "North Building" Area Set.  No attributes are defined. 

Access 

As the above diagram demonstrates, there are two types of access: 

Á Linked Access 

Á Direct Cardholder Access 

Linked Access  is defined as access derived from the link between a Category and an Area, a Category and 

an Area Set or a Cardholder and an Area Set.  When access is granted via a link, attributes such as Timezones, 
expiration dates, etc. are determined for the link.  All attributes of this link will be the same for every Cardholder 

associated with it (unless Tweaked).  

Direct Cardholder Access  is defined as access derived from the link between a Cardholder and an Area.  The 
attributes such as Timezones, expiration dates, etc. are determined for the link and only affect the specific 
Cardholder. 

Example 3 : The "Campus Security Officers" Category now needs to have access to the North Building.  The 

operator creates linked access between the "Campus Security Officers" Category and the "North Building" Area 
Set and defines the attributes for the linked access such as Timezone, activation date, etc.  There is now linked 

access between all the Cardholder members of the "Campus Security Officers" Category and all the Area 

members of the "North Building" Area Set.  Access attributes were defined when the link was created.  

Example  4 : John Doe requires additional access to the "Gate House of North Building" Area.  This Area is not 

part of an Area Set.  The operator creates direct access between the Cardholder John Doe and the Area "Gate 

House of North Building" and defines the attributes for the direct access.   
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Note:  All linked access is dynamic. 

     Å If a Cardholder is added to a Category at a later date, that Cardholder is granted all access of that 

Category. 

     Å If an Area is later added to an Area Set then any access granted via a link to that Area Set will then include 

the new Area as well. 

     Å If a Cardholder is removed from a Category, that Cardholder will no longer have any of the access granted 

to that Category. 

     Å If an Area is removed from an Area Set then access granted via a link to that Area Set will no longer include 

the removed Area.   

Example 5 : During the upcoming holidays the cafeteria in the North Building is going to be undergoing renovations.  

No employees should have access to this Area during this time.  The operator removes the "Cafeteria" Area from 

the "North Building" Area Set.  Now no one who was granted access to the cafeteria via a link to the "North Building" 

Area Set will have access. 

Attributes 

Attributes are the specific rules governing when and how access is granted.  Attributes are specified using the Area 
Access Assignment Wizard whenever access is granted, either via direct or linked access.  There are two types of 
attributes: Online and Offline 

Online Attributes 

Á Timezone  - specifies during which timezone access is granted (also affects offline locks) 

Á Online Activation  - specifies when the access was activated 

Á Online Expiration  - specifies when the access will expire 

Á Access Blocked  - Allows all access granted by the link to be blocked (including offline locks) 

Á Area States  - Specifies which area state the area must be in for access to be granted 

Á Door Types  - Specifies which types of doors can be accessed 

Offline Attributes 

Á Normal  - Opens a door for a specified time. The time span is defined by the Relock Delay set in the Offline 
Lock Definition. 

Á Toggle  - Opens a door and leaves it open until it is closed again by a toggle credential. It toggles a door 
between locked and unlocked. 

Á Pass Through/Super User  - Allows Users to pass through doors that are in secured lockout mode. It does 
not matter if this mode was set by a door Holiday, or by a Freeze credential used when the door was secured. 
A Pass Through credential will open the door for the specified relock time. 

Á Freeze/Lockout  - Disables the keypad/credential reader. Only credentials set to ñPass Throughò can open 
the door. Use a credential with ñFreezeò function to return the door to an operational state. ñFreezeò does not 
lock a door, for example when the door was toggled open. 

Á One Time/Visitor  - Opens the door only once with the Normal function. After the door relocked the credential 
does not work anymore on this door. It can still work on other doors, until after it was used on these doors 
once. 

Á Supervised  - Follows the ñtwo person ruleò. Two supervised credentials must be used within five seconds to 
open the door. The door stays open until the Relock Delay ends. 

Á Dogging  - Has only a special function on electronic dogging bars. On these exit bars it keeps the push pad 
pushed in and the door unlocked. Dogged works as Normal function on all other devices. 

Á Prohibit Access  - Will not allow the credential to open a door, but it will register when the User of this 
credential tries to do so. It always generates an Audit Event, and additionally sounds the Alarm when the door 
is equipped with a horn. 
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Á CT Aux Normal  - Operates only the Auxiliary relay of CT Controllers, but not the Main relay. The time span 
the relay is activated is specified by the Relock Delay. 

Á CT Main and Aux Normal - Operates both the Auxiliary relay and main relay of Controllers. The time span 
the relays are activated is specified by the relock delay. 

Á CT Aux Toggle  - Operates only the Auxiliary relay of CT Controllers, but not the Main relay, and keeps that 
relay open until closed again by a toggle credential. 

Á CT Main and Aux Toggle - Operates both the Auxiliary relay and main relay of Controllers and keeps those 
relays open until closed again by a toggle credential. 

Tweaking 

Tweaking is a powerful tool that allows the operator to customize access on a one-on-one basis.  The creation of 
linked access assigns the same access attributes to all Cardholders that are granted access via the link.  If the 
operator wants to change the attributes for only one Cardholder in the group then the attributes for that Cardholder 

need to be Tweaked.  The operator can make changes as needed for a specific Cardholder, that will not affect the 
rest of the group, by opening the attributes for that specific Cardholder.  A column in the grid view indicates to the 

operator when access is Tweaked.  Tweaking is discussed further in later parts of this chapter.     

Example : John Doe has been prescribed medicine that prohibits him from being around heavy machinery.  He is 

part of the "Campus Security Officers" Category which is linked to the "North Building" Area Set.  The "North 

Building" Area Set contains the "Machine Shop" Area, which John Doe can not have access to while on 

medication.  The operator can open John Doe's access records and Tweak it so he is blocked from the "Machine 

Shop" Area.  The access blocking will only affect John Doe and not anyone else in the "Campus Security Officers" 

Category.  John Doe's access record will show a check in the Tweaked box to let the operator know this access 

link has been Tweaked.  
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Working With Access Manager 

The Access Manager main screen is subdivided into three sections, the options bar, the main view and the grid 
view.  The options bar is located on the left side of the screen and contains shortcut buttons that quickly open the 
main and grid view that are associated with its topic.  The main view is directly to the right of the options bar while 
the grid view is located at the bottom of the window.  

 

Option Bar  - Located on the left of the window.  Contains shortcuts for Category, Cardholder, Area Set and 

Area.  The information displayed in the main view and grid view will depend on which option is selected in the option 

bar.  

Main View  - Located on the right of the window.  Displays descriptive information such as Category names, 

Cardholder information, Area Set names and Area names.  The arrow keys at the top of the main grid are used 
to navigate between records.  The plus and minus symbols can be used to add or delete a record and the grouping 
and linking buttons can be used to assign membership and grant access.   

Grid View  - Located at the bottom of the window.  Displays information on access, membership, Offline Lock access 
and devices in a set of tabs.  Access and membership can be granted and assigned from this view as well.    
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Main View 

The main view will display all the records currently in the database (up to maximum of 200 Cardholders).  The 
operator can add, delete, and modify records as well as grant access and assign membership from this view. 

Navigation Buttons 

 - Navigate to the first record 

 - Navigate back 10 records 

 - Navigate back 1 record 

 - Navigate forward 1 record 

 - Navigate forward 10 records 

 - Navigate to the last record 

 

Add/Delete/Edit Buttons 

 - Add a new record 

 - Delete a selected record 

 - Edit the selected record 

Search/Refresh Buttons 

 - Refresh the main view 

 - Search for a specific record 

Linking/Membership Buttons 

 - Assign access (Area Access Assignment 
Wizard) 

 - Grouping (Add Cardholder to Category 
Wizard or Add Area to Area Set Wizard) 

Columns 

Á Category / Cardholder / Area Set / Area  - Name of the record in the SMS database  

Á Notes - Displays any notes on a record 

Á Category ID / Cardholder ID / Area Set ID / Area ID  - Unique identifier of the record in the SMS 
database (cannot be changed) 
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Grid View 

The grid view displays specific access information for whichever record is selected in the main view. If multiple 
records are selected the grid view will be blank. The grid view is separated into a set of tabs that vary depending on 
what is selected in the option bar. The information in the grid view will change depending on which of these tabs is 
selected. The navigation, add, delete, edit and search buttons all work similarly no matter which tab is selected.  

Navigation Buttons 

 - Navigate to the first record 

 - Navigate back 10 records 

 - Navigate back 1 record 

 - Navigate forward 1 record 

 - Navigate forward 10 records 

 - Navigate to the last record 

 

Add/Delete/Edit Buttons 

 - Add access or assign membership (depending on tab) 

 - Delete access or remove membership (depending on 
tab) 

 - Edit access 

Search/Refresh Buttons 

 - Refresh the grid view 

 - Search for a specific access record 

 - Cardholders in selected Category only 

 - Display details for selected record 

Block/Unblock Buttons 

 - Unblock access 

 - Block access 

All information displayed in the tabs of the grid view may be organized by any of the columns listed.  Simply click on 
the header of the column and the information will reorder itself.  Click again to change the sort direction. 

Example :  The operator wants to see which access records are expiring soon for members of the "Management 

Division" Category.  The operator clicks on the Category option button and selects the "Management Division" 

Category from the main view.  The grid view now displays information on the members of this Category.  The 

operator then clicks on the All Area Access tab to view all the access records of members of this Category.  The 
operator then clicks on the heading of the Online Expiration column in order to see the information arranged by 
expiration.  The displayed data is resorted to present the access records with the soonest expiration at top and the 

latest expiration on the bottom.  The operator can easily see which members of the Category need to have their 

expiration date updated. 

Category 

When the Category button is clicked, Access Manager will display information specific to Categories in both the 

main view and the grid view. 

All Area Access Tab 

Displays all the access records of all Cardholders who are a member of the selected Category.  Single access 

records can be Tweaked from this tab.  See the Tweaking Access Records section for details.  

Á Cardholder  - Cardholder Name 
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Á Area  - Name of the Area for which the Cardholder has access 

Á Timezone  - Name of the Timezone attribute assigned to the access record 

Á Access Type  - Identifies the method used to grant access to the Cardholder 

Á Access Source  - Names of the Category and Area or Area Set that are linked 

Á Tweaked  - Indicates if the access record has been Tweaked 

Á Online Activation  - Date that access granted by the access record becomes active 

Á Online Expiration  - Date that access granted by the access record expires 

Á Blocked  - Indicates that the access record has been blocked 

Á Cardholder ID - Unique identifier for the Cardholder used by the SMS database (cannot be changed) 

Á Area ID - Unique identifier for the Area used by the SMS database (cannot be changed) 

Á Timezone ID - Unique identifier for the Timezone used by the SMS database (cannot be changed) 

Á Area Access ID - Unique identifier for the Area Access record used by the SMS database (cannot be 

changed) 

Cardholder Membership Tab 

Displays all the Cardholders that are members of the Category. Double-clicking on a Cardholder will switch the 
Access Manager to the Cardholder option with the selected Cardholder displayed. Note that Cardholders may be 
members of more than one Category. Use the Cardholders in selected Category only filter button to display 
Cardholders who are a member of the selected Category (and the default ñAll Cardholdersò Category only. The filter 
will turn green when enabled (as shown below). 

Á Last Name  - Cardholder Last Name 

Á First Name  - Cardholder First Name 

Á Initial  - Cardholder Middle Initial 

Á Activation Date  - Date that access granted to the Cardholder becomes active 

Á Expiration Date  - Date the access granted to the Cardholder will expire 

Á Access Block  - Indicates if the Cardholder access is blocked globally 

Á Controlled Antipassback  - Indicates if the Cardholder is subject to antipassback rules 

Á Special Access Privileges - Indicates if the Cardholder has Special Access Privileges 

Á Raw Data  - Raw card data of the Cardholder's card 

Á Encoded ID  - Encoded ID of the Cardholder's card 

Á Stamped ID  - Stamped ID of the Cardholder's card 

Á Cardholder ID - Unique identifier for the Cardholder used by the SMS database (cannot be changed) 

Á Notes  - Notes entered for the Cardholder 
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Area Links Tab 

Displays any Areas that are linked to the selected Category.  Does not display any access granted by a link 

between the Category and an Area Set, only between the Category and an Area.  Access can be added, 

removed or modified from this tab.  

Á Area  - Name of the Area linked to the Category 

Á Timezone - Name of the Timezone attribute assigned to the link 

Á Online Activation  - Date that access granted by the access record becomes active 

Á Online Expiration  - Date that access granted by the record expires 

Á Blocked  - Indicates if the access link is blocked 

Á Area ID - Unique identifier for the Area used by the SMS database (cannot be changed) 

Á Timezone ID - Unique identifier for the Timezone used by the SMS database (cannot be changed) 

Á Has Tweaked - Indicates that the Area has one or more Tweaked access records 

Area Set Links Tab 

Displays any Area Sets that are linked to the selected Category.  Does not display access granted by a link 

between the Category and an Area, only between the Category and an Area Set.  Access can be added, 

removed or modified from this tab.  

Á Area Set  - Name of the Area Set linked to the Category 

Á Timezone - Name of the Timezone attribute assigned to the link 

Á Online Activation  - Date that access granted by the access record becomes active 

Á Online Expiration  - Date that access granted by the record expires 

Á Blocked  - Indicates if the access link is blocked 

Á Timezone ID - Unique identifier for the Timezone used by the SMS database (cannot be changed) 

Á Area Set ID - Unique identifier for the Area Set used by the SMS database (cannot be changed) 

Á Has Tweaked - Indicates that the Area Set has one or more Tweaked access records 
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Offline Lock Access Tab 

Displays any links between the selected Category and any Offline Locks. 

Á Cardholder  - Cardholder Name 

Á Area  - Name of the Area for which a Cardholder has been granted access and contains an Offline Lock 

Á Timezone  - Name of the Timezone attribute assigned to the link 

Á Raw Data  - Raw card data of the Cardholder's card 

Á Offline Credential Function  - Specifies if any Offline Credential Functions are active 

Á Access Type  - Identifies the method used to grant access to the Cardholder 

Á Access Source  - Names of the Category and Area or Area Set that are linked 

Á Blocked Reason(s)  - Identifies the source(s) for any Cardholder blocked access to the Area 

Á Offline Lock  - Name entered for the Offline Lock 

Á Badge Technology  - Indicates the type of Offline badge technology used 

Á Encoded ID  - Encoded ID of the Offline card 

Á Keypad ID - Unique identifier for the associated Keypad used by the SMS database (cannot be changed) 

Á Badge ID - Unique identifier for the Cardholder's Offline card used by the SMS database (cannot be changed) 

Á Badge Technology ID - Unique identifier for the Offline badge technology used by the SMS database 

(cannot be changed) 

Á Device ID - Unique identifier for the associated Device used by the SMS database (cannot be changed) 

Á Area ID - Unique identifier for the Area used by the SMS database (cannot be changed) 

Á Timezone ID - Unique identifier for the Timezone used by the SMS database (cannot be changed) 

Á Cardholder ID - Unique identifier for the Cardholder used by the SMS database (cannot be changed) 

Á Area Access ID - Unique identifier for the Area Access record used by the SMS database (cannot be 

changed) 

Cardholder 

Initial click of the Cardholder button will open the Cardholder Search and Select dialog.  Cardholder Search results 
allow the operator to specify which system Cardholders should be loaded into the main view.   

Display a specific list of Cardholders:  

1 Fill in the search criteria fields.  

2 Click the Find Now  button.  

3 Select the correct Cardholders from the displayed list. 
OR 

Click Select All to select all the displayed Cardholders.  

4 Click OK.  The Search window will close and the selected Cardholders will be displayed in the main view of 
Access Manager. 

Display all Cardholders (max 200):  

1 Click the Find Now  button without filling in any search criteria.  

2 Click on the Select All  button.  All Cardholders will be selected.  
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3 Click OK.  The search window will close and all system Cardholders will be displayed in the main view of 
Access Manager.  

Note:  The search will return a maximum of 200 Cardholders 

Access Manager will display information specific to Categories in both the main view and the grid view. 

All Area Access Tab 

Displays all the access records of the selected Cardholder.  Single access records can be Tweaked from this tab.  

See the Tweaking Access Records section for details.  

Á Area  - Name of the Area for which the Cardholder has been granted access 

Á Timezone  - Name of the Timezone attribute used by the access record 

Á Access Type  - Identifies the method used to grant access to the Cardholder 

Á Access Source  - Names of the Category and Area or Area Set that are linked 

Á Tweaked  - Indicates if the access record has been Tweaked 

Á Online Activation  - Date that access granted by the access record becomes active 

Á Online Expiration  - Date that access granted by the access record expires 

Á Blocked  - Indicates that the access record has been blocked 

Á Area ID - Unique identifier for the Area used by the SMS database (cannot be changed) 

Á Timezone ID - Unique identifier for the Timezone used by the SMS database (cannot be changed) 

Á Area Access ID - Unique identifier for the Area Access record used by the SMS database (cannot be 

changed) 

Category Membership Tab 

Displays all Categories for which the selected Cardholder has membership.  Double-clicking on a Category will 

switch the Access Manager to the Category option with the selected Category displayed.  

Á Category  - Names of the Categories for which the Cardholder has membership 

Á Notes  - Notes entered for the Category 

Á Category ID - Unique identifier for the Category used by the SMS database (cannot be changed)  

Direct Area Access Tab 

Displays any direct access between Areas and the selected Cardholder.  Does not display access granted by a 

link between the Cardholder and an Area Set, only between the Cardholder and an Area.  Access can be added, 

removed or modified from this tab.  

Á Area  - Name of the Area linked to the cardholder 

Á Timezone - Name of the Timezone attribute assigned to the link 

Á Online Activation  - Date that access granted by this link becomes active 

Á Online Expiration  - Date that access granted by this link expires 

Á Blocked  - Indicates that the access link has been blocked 

Á Timezone ID - Unique identifier for the Timezone used by the SMS database (cannot be changed) 

Á Area ID - Unique identifier for the Area used by the SMS database (cannot be changed) 

Á Area Access ID - Unique identifier for the Area Access record used by the SMS database (cannot be 

changed) 
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Area Set Links Tab 

Displays any Area Sets that are linked to the selected Cardholder.  Does not display access granted by a link 

between the Cardholder and an Area, only between the Cardholder and an Area Set.  Access can be added, 

removed or modified from this tab.  

Á Area Set  - Name of the Area Set linked to the Cardholder 

Á Timezone - Name of the Timezone attribute assigned to the link 

Á Online Activation  - Date that access granted by this link becomes active 

Á Online Expirat ion  - Date that access granted by this link expires 

Á Blocked  - Indicates that the access link has been blocked 

Á Area Set ID - Unique identifier for the Area Set used by the SMS database (cannot be changed) 

Á Timezone ID - Unique identifier for the Timezone used by the SMS database (cannot be changed) 

Á Has Tweaked - Indicates that the Area Set has one or more Tweaked access records 

Offline Lock Access Tab 

Displays any links between the selected Category and any Offline Locks.   

Á Area  - Name of the Area for which a Cardholder has been granted access and contains an Offline Lock 

Á Timezone  - Name of the Timezone attribute assigned to the link 

Á Raw Data  - Raw card data of the Cardholder's card 

Á Offline Credential Function  - Specifies if any Offline Credential Functions are active 

Á Access Type  - Identifies the method used to grant access to the Cardholder 

Á Access Source  - Names of the Category and Area or Area Set that are linked 

Á Blocked Reason(s)  - Identifies the sources for any Cardholder blocked access to the Area 

Á Offline Lock  - Name entered for the Offline Lock 

Á Badge Technology  - Indicates the type of Offline badge technology used 

Á Encoded ID  - Encoded ID of the Offline card 

Á Keypad ID - Unique identifier for the associated Keypad used by the SMS database (cannot be changed) 

Á Badge ID - Unique identifier for the Cardholder's Offline card used by the SMS database (cannot be changed) 

Á Badge Technology ID - Unique identifier for the Offline badge technology used by the SMS database 

(cannot be changed) 

Á Device ID - Unique identifier for the associated Device used by the SMS database (cannot be changed) 

Á Area ID - Unique identifier for the Area used by the SMS database (cannot be changed) 

Á Timezone ID - Unique identifier for the Timezone used by the SMS database (cannot be changed) 

Á Area Access ID - Unique identifier for the Area Access record used by the SMS database (cannot be 

changed) 

Area Set 

Click the Area Set button to have Access Manager display information specific to Area Sets in both the main and 

grid views. 
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All Area Access Tab 

Displays all the access records of the selected Area Set.  Single access records can be Tweaked from this tab.  

See the Tweaking Access Records section for details.  

Á Cardholder  - Names of the Cardholders linked to the Area Set 

Á Area  - Name of the Area for which the Cardholder has access 

Á Timezone  - Name of the Timezone attribute assigned to the access record 

Á Access Type  - Identifies the method used to grant access to the Cardholder 

Á Access Source  - Names of the Category and Area or Area Set that are linked 

Á Tweaked  - Indicates if the access record has been Tweaked 

Á Online Activation  - Date that access granted by the access record becomes active 

Á Online Expiration  - Date that access granted by the access record expires 

Á Blocked  - Indicates that the access record has been blocked 

Á Cardholder ID - Unique identifier for the Cardholder used by the SMS database (cannot be changed) 

Á Area ID - Unique identifier for the Area used by the SMS database (cannot be changed) 

Á Timezone ID - Unique identifier for the Timezone used by the SMS database (cannot be changed) 

Á Area Access ID - Unique identifier for the Area Access record used by the SMS database (cannot be 

changed) 

Area Membership Tab 

Displays all Areas that are members of the selected Area Set.  Double-clicking on an Area will switch the Access 

Manager to the Area option with the selected Area displayed.  

Á Area  - Names of the Areas with membership in the selected Area Set 

Á Notes  - Notes entered for the Area record 

Á Area State  - Indicates the current the state of the Area 

Á Area ID  - Unique identifier for the Area used by the SMS database (cannot be changed) 

Cardholder Links Tab 

Displays any links between Cardholders and the selected Area Set.  Does not display access granted by a link 

between the Area Set and a Category, only between the Area Set and a Cardholder.  Access can be added, 

removed or modified from this tab.  
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Á Cardholder  - Names of the Cardholders linked to the selected Area Set 

Á Timezone - Name of the Timezone attribute assigned to the link 

Á Online Activation  - Date that access granted by the link becomes active 

Á Online Expiration  - Date that access granted by the link expires 

Á Blocked  - Indicates if the access link is blocked 

Á Cardholder ID  - Unique identifier for the Cardholder used by the SMS database (cannot be changed) 

Á Timezone ID - Unique identifier for the Timezone used by the SMS database (cannot be changed) 

Á Has Tweaked - Indicates that the Cardholder has one or more Tweaked access records 

Category Links Tab 

Displays any Categories that are linked to the selected Area Set.  Does not display access granted by a link 

between the Area Set and a Cardholder, only between the Area Set and a Category.  Access can be added, 

removed or modified from this tab.  

Á Category  - Name of the Category linked to the Area Set 

Á Timezone - Name of the Timezone attribute assigned to the link 

Á Online Activation  - Date that access granted by the link becomes active 

Á Online Expiration  - Date that access granted by the link expires 

Á Blocked  - Indicated if the access link is blocked 

Á Category ID  - Unique identifier for the Category used by the SMS database (cannot be changed) 

Á Timez one ID  - Unique identifier for the Timezone used by the database (cannot be changed) 

Á Has Tweaked - Indicates that the Category has on one or more Tweaked access records 

Offline Lock Access Tab 

Displays any information on Offline Locks associated with the selected Area Set.   

Á Cardholder  - Names of the Cardholders linked to the Area Set 

Á Area  - Name of the Area for which a Cardholder has been granted access and contains an Offline Lock 

Á Timezone  - Name of the Timezone attribute assigned to the link 

Á Raw Data  - Raw card data of the Cardholder's card 

Á Offline Credential Function  - Specifies if any Offline Credential Functions are active 

Á Access Type  - Identifies the method used to grant access to the Cardholder 

Á Access Source  - Names of the Category and Area or Area Set that are linked 

Á Blocked Reason(s)  - Identifies the sources for any Cardholder blocked access to the Area 

Á Offline Lock  - Name entered for the Offline Lock 

Á Badge Technology  - Indicates the type of Offline badge technology used 

Á Encoded ID  - Encoded ID of the Offline card 

Á Keypad ID - Unique identifier for the associated Keypad used by the SMS database (cannot be changed) 

Á Badge ID - Unique identifier for the Cardholder's Offline card used by the SMS database (cannot be changed) 

Á Badge Technology ID - Unique identifier for the Offline badge technology used by the SMS database 

(cannot be changed) 
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Á Device ID - Unique identifier for the associated Device used by the SMS database (cannot be changed) 

Á Area ID - Unique identifier for the Area used by the SMS database (cannot be changed) 

Á Timezone ID - Unique identifier for the Timezone used by the SMS database (cannot be changed) 

Á Cardholder ID - Unique identifier for the Cardholder used by the SMS database (cannot be changed) 

Á Area Access ID - Unique identifier for the Area Access record used by the SMS database (cannot be 

changed) 

Devices Tab 

Displays any Devices associated with the selected Area Set 

Á Device  - Name assigned to the the Device 

Á Device Type  - Identifies the type of device 

Á Area  - Name of the Area containing the Device 

Á Parent Device  - Name of the parent Device, if any 

Á Parent Device Type  - Identifies the type of the parent Device 

Á Device Capacity  - Name of the device capacity (specifies the device feature set) 

Á Device Template  - Name of the template used to create the Device, if any 

Á Description  - Description entered for the Device 

Á Port Number  - Identifies the controller port number assigned to the device 

Á Multi drop Address  -  

Á Local Number -  

Á Serial Maxed - 

Á Point Maxed - 

Á Relay Maxed -  

Á Installed  - Indicates that the Device is active for use by SMS 

Á Domain Suffix - 

Á Device ID - Unique identifier for the Device used by the SMS database (cannot be changed) 

Á Device Type ID - Unique identifier for the device type used by the SMS database (cannot be changed) 

Á Area ID - Unique identifier for the assigned Area used by the SMS database (cannot be changed) 

Á Parent ID - Unique identifier for the parent device used by the SMS database (cannot be changed) 

Á Device Capacity ID - Unique identifier for the device capacity used by the SMS database (cannot be 

changed) 

Á Device Template ID - Unique identifier for the device template used by the SMS database (cannot be 

changed) 

Area 

Click the Area button to have Access Manager display information specific to Areas in both the main and grid 

views. 

All Area Access Tab 

Displays all the access records of the selected Area.  Single access records can be Tweaked from this tab.  See 

the Tweaking Access Records section for details.  
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Á Cardholder  - Names of the Cardholders linked to the Area 

Á Timezone  - Name of the Timezone attribute assigned to the access record 

Á Access Type  - Identifies the method used to grant access to the Cardholder 

Á Access Source  - Names of the Category and Area Set that are linked 

Á Tweaked  - Indicates if the access record has been Tweaked 

Á Online Activation  - Date that access granted by the access record becomes active 

Á Online Expiration  - Date that access granted by the access record expires 

Á Blocked  - Indicates that the access record has been blocked 

Á Cardholder ID - Unique identifier for the Cardholder used by the SMS database (cannot be changed) 

Á Timezone ID - Unique identifier for the Timezone used by the SMS database (cannot be changed) 

Á Area Access ID - Unique identifier for the Area Access record used by the SMS database (cannot be 

changed) 

Area Set Membership Tab 

Displays all Area Sets for which the selected Area as membership.  Double-clicking an Area Set will switch 

Access Manager to the Area Set option with the selected Area displayed.  

Á Area Set  - Name of the Area Set for which the selected Area is a member 

Á Notes  - Notes entered for the Area Set  

Á Area Set ID  - Unique identifier for the Area Set used by the SMS database (cannot be changed) 

Direct Cardholder Access Tab 

Displays any direct access between Cardholders and the selected Area.  Does not display access granted by a link 

between the Area and a Category, only between the Area and a Cardholder.  Access can be added, removed or 

modified from this tab.  

Á Cardholder  - Names of the Cardholders with direct access to the selected Area  

Á Timezone - Name of the Timezone attribute assigned to the direct access 

Á Online Activation  - Date that access granted by the direct access becomes active 

Á Online Expiration  - Date that access granted by the direct access expires 

Á Blocked  - Indicates if the direct access is blocked 

Á Timezone ID  - Unique identifier for the Timezone used by the SMS database (cannot be changed) 

Á Cardholder Id  - Unique identifier for the Cardholder used by the SMS database (cannot be changed) 

Á Area Access ID  - Unique identifier for the area access record used by the database (cannot be changed) 

Category Links Tab 

Displays any Categories linked to the selected Area.  Does not display access granted by a link between the 

Area and a Cardholder, only between the Area and a Category.  Access can be added, removed or modified 

from this tab.    

Á Category  - Name of the Category linked to the Area 

Á Timezone - Name of the Timezone attribute assigned to the link 

Á Online Activation  - Date that access granted by the link becomes active 
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Á Online Expiration  - Date that access granted by the link expires 

Á Blocked  - Indicated if the access link is blocked 

Á Category ID  - Unique identifier for the Category used by the SMS database (cannot be changed) 

Á Timezone ID  - Unique identifier for the Timezone used by the database (cannot be changed) 

Á Has Tweaked - Indicates that the Category has on one or more Tweaked access records 

Offline Lock Access Tab 

Displays any information on Offline Locks associated with the selected Area. 

Á Cardholder  - Names of the Cardholders linked to the Area 

Á Timezone  - Name of the Timezone attribute assigned to the link 

Á Raw Data  - Raw card data of the Cardholder's card 

Á Offline Credential Function  - Specifies if any Offline Credential Functions are active 

Á Access Type  - Identifies the method used to grant access to the Cardholder 

Á Access Source  - Names of the Category and Area or Area Set that are linked 

Á Blocked Reason(s)  - Identifies the sources for any Cardholder blocked access to the Area 

Á Offline Lock  - Name entered for the Offline Lock 

Á Badge Technology  - Indicates the type of Offline badge technology used 

Á Encoded ID  - Encoded ID of the Offline card 

Á Keypad ID - Unique identifier for the associated Keypad used by the SMS database (cannot be changed) 

Á Badge ID - Unique identifier for the Cardholder's Offline card used by the SMS database (cannot be changed) 

Á Badge Technology ID - Unique identifier for the Offline badge technology used by the SMS database 

(cannot be changed) 

Á Device ID - Unique identifier for the associated Device used by the SMS database (cannot be changed) 

Á Timezone ID - Unique identifier for the Timezone used by the SMS database (cannot be changed) 

Á Cardholder ID - Unique identifier for the Cardholder used by the SMS database (cannot be changed) 

Á Area Access ID - Unique identifier for the Area Access record used by the SMS database (cannot be 

changed) 

Devices Tab 

Displays any Devices associated with the selected Area. 

Á Device  - Name assigned to the the Device 

Á Device Type  - Identifies the type of device 

Á Parent Device  - Name of the parent Device, if any 

Á Parent Device Type  - Identifies the type of the parent Device 

Á Device Capacity  - Name of the device capacity (specifies the device feature set) 

Á Device Template  - Name of the template used to create the Device, if any 

Á Description  - Description entered for the Device 

Á Port Number  - Identifies the controller port number assigned to the device 

Á Multi drop Address  -  

Á Local Number -  

Á Serial Maxed - 
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Á Point Maxed - 

Á Relay Maxed -  

Á Installed  - Indicates that the Device is active for use by SMS 

Á Domain Suffix - 

Á Device ID - Unique identifier for the Device used by the SMS database (cannot be changed) 

Á Device Type ID - Unique identifier for the device type used by the SMS database (cannot be changed) 

Á Parent ID - Unique identifier for the parent device used by the SMS database (cannot be changed) 

Á Device Capacity ID - Unique identifier for the device capacity used by the SMS database (cannot be 

changed) 

Á Device Template ID - Unique identifier for the device template used by the SMS database (cannot be 

changed) 

Add/Delete/Modify a Category 

Click on the Category button on the options bar to add, delete, or modify a Category.  The main and grid views 

will be populated with Category related information.  Select a Category and follow the steps below.  

Add a Category:  

1 Click on the  button in the main view.  The Cardholder Category Definition window will open.  

 

2 Enter the Category name in the Description field. 

3 Enter any additional descriptive information about the Category in the Notes field.  

4 Click on Save and Close .  The window will close and the Category will appear in the main view. 

Delete a category:   

1 Select the Category to be deleted from the main view.  

2 Click on the  button in the main view.  The Information window will open.  

3 Click on Yes. The Category will be deleted and removed from the main view.  

Modify a category:  

1 Select the Category to be modified from the main view.  

2 Click on the  button in the main view.  The Cardholder Category Definition window will open.  

3 Enter any changes into the Description or Notes fields.  
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4 Click on Save and Close .  The window will close and the Category will be modified.  

Add/Delete/Modify a Cardholder 

Click on the Cardholder button on the options bar to add, delete, or modify a cardholder.  The main and grid views 
will be populated with Cardholder related information.  Select a Cardholder and follow the steps below.  

Add a cardholder:  

1 Click on the  button in the main view.  The Cardholder Definition module will open.  See the Cardholder 
Definition chapter for details on adding a Cardholder.  

Delete a cardholder:   

1 Select the Cardholder to be deleted from the main view.  

2 Click on the  button in the main view.  The Information window will open.   

3 Click on Yes. The Cardholder will be deleted and removed from the main view.  

Modify a cardholder:  

1 Select the Cardholder to be modified from the main view.  

2 Click on the  button in the main view.  The Cardholder Definition module will open.  See the Cardholder 
Definition chapter for details on modifying a Cardholder.  

Add/Delete/Modify an Area Set 

Click on the Area Set button on the options bar to add, delete, or modify an area set.  The main and grid views will 

be populated with Area Set related information.  Select an Area Set and follow the steps below.  

Add an Area Set:  

1 Click on the  button in the main view.  The Area Set Definition window will open.  

 

2 Enter the Area Set name in the Description field. 

3 Enter any additional descriptive information about the Area Set in the Notes field.  

4 Click on Save and Close .  The window will close and the Area Set will appear in the main view. 

Delete an Area Set:   

1 Select the Area Set to be deleted from the main view.  

2 Click on the  button in the main view.  The Information window will open.  

3 Click on Yes. The Area Set will be deleted and removed from the main view.  
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Modify an Area Set:  

1 Select the Area Set to be modified from the main view.  

2 Click on the  button in the main view.  The Area Set Definition window will open.  

3 Enter any changes into the Description or Notes fields.  

4 Click on Save and Close .  The window will close and the Area Set will be modified.  

Add/Delete/Modify an Area 

Click on the Area button on the options bar to add, delete, or modify an Area.  The main and grid views will be 

populated with Area related information.  Select an Area and follow the steps below.  

Add  an Area:  

1 Click on the  button in the main view.  The Add Area Wizard window will open.  

 

2 Enter the Area name in the Description field. 

3 Enter any additional descriptive information about the Area in the Notes field.  

4 Select the Area Type.  See the Two Person Rule  chapter for details.  

5 Select the Maximum occupancy count (disabled for Normal Area Types). 

6 Select the Area State.   

7 Click Finish.  The window will close and the Area will appear in the main view. 

Delete an Area:   

1 Select the Area set to be deleted from the main view.  

2 Click on the  button in the main view.  The Information window will open.  

3 Click on Yes. The Area will be deleted and removed from the main view.  

Modify an Area:  

1 Select the Area to be modified from the main view.  
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2 Click on the  button in the main view.  The Add Area Wizard window will open.  

3 Enter any changes into the Description, Notes, or Area State fields.  

4 Click Finish.  The window will close and the Area will be modified.  

Adding Cardholders to Categories 

The Add Cardholder to Category Wizard  is used to make a Cardholder a member of a Category.  The wizard 

can be opened in a variety of ways, depending on whether Category or Cardholder is selected in the option bar.  

 

Accessing the Adding Cardholders to Categories Wizard from the Category 
Option 

1 Click on the Category button in the option bar.  

2 Select the Category to be added to from the main view (multiple selections can be made if adding 

Cardholders to multiple categories at once). 

3 There are three options to open the wizard: 

Á Click on the Grouping button ; 
OR 

Á Right Click on the main view and select the Add Cardholder to the Selected Category  option; 
OR 

Á Select the Cardholder Membership tab in the grid view and Click the  button in the grid view (not 
available if multiple Categories are selected). 

4 The Adding Cardholder to Categories wizard will open with the selected Categories in the Categories that 

have been selected  field.  

Accessing the Adding Cardholders to Categories Wizard from the Cardholder 
Option 

1 Click on the Cardholder button in the option bar.  

2 Search for Cardholders.  See the Add/Delete/Modify a Cardholder section above for details.  

3 Select the Cardholder to be added to a Category (multiple selections can be made if adding multiple 

cardholders to a category at once). 

4 There are three options to open the wizard: 

Á Click on the Grouping button ; 
OR 

Á Right Click on the main view and select the Add the Selected Cardholders to Categories  option; 
OR 

Á Select the Category Membership tab in the grid view and Click the  button in the grid view (not available 
if multiple Cardholders are selected). 

5 The Adding Cardholder to Categories wizard will open with the selected Cardholders in the Cardholders 
that have been selected  field. 
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Using the Adding Cardholders to Categories Wizard 

Once the wizard is open it can be used to group Cardholders into Categories.  The wizard will already have either 

the selected Categories or the selected Cardholders entered into its fields depending on if it was opened from the 

Categories option or the Cardholder option.  Additional Categories or Cardholders can be added beyond the 

initial selection if desired.   

1 Open the Adding Cardholders to Categories Wizard (see above for details on access in the wizard).  

 

2 Click the Add Cardholders  button.  The Select Cardholders search window will open.  

3 Enter search criteria into the Search criteria  field (such as first name, last name, or Cardholder ID) or leave 
the field blank to show all records.  

4 Click the Find Now  button.  

5 Select Cardholders from the list.  Hold down the Ctrl key to make multiple selections.  

6 Click OK.  The search window will close and the wizard will display the selected Cardholders.  

7 Click Next .  The Categories section of the wizard will open.  

 

8 Click Add Categories .  The Select Categories search window will open.  
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9 Enter search criteria into the Search criteria  field (such as Category name or Category ID) or leave the 

field blank to show all records.  

10 Click the Find Now  button.  

11 Select Categories from the list.  Hold down the CTRL key to make multiple selections.  

12 Click OK.  The search window will close and the wizard will display the selected Categories.  

13 Click Finish .  The selected Cardholders will be added to the selected Categories.   

Note:  At any time the Next  and Back  buttons can be used to change the selections or the Cancel  button 
can be used to abort the operation without making any changes.  

Removing Cardholders from Categories 

Remove a Cardholder from a Category using the Category button in the option bar:  

1 Click on the Category  button in the option bar.  

2 Select the Category that will have a Cardholder removed from the main grid.  

3 Click on the Cardholder Membership  tab in the grid view.  

4 Select the Cardholder to be removed in the grid view.  

5 Click the  button in the grid view.  A warning window will open.  

6 Click Yes.  The warning window will close and the Cardholder will be removed from the Category.  

Remove a Cardholder from a Category using the Cardholder button in the option bar:  

1 Click on the Cardholder  button in the option bar.  

2 Select the Cardholder to be removed from the main grid.  

3 Click on the Category Membership tab in the grid view.  

4 Select the Category that this Cardholder will be removed from in the grid view.  

5 Click the  button in the grid view.  A warning window will open.  

6 Click Yes.  The warning window will close and the Cardholder will be removed from the Category. 

Note:  Removing a Cardholder from a Category will revoke all access linked to the Category  

Adding Areas to Area Sets 

The Add Area to Area Sets Wizard  is used to make an Area a member of an Area Set.  The wizard can be 

opened in a variety of ways, depending on whether Area Set or Area is selected in the option bar.  

Accessing the Adding Areas to Area Sets Wizard from the Area Set Option 

1 Click on the Area Set button in the option bar.  

2 Select the Area Set to be added to from the main view (multiple selections can be made if adding Areas to 

multiple Area Sets at once). 

3 There are three options to open the wizard: 

Á Click on the Grouping button ; 
OR 
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Á Right Click on the main view and select the Add Area to the Selected Area Set  option; 
OR 

Á Select the Area Membership tab in the grid view and Click the  button in the grid view (not available if 
multiple area sets are selected). 

4 The Adding Areas to Area Sets wizard will open with the selected Area Sets in the Area Sets that have 

been selected  field.  

Accessing the Adding Areas to Area Sets Wizard from the Area Option 

1 Click on the Area button in the option bar.  

2 Select the Area to be added to from the main view (multiple selections can be made if adding Areas to multiple 

Area Sets at once). 

3 There are three options to open the wizard: 

Á Click on the Grouping button ; 
OR 

Á Right Click on the main view and select the Add the Selected Areas to Area Sets  option; 
OR 

Á Select the Area Set Membership tab in the grid view and Click the  button in the grid view (not available 
if multiple Areas are selected). 

4 The Adding Areas to Area Sets wizard will open with the selected Areas in the Areas that have been 

selected  field. 

Using the Adding Areas to Area Sets Wizard 

Once the wizard is open it can be used to group Areas into Area Sets.  The wizard will already have either the 

selected Area Sets or the selected Areas entered into its fields depending on if it was opened from the Area Set 
option or the Area option.  Additional Area Sets or Areas can be added beyond the initial selection if desired.   

1 Open the Add Area to Area Set Wizard (see above for details on access in the wizard).  

 

2 Click the Add Areas  button.  The Select Areas search window will open.  

3 Enter search criteria into the Search criteria  field (such as Area name or Area ID) or leave the field blank 

to show all records.  
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4 Click the Find Now  button.  

5 Select Areas from the list.  Hold down the Ctrl key to make multiple selections.  

6 Click OK.  The search window will close and the wizard will display the selected Areas.  

7 Click Next .  The Area Set section of the wizard will open.  

 

8 Click Add Area Sets .  The Select Area Sets search window will open.  

9 Enter search criteria into the Search criteria  field (such as Area Set name or Area Set ID) or leave the field 

blank to show all records.  

10 Click the Find Now  button.  

11 Select Area Sets from the list.  Hold down the CTRL key to make multiple selections.  

12 Click OK.  The search window will close and the wizard will display the selected Area Sets.  

13 Click Finish .  The selected Areas will be added to the selected Area Sets.   

Note:  At any time the Next  and Back  buttons can be used to change the selections or the Cancel  button 
can be used to abort the operation without making any changes.  

Removing Areas from Area Sets 

Remove an Area from an Area set using the Area Set button i n the option bar:  

1 Click on the Area Set  button in the option bar.  

2 Select the Area Set that will have an Area removed from the main grid.  

3 Click on the Area Membership  tab in the grid view.  

4 Select the Area to be removed in the grid view.  

5 Click the  button in the grid view.  A warning window will open.  

6 Click Yes.  The warning window will close and the Area will be removed from the Area Set.  

Remove an Area from an Area Set using the Area button in the option bar:  

1 Click on the Area  button in the option bar.  

2 Select the Area that will be removed from the main grid.  

3 Click on the Area Set Membership  tab in the grid view.  
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4 Select the Area Set that this Area will be removed from in the grid view.  

5 Click the  button in the grid view.  A warning window will open.  

6 Click Yes.  The warning window will close and the Area will be removed from the Area Set.  

Note:  Removing an Area from an Area Set will revoke all access linked to the Area Set 

 

Granting Access 

Access is granted using the Area Access Assignment Wizard.  The wizard is opened in a variety of ways, depending 

on which option is selected in the option bar.  The wizard has five sections, one each for Categories, Cardholders, 

Areas and Area Sets as well as a section for defining attributes.  Depending on how it is accessed, the wizard 

will only show some of these sections.  Categories can be linked to Areas and Area Sets, Cardholders can be 

linked to Area Sets and direct access can be granted from a Cardholder to an Area using the wizard. 

Area Access Assignment Wizard 

Once the wizard is open it can be used to create links and direct Cardholder access and to assign access attributes.  

The wizard starts with the Category / Cardholder sections and moves forward to the Area Set / Area sections.  

Whatever Cardholders, Categories, Areas or Area Sets have been selected in the main view will be 
automatically added to the wizard in the appropriate section; Cardholders will be in the Cardholder section, 

Categories in the Category section, Areas in the Area section and Area Sets in the Area Set section.  Not 

all sections of the wizard will be available at once.  If accessed from the Category option, the Cardholder section 

will be unavailable.  If accessed from the Cardholder option, the Category section will be unavailable.  If accessed 

from the Area Set option, the Area section will be unavailable.  If accessed from the Area option, the Area Set 
section will not be available.  The attributes section is always available, no matter how the wizard accessed.  

Link Category to Area/Area Set 

1 Click the Category  button in the option bar.  

2 Select a Category from the main view.   

3 There are four ways to open the Area Access Assignment Wizard: 

Á Click on the Access Assignment button ; 
OR 

Á Right-click in the main view and select the Insert Area Access to the Selected Categories option; 
OR 

Á Select the Area Links tab in the grid view and Click  in the grid view (only allows linking to an Area, not 
an Area Set); 
OR 

Á Select the Area Set Links tab in the grid view and Click  in the grid view (only allows linking to an Area 
Set, not an Area).  

4 The Area Access Assignment wizard will open with the selected Categories in the Categories that have 

been selected  field.  

5 Click Next .  The Area section of the wizard will open. If not adding access to any Areas, skip this section 

by clicking Next . 

6 Click Add Areas .  The Search for Areas window will open.   
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7 Select any Areas for which this Category should be granted access.   

8 Click Ok .  The Search window will close and the wizard will have the selected Areas displayed.  

9 Click Next .  The Area Set section of the wizard will open. If not adding access to any Area Sets, skip this 

section by clicking Next .  

10 Click Add Area Sets .  The Search for Area Set window will open.  

11 Select any Area Sets for which this Category should be granted access.  

12 Click OK.  The Search window will close and the wizard will have the selected Area Sets displayed.  

13 Click Next .  The Assign Access Attributes section of the wizard will open.  

14 Select the Timezone, Online Activation, Online Expiration and any other attributes for this access (see the 
Attributes section above for details). 

15 Click Finish .  The wizard will close and the access will be linked to the Category.   

Link Cardholder to Area Set / Grant Direct Access for Cardholder to Area 

1 Click the Cardholder  button in the option bar.  

2 Select a Cardholder from the main view.   

3 There are four ways to open the Area Access Assignment Wizard: 

Á Click on the Access Assignment button ; 
OR 

Á Right Click in the main view and select the Insert Area Access to the Selected Cardholders option; 
OR 

Á Select the Direct Area Access tab in the grid view and Click  in the grid view (only allows granting access 
to an Area, not an Area Set); 
OR 

Á Select the Area Set Links tab in the grid view and Click  in the grid view (only allows linking to an Area 
Set, not an Area).  

4 The Area Access Assignment Wizard will open with the selected Cardholders in the Cardholders that have 
been selected  field.  

5 Click Next .  The Area section of the wizard will open.  If not adding access to any Areas, skip this section 

by clicking Next .  

6 Click Add Areas .  The Search for Areas window will open. 

7 Select any Areas for which this Cardholder should be granted access.   

8 Click Ok .  The Search window will close and the wizard will have the selected Areas displayed.  

9 Click Next .  The Area Set section of the wizard will open. If not adding access to any Area Sets, skip this 

section by clicking Next . 

10 Click Add Area Sets .  The Search for Area Set window will open.   

11 Select any Area Sets for which this Category should be granted access.  

12 Click OK.  The Search window will close and the wizard will have the selected Area Sets displayed.  

13 Click Next .  The Assign Access Attributes section of the wizard will open.  

14 Select the Timezone, Online Activation, Online Expiration and any other attributes for this access (see the 
Attributes section above for details). 

15 Click Finish .  The wizard will close and the access will be linked to the Cardholder. 
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Link Area Set to Cardholder/Category 

1 Click the Area Set  button in the option bar.  

2 Select an Area Set from the main view.   

3 There are four ways to open the Area Access Assignment Wizard: 

Á Click on the Access Assignment button ; 
OR 

Á Right Click in the main view and select the Insert Area Access to the Selected Area Sets option; 
OR 

Á Select the Cardholder Links tab in the grid view and Click  in the grid view (only allows linking to a 
Cardholder, not a Category); 
OR 

Á Select the Category Links tab in the grid view and Click  in the grid view (only allow linking to a Category, 
not a Cardholder).  

4 The Area Access Assignment Wizard will open to the Cardholders section.  If not adding access to any 

Cardholders, skip this section by clicking Next . 

5 Click Add Cardholders .  The Search for Cardholders window will open.  

6 Select any Cardholders that should be granted access to this Area Set.  

7 Click Ok .  The Search window will close and the wizard will have the selected Cardholders displayed. 

8 Click Next .  The Category section of the wizard will open. If not adding access to any Categories, skip 

this section by clicking Next . 

9 Click Add Categories .  The Search for Categories window will open.  

10 Select any Categories to which this this Area Set should be linked.    

11 Click Ok .  The Search window will close and the wizard will have the selected Categories displayed.  

12 Click Next .  The Area Set section of the wizard will open. The Area Set that was selected in the main view 

will be displayed.   

13 Click Next .  The Assign Access Attributes section of the wizard will open.  

14 Select the Timezone, Online Activation, Online Expiration and any other attributes for this access (see the 
Attributes section above for details). 

15 Click Finish .  The wizard will close and the access will be linked to the Area Set.   

Link Area to Category / Grant Direct Access Between Area and Cardholder 

1 Click the Area  button in the option bar.  

2 Select an Area from the main view.   

3 There are four ways to open the Area Access Assignment Wizard: 

Á Click on the Access Assignment button ; 
OR 

Á Right Click in the main view and select the Insert Area Access to the Selected Areas option; 
OR 
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Á Select the Direct Cardholder Access tab in the grid view and Click  in the grid view (only allows granting 
access to a Cardholder, not a Category); 
OR 

Á Select the Category Links tab in the grid view and Click  in the grid view (only allows linking to a 
Category, not a Cardholder).  

4 The Area Access Assignment Wizard will open to the Cardholders section.  If not adding access to any 

Cardholders, skip this section by clicking Next . 

5 Click Add Cardholders .  The Search for Cardholders window will open.  

6 Select any Cardholders that should have access to this Area Set.  

7 Click Ok .  The Search window will close and the wizard will have the selected Cardholders displayed. 

8 Click Next .  The Category section of the wizard will open. If not adding access to any Categories, skip 

this section by clicking Next . 

9 Click Add Categories .  The Search for Categories window will open.  

10 Select any Categories to which this Area Set should be linked.    

11 Click Ok .  The Search window will close and the wizard will have the selected Categories displayed.  

12 Click Next .  The Areas section of the wizard will open. The Area that was selected in the main view will be 

displayed.   

13 Click Next .  The Assign Access Attributes section of the wizard will open.  

14 Select the Timezone, Online Activation, Online Expiration and any other attributes for this access (see the 
Attributes section above for details). 

15 Click Finish .  The wizard will close and the access will be linked to the Area.   

Removing Access 

Remove linked access using the Category option:  

1 Click the Category  button in the option bar.  

2 Select the Category that will be losing access in the main view.  

3 Select the Area Links  tab in the grid view if removing access from an Area. 
OR 

Select the Are Set Links  tab in the grid view if removing access from an Area Set. 

4 Select the Area or Area Set that will no longer be linked to the Category in the grid view. 

5 Click the  button in the grid view.  A warning window will open.  

6 Click Yes.  The warning window will close and the access link will be removed.  

Remove linked and direct access using the Cardholder option:  

1 Click the Cardholder  button in the option bar.  

2 Select the Cardholder that will be losing access in the main view (use the search button to find Cardholders if 
necessary). 

3 Select the Direct Area Access  tab in the grid view if removing access from an Area; 
OR 

Select the Are Set Links  tab in the grid view if removing access from an Area Set. 

4 Select the Area or Area Set that will no longer be linked to the Category in the grid view. 

5 Click the  button in the grid view.  A warning window will open.  
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6 Click Yes.  The warning window will close and the access link will be removed.  

Remove linked access using the Area Set option:  

1 Click the Area Set  button in the option bar.  

2 Select the Area Set that will be losing access in the main view. 

3 Select the Cardholder Link s tab in the grid view if removing access from a Cardholder; 
OR 

Select the Category Links  tab in the grid view if removing access from a Category. 

4 Select the Cardholder or Category that will no longer be linked to the Area Set in the grid view. 

5 Click the  button in the grid view.  A warning window will open.  

6 Click Yes.  The warning window will close and the access link will be removed.  

Remove linked and direct access using the Area option:  

1 Click the Area button in the option bar.  

2 Select the Area that will be losing access in the main view. 

3 Select the Direct Area Access  tab in the grid view if removing access from a Cardholder; 
OR 

Select the Category Links  tab in the grid view if removing access from a Category. 

4 Select the Cardholder or Category that will no longer be linked to the Area in the grid view. 

5 Click the  button in the grid view.  A warning window will open.  

6 Click Yes.  The warning window will close and the access link will be removed.  

Modifying Access 

Modifying linked and direct access is done via the Modify Access Attributes window.  Click the edit button in the grid 
view or double-click a linked access record from any of the access tabs in the grid view to access this functionality.  

The operator can change the attributes (see attributes section for details on each) of each link.  All access records 
connected to the link will be modified if any changes are made.  

Modify linked access using the Category option:  

1 Click the Category  button in the option bar.  

2 Select the Category that will be having access modified in the main view.  

3 Select the Area Links  tab in the grid view if modifying access for an Area; 
OR 

Select the Are Set Links  tab in the grid view if modifying access for an Area Set. 

4 Select the Area or Area Set for which the Category link will be modified in the grid view. 

5 Click the  button in the grid view.  The Modify Access Attributes window will open.  

6 Make any changes needed to the attributes.  

7 Click Finish .  The modify access window will close and the access link will be modified.  

Modify linked access using the Cardholder option:  

1 Click the Cardholder  button in the option bar.  
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2 Select the Cardholder that will be having access modified in the main view.  

3 Select the Direct Area Access  tab in the grid view if modifying access for an Area; 
OR 

Select the Are Set Links  tab in the grid view if modifying access for an Area Set. 

4 Select the Area or Area Set for which the Cardholder link will be modified in the grid view. 

5 Click the  button in the grid view.  The Modify Access Attributes window will open.  

6 Make any changes needed to the attributes.  

7 Click Finish .  The modify access window will close and the access link will be modified.  

Modify linked access using the Area Set option:  

1 Click the Area Set  button in the option bar.  

2 Select the Area Set that will be having access modified in the main view.  

3 Select the Cardholder Links  tab in the grid view if modifying access for a Cardholder; 
OR 

Select the Category Links  tab in the grid view if modifying access for a Category. 

4 Select the Cardholder or Category for which the Area Set link will be modified in the grid view. 

5 Click the  button in the grid view.  The Modify Access Attributes window will open.  

6 Make any changes needed to the attributes.  

7 Click Finish .  The modify access window will close and the access link will be modified.  

Modify linked access using the Area option:  

1 Click the Area  button in the option bar.  

2 Select the Area that will be having access modified in the main view.  

3 Select the Direct Area Access  tab in the grid view if modifying access for a Cardholder; 
OR 

Select the Category Links  tab in the grid view if modifying access for a Category. 

4 Select the Cardholder or Category for which the Area link will be modified in the grid view. 

5 Click the  button in the grid view.  The Modify Access Attributes window will open.  

6 Make any changes needed to the attributes.  

7 Click Finish .  The modify access window will close and the access link will be modified. 
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Modifying Linked Access Containing Tweaked Records 

When modifying linked access that contains a Tweaked record (see the Tweaking Access section for details) the 

Modify Access Attributes window will have a new section at the bottom of the window: 

 

Á Blue Text  - Indicates the number of access records created by this link that have been Tweaked.  This 

information is to inform the operator that there are tweaked records attached to this link.   

Á Preserve tweaked, overwrite remaining  - Tweaked records associated with this link will maintain ALL 

existing attributes and will not be affected by the modification. 

Á Overwrite All  - Tweaked records associated with this link will NOT maintain existing attributes and will be 

modified along with the rest of the access records (i.e. they will cease to be Tweaked).   

Example 1 : The operator is making changes to some of the access links.  The Manager Category is linked to the 
North Building Area Set with a Timezone attribute of Awake Hours.  The operator needs to change this attribute to 
Always.  When the Modify Access Attributes window is opened for this link the operator sees that there is 1 record 

that is Tweaked.  The operator knows that this is because one of the Cardholder members of the Manager 

Category is currently blocked.  The operator does not want this Tweak to go away so he chooses the Preserve 
tweaked, overwrite remaining option and clicks the Finish button.  All the non-tweaked access records are updated 

with the new Timezone while the Tweaked record is left the same: it is still blocked and its Timezone attribute 

remains at Awake Hours.   

Example 2 : The Employee Category is linked to the Engineering Area with a Timezone of Awake Hours and an 

expiration date of 12/31/2009.  Last week 3 members of the Employee Category were working late and had their 

Timezone attribute Tweaked to Late Night.  Now, over the weekend, the operator is updating the expiration date 
attribute of the link to extend it to 12/31/2010.  When the Modify Access Attributes window is opened for this link the 

operator sees that there are 3 records that are Tweaked.  The operator knows that these are the three employees 

with the Tweaked Timezone attribute and he knows that in the coming week they will no longer need the later 
Timezone.  So the operator changes the expiration date and selects the Overwrite ALL option and clicks the Finish 

button.  All the access records are updated with the new expiration date and the three Tweaked records are 

returned to their original Timezone attribute.  There are now no Tweaked records in this access link. 
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Tweaking Access 

When a Cardholder is linked to an Area Set, or a Category is linked to an Area or an Area Set, a series of 
access links are created.  All the access records created by the link will share the same attributes, which are defined 
when the link is created.  The operator may want to change the attributes of only one of the access records created 

by the link without affecting any of the other access records.  The specified access record must be Tweaked.   

Tweaking is performed from the All Area Access Tab in the grid view.  All the access records of a Category, 

Cardholder, Area Set or Area are displayed depending on which of the option buttons is selected.  Double-click 
on a record or select it and click the edit button to alter one of the records, without affecting the rest of the linked 
records. 

Tweaking Access Records  

1 Select the access record to be Tweaked:  

1. Select an option from the option bar. 

2. Select a record in the main view.  

3. Click on the All Area Access Tab in the grid view.  

2 Select the access record to be Tweaked from the grid view.  

3 Double-click the access record or click the  button in the grid view.  The Modify Access Attributes window 
will open.  

4 Using the drop down boxes or the check boxes, change the first attribute.  An information window will open 

asking if you want to Tweak the attribute.  

5 Click Continue .  The information window will close and the Reset Attributes to Owning Link's button will 
appear in the Modify Access Attributes window.  

6 Using the drop down boxes or the check boxes, make additional changes (if any) to attributes.  

7 Click Finish .  The Modify Access Attributes window will close and the access record will have a check in the 

Tweaked box.  

Resetting a Tweaked Access Record  

1 Select the access record with Tweaked attributes from the All Area Access tab of the grid view.   

2 Double-click the access record or click the  button in the grid view.  The Modify Access Attributes window 
will open.  

  

3 Click the Reset Attributes to Owning Link's  button. The attributes will reset. 
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4 Click Finish .  The Modify Access Attributes window will close and the access record will no longer have a 

check in the Tweaked box. 

 



 

274 SMS Software Manual Version 7.0.0 

 

C H A P T E R  6  

Introduction 

The user friendly interface of the Cardholder Definition program allows the user to store the cardholder information 

easily. The New Cardholder Wizard  prompts the user for all necessary cardholder data and provides step by step 
instruction for adding a new cardholder record. The system allows a cardholder to have both online and offline 
credentials. Offline credentials are used to give access to CM and CL locks. With the help of wizards, all data 
regarding active and retired credentials, lock access, area access (available only in SMS Enterprise systems), 
cardholder Categories and e-mail addresses are entered and retrieved effortlessly. The user can capture, edit and 
store cardholder portraits and signatures. The Portrait Enhancement Utility takes the cropped image, enhances it 
and then displays a selection of 15 photographs. Images can be exported out of the module and sent to any file on 
your network. There are also options to duplicate cardholder information and print reports. The Advanced Find 
method helps the user to achieve accurate search results using either simple or complex search options. 

Accessing the application 

1 Open the System Launcher by double clicking the Launcher icon on your desktop or go to Start > 
Programs > Vanderbilt SMS > SMS Launcher 6.4.5. 

2 The login window opens. Enter your user id and password. 

3 In the System Launcher window, double click on the Cardholder Definition icon. 

The user can set the Cardholder Definition program to open either in the Search  mode or in the main screen.  

This option is set under the Preferences  menu of the main screen.  

 

To go to the main screen, close the search window, and the program opens the main Cardholder Definition 

screen.  Unselect the Start In Search Mode  option in order for the program to open the main screen by 
default. 

 

Cardholder Definition 
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Working with Cardholder Definition 

 

The main screen displays the cardholder factory set and user defined fields (UDFs). The position of the fields are 
arranged, modified and saved using the UDF Editor module. The lower section of the program displays individual 
cardholder information regarding badge status, lock access, area access, cardholder category and e-mail 
addresses.   Green, yellow and red color indicators are incorporated into the area access time zone and expiration 
fields. A green indicator shows valid access, a yellow indicator means the access will expire shortly; and red 
indicates that access has expired. 

The system offers multiple options to add new cardholders into the system. You can use the cardholder wizard, tool 
bars or main screen to accomplish the same task. 

The Cardholder Wizard is a step by step feature that prompts you for all necessary cardholder data including 
badge, area sets, area access, category information, image and signature capture. A second option for inputting 

cardholders is the New Cardholder option. This allows you to input the information directly on the main screen. 

The Duplicate Cardholder option is a quick and simple way to enter multiple cardholders who have the same 
area access and belong to the cardholder category. The program copies these fields from the previous record to a 
new cardholder record. 

It will also replicate user defined fields that are marked for duplication in the UDF Editor module. The user can then 
enter the new cardholderôs name, badge and image information. 

Removing multiple cardholder records simultaneously is easily accomplished through the Delete Cardholders 

feature. All these features are described in detail later in this document. 

Note: We recommend you to explore the tool bars icons, menu bar drop down options, hot keys and tabs to be 

familiar with all the available options within the program. 
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Add a new Cardholder 

There are two ways to enter new cardholder information. They are, using the Cardholder Wizard and the Add 
New Cardholder Options. The Cardholder Wizard will lead you step by step through its screens for cardholder 
information. The Add Cardholder option allows you to enter information directly on the main screen. However 
additional steps for image and signature capture are necessary. 

 

New Cardholder Wizard 

Note: Adding cardholders using the wizard is available only in SMS Enterprise systems. 

The Cardholder Wizard screens prompts you to add cardholder information, user defined fields, to define badges, 

add area sets and additional areas for access privileges, cardholder categories and image and signature capture. 

1 Select File > Cardholder Wizard option or click the wand icon on the tool bar. 

 

The Access Manager  module is specially designed to make assigning direct and linked access easier (see 

the Access Manager chapter for details), however it is still possible to assign access via the Cardholder 

Definition application.  Vanderbilt recommends using Access Manager for all access assignments. 

Therefore, Vanderbilt recommends clearing the Assign Areas and Area Sets after Finish check box above. 

a) The New Cardholder wizard shows all the available fields (the fields that you see on the main screen) 

including the user defined fields. 

b) Last Name is a required field on the first screen. If a User Defined field has been defined in the UDF 
Editor as ñRequiredò, then UDF fields must also be entered as well. 

User Defined Fields are additional cardholder fields; examples of UDFs are Nick Name, Social Security 

Number or Phone Extension. Please refer to the UDF Editor section for more information. You may 
type in any of these fields to modify the information. In addition, the date fields offer a drop down calendar. 
Use the down arrow to scroll for additional fields on the page. 

c) The portrait capture date and signature capture dates are disabled as these dates are entered 
automatically while adding portrait and signature. 

 

d) If you want to block the cardholderôs Area Access privileges check the box near the option Access 
Blocked. 
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e) To enable anti-pass back feature check the box near the Controlled Antipassback Enabled / 
Lockdown Passthru DISABLED option. If this field is unchecked the card is considered as a master 
card and it will override the antipassback, global antipassback rules of the card readers. The card can be 
used anywhere, any number of times.  Also, if the the IPB LockDown function is in use (See the Internal 
Push Button section of Contact Definitions for details) and the Passthru option is enabled the master card 
will be able to gain entry to doors in LockDown mode. 

There are 2 Options Available 

Controlled Antipassback Enabled / Lockdown Passthru DISBLED  

or 

Controlled Antipassback Disabled / Lockdown Passthru ENABLED 

2 Antipassback - Antipassback is a function that prevents cardholders from passing their card to another 
person for illegal entry. The same card cannot be used at an entry or exit reader twice in a row. In other words, 
once a card is presented at an entry reader, it must then be presented at an exit reader. If a card is presented 
twice in a row at the same type of reader, no access will be granted. The Transaction Monitor will display an 
anti-pass back violation transaction. It is commonly used at car park barriers and turnstiles. 

3 If the cardholder is a disabled person, select the option Special Access Privileges. The system identifies 
valid card reads from cardholder's with special access privileges in order to allow access through specific 
doors with longer GO Relay times (time door strike shall remain energized). The Transaction Monitor displays 
transactions that differentiate a normal card swipe with a card swipe from a person with special access 

privileges. If the field Special Access Privileges is selected, when the cardholder swipes his/her card the 

following transactions are displayed instead of the normal ñValid Accessò type transactions.  

Á Valid Access ï Special access privileges. 

Á Valid Entry ï Special access privileges 

Á Valid Exit ï Special access privileges 

Setting up Special Access Privileges 

a) Select the Special Access Privileges check box in the Cardholder Definition window. 

b) In System Manager, select the reader you want to set up for assigning special access privileges.  You 
need to define the Event Triggers and Actions with increased access time for allowing the disabled person 
to access through the door without any inconvenience.  

c) With the reader selected, click on the Event Trigger Definition button from the toolbar. 

 

d) The Event Triggers for .... window opens.  Click on the + sign on the Event Triggers section to define 

a new event trigger for Special Access Privileges feature.  
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e) Enter a description.  Select the Access Granted Transactions group by clicking on the browse button.  
In the Access Granted Transactions list, there are three transactions available for special access.  If the 

reader you are defining event triggers for is an entry or exit reader, you must select either Valid Entry or 

Valid Exit transactions.  These types of readers are used for creating evacuation reports.  Click OK. 

 

f) Click Save and Close on the Event Trigger Definition window. 

g) Now define the action items for the event trigger.   First action you need to define is Energize Relay.   
Select the device and command to execute.  The duration must be set to longer time period than the usual 
settings to give enough time for the disabled person to go through the door without generating any alarms 

(E.G 20 seconds). The second command is Turn LED Green.  Here also set the duration to a longer 
time.   The duration setting sets the amount of seconds the relay will be energized.  There are two 

Commands that have to be programmed for the DOD Contact. The first is Contact Reporting 

Disabled. This prevents the Contact Active transaction, which may be an Alarm, from being sent for 

the amount of time that is set in the Duration of Seconds field. Again set the Duration time for 20 

seconds.  Once you have defined all the actions for the trigger, click the Close button to exit the window.   



...   
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4 You can continue add new cardholder process in the Cardholder Definitions program. 
 

Assigning Areas and Area Sets 

1 Next, select the Area Sets that you want to assign to the cardholder. 

 

a) Click Add Area Sets. 

b) Choose the Area Sets from the Select Area Sets window. You can use the Search feature to locate 

Area Sets easily. Click OK. 

c) Click Next on the New Cardholder Wizard. 

d) If you want to assign any other Areas additionally click Add Areas. Select the Areas and click OK. 

e) Now select the Time zone, activation and expiration dates for the Areas. You can open the calendar using 
the drop down arrow to select the dates. Use the up and down arrow to adjust the time. 

 

f) Click Next on the New Cardholder Wizard. 

2  File > Area Access > Add Area Access option activates the Area Access wizard. There are four 

different options available on this window. 

a) Remove Area Sets - Removes the Area Set from the cardholderôs record. 

b) Set the selected records so that they use the stored template values - This uses the template 

values for Area Access permissions that have been defined in the System Manager module. 

c) Set the selected records so that they do not use the stored template values - Allows the 
user to change time zone, expiration values, area state and door types associated with the Area Access 
permissions for the specific cardholder. 
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d) Edit access permissions on the selected Area set - Allows user to change the Area Setôs access 
permission for the specific cardholder, provided you have chosen not to use the stored template values. 

e) Your selections will be highlighted in blue color. After clicking OK, the wizard will return to the Area Set 

window. 

3 To delete Area Access, select an Area from the Area Access tab and choose delete. 

Note: The Area Access tab in the cardholder main window displays only Areas; it will not display the Area 
Sets assigned to that cardholder. This means that individual Areas that are members of an Area Set are listed 
in the cardholderôs Area Access tab. An Area will only display one time in the Area Access tab regardless of 
the fact that it may be in multiple Area Sets that have been assigned to a card.   The three buttons are Add 

Areas, Remove Areas and Edit Areas.  Use the Add Area window when a cardholder needs access to a 
specific area and that Area is not associated with any Area Sets that you have assigned to the cardholder. 
You may want to skip this screen until you can review the Area Access tab. 

4 Select Next to skip this step. 

5 In the Area Search screen, type the area name in the criteria field or use Find Now to display all areas 

that have been defined. 

6 Highlight the Area and click OK. To add multiple Areas, hold the control key down while you make your 

selections. 

7 Click OK to display the Areas that have been selected. 
 

Modify Area Access 

1 Now, add this Cardholder to any Cardholder Category that is already defined in the system. You can assign 

a Cardholder to any number of Cardholder Categories. 

a) Click Add Categories. Select a category from the list and click OK. Add any number of categories you 

want. Click Remove Categories to delete any selected categories. 

b) Select File > Categories > Add to Category allows the user to add a cardholder record to a 

cardholder category list. 

c) Select File > Categories > Select a Category to delete a cardholder from a category 
 

Area Access 

1 The Area Access Permission window prompts you for Timezone and Access Expiration. To select 
a different Time zone, use the browse button. To change the date, use the drop down arrow to access the 
calendar. The up and down arrows will modify the time field. 

2 Click the Advanced button to display all Area States and Door Types. 

Note: If the Area Set(s) you selected is using an Area Access template, the template values will be 

automatically assigned to the cardholder. The template is defined and assigned during the Area Set definition 
section in the System Manager. 

3 To assign a time zone and the access expiration time, on the Area Access Permissions window, choose 
the Area Access Time zone. Select access expiration date and time. Click the down arrow near the date field 
to display the calendar. Adjust the time using the up and down arrows. 

4 If you want to block the access, select the check box near the Access Blocked field. 

5 Click OK. 
 



...   
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Portrait Capture 

Next step is capturing the portrait of the cardholder. Select Capture to display the Cardholder Image window. 

Under the Source field, your choices are From File, From TWAIN Device or From FlashbusMV. Select 

Capture on the Cardholder Image screen; the photograph is displayed. Tool bar icons offer Crop Image or Show 
Crop Rubber band options. The rubber band is used to display a red dotted line. Drag the rubber band to the 

crop position of your choice then select the Crop Image icon. Save, Cancel, Edit and Refresh are not available 

at this point because the image is stored in memory. Look under the Tools menu for image and cropping choices. 

a) Capture Image - Click this button to capture the image using the default chosen in the System Manager 

Settings module. The choices are File, Twain Device or Flash Bus. 

b) Crop Image - Opens the Portrait Enhancement Utility. Before selecting this option, verify that your Crop 

Rubber band is placed on the image where you want to crop the photograph. 

c) Cropping Rectangle - Displays the Crop Rubber band on the image. Drag and resize the rectangle 

into the position that you want the image to be cropped. 

d) Portrait Image Enhancer - This feature is enabled in the System Manager Settings module under the 
SMS Image Settings tab. When a portrait is cropped, the user is presented with a selection of 15 pictures. 
Using the Decrease and Increase buttons on the bottom, left of the screen will modify the pictures to make 
them lighter or darker. Click on the picture of your choice. The window closes and you are returned to the 

New Cardholder wizard Cardholder Image screen. If you are satisfied with the image select the Save 

icon. 

e) Save your changes and close the Cardholder Image window. The cardholder portrait is displayed on 

the New Cardholder Wizard. 
 

Signature Capture 

Next, you can capture the signature of the cardholder. Click Capture. The Source choices are File, TWAIN Device 
or SMS. If you select the option SMS, you need to have a signature pad connected to the COM Port of your PC. If 

you select the option From File, the Signature folder is displayed by default. Select the file and click Open. The 
signature is displayed on the Cardholder signature screen. Refer to the previous section in this manual for the tool 

bar options. Save your changes and close the window. click Next on the New Cardholder Wizard. 

 

Navigating Linked Access 

Cardholder Definition also provides new functionality to jump directly to Access Manager in the appropriate location 
for editing linked access. 

1 Select the Area Access tab in the grid view 

2 Select an Area Access record 

3 Right-click on an access record with linked access: 

4 The context sensitive menu will display with several options including 2 pertaining to the linked access: 

Á Go to Access Link P.O.V. - Cardholder: CategoryName  

Á Go to Access Link P.O.V. - Area Set: AreaSetName 
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Each option will launch Access Manager opened to the appropriate linked access source  

(either the Category or Area Set which caused the linked access to be granted to the selected Cardholder) 

 
 

Credential Definition 

Adding credentials is the final step in the cardholder insert wizard. Cardholders may be assigned more than one 

active credential including one blank badge (a credential without an encoded ID or a stamped ID). SMS supports 
both active online credentials and offline credentials (offline credentials are used for the offline locks). The offline 
device does not communicate directly with the host controller. The manual programming of the device shall occur 
at the reader location. 

The system allows you to define same online and offline credentials for cardholders. 

Note: Vanderbilt Enrollment Reader allows you to enroll both online and offline credentials. This device has 

Magstripe, proximity, and iButton read heads and can be connected to a PC running the SMS software via a serial 
port or via a serial->USB adapter that is included with the hardware. 

 

Setting up Vanderbilt Enrollment Reader 

The credential data is retrieved using either Enrollment Reader or Offline Enrollment Reader. This enrollment reader 
is connected to a PC running the SMS software via a serial port or via an included serial->USB adapter. To use the 
USB Port Adapter, you must first install the driver software on your computer.  Once the driver has successfully 
installed, you will need to restart your computer.  This device has Magstripe, Proximity, and iButton read heads.   

Connecting the hardware and determining the COM Port 

1 Connect the USB Adapter to the USB Port of your computer.  

2 Go to My Computer.  Right click on My Computer , select Manage.  This opens the   Computer 
Management  screen. 



...   
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3 On the Computer Management screen, select Device Manager>Ports (COM and LPT)>Serial on USB 

Port (COM #) .  It shows the specific COM Port that is used to connect the Enrollment reader. 

  

Setting up the Enrollment Reader in SMS 

1 Open System Settings program.  Choose the tab, Online Credential Options and Pin Calculator . 

2 Under the Enrollment Reader Settings , select Enable Enrollment Reader .   

3 Now select the COM Port  that is used to connect the Enrollment Reader.  This Com Port must be the same 
that you have determined in the previous step.   
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4 In order to add credentials, the system needs to know the format of the credential.  Click the browse button 

near the Card Formats Used in the System  field.  It opens the  Card Formats Used in the System window.  
Choose the card formats that you will be using. 

 
 

Active Online Credentials 

Note: Online credential functionality is available only in SMS Enterprise systems. 

Active online credentials are used for the readers that communicate directly with the host controller. Follow these 
steps to define the online credentials. 

Add credentials 

1 Select the tab Active Online Credentials. Select Add Credential to open the Credential Definition 
screen. 



...   

 

 Chapter 6    Cardholder Definition 285 

 

 

Note: One credential per cardholder can be added without entering a stamped ID or an encoded ID. Check 

the option ñEnter the Stamped ID and the Encoded ID Laterò. If the current cardholder already has a blank 
badge (a badge without a stamped ID or encoded ID) the Credential Definition window will not allow the user 
to create another blank badge. 

 

a) Credential Technology  - Click on the expand button to select the badge technology used for this 
credential. Magnetic Stripe, Barium Ferrite, Proximity, iButton and PIN Only are available options. 

b) Stamped ID is the pre-printed number located on the back of the cardholderôs badge. 

c) Encoded ID - Encoded ID is a unique numeric value that is required to add a credential to a cardholder 
record. For instance, a proximity card has a chip programmed with the number. A magnetic stripe card 
will have the number embedded in the stripe. The maximum value you can enter is 4294967295 for online 
credentials. 

d) Issue Code counts the number of badges issued to an individual cardholder. The original credential will 

have Issue Code zero (0). 

e) Badge Layout -This is a required field. Badge Layout displays the list of layouts that have been created 

in the Badge Creation module. 

Note: Privileges to select, view or print badges will be based on the operator's security group permissions 
set in the System Security Module. When permission to a badge layout equals none, selecting, viewing or 
printing that layout will be unavailable. 

f) Once you fill in the required fields, select Save and Close. Click Save and New to add another badge. 

The information will display in the grid window. Once you are done with adding badges click Finish. 
 

Active Credential Options 

There are eight options available under the Active Credentials sub-menu. Selecting from the Active Badge sub-

menu links to badge fields and opens the Active Credential tab. 

1 Select File>Active Credentials. The following are the menu options. 

a) Add Credential - Opens the Credential Definition window. 

b) Retire Credential - Highlight a badge then select this option to remove it from the Active Online 

Credential tab and write it to the Retired Credential tab. 
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c) Encode Magstripe - If the Magtek or JOMS magstripe encoder is connected this button will encode a 
magstripe credential with the provided information.  The Preferences section is used to define which Track 
will be encoded.  See below for more details.    

d) Reset Anti pass back State - Returns the cardholderôs anti pass back state to neutral. 

e) Select Credential Layout - Opens the Credential Layout Description window that allows the 

user to select a different layout. 

f) Print Credential - Allows user to send the highlighted credential to either the default credential printer 

or a print queue. 

g) Calculate Keypad Pin - Uses the Encoded ID of the highlighted badge to calculate a PIN number. 

Standard or SMS PIN Encryption is defined in the System Settings module. 

h) Edit Badge - Click on this option to edit badge technology and badge layout. Stamped ID, Encoded ID 

and Issue Codes are displayed as Read Only fields. 
 

Offline Credentials 

SMS supports offline readers which do not communicate with the host controller directly. So it is necessary to do 
manual programming at the reader location. The user can create necessary downloadable files and upload to a 
pocket PC. The data is transferred to a PDA by connecting to the serial communication port of the PC. The 

programming of doors is accomplished by connecting a CIP (Computer Interface PAK cable) from the laptop/PDA 
to the iButton ports of the lock. The system will not allow the users to assign different card technologies (Magstripe, 
Proximity) on the same lock. For example, if a Magstripe credential is already assigned to a lock, the system will not 
allow the user to assign a proximity card to the same lock and vice versa. 

 

CM lock credential definition 

Follow these steps to define CM Lock Credentials for cardholders. The first step in defining CM lock credentials is 

setting up the Proximity and Magstripe card formats used in the system. This is set up in the System Settings 

program. Custom card formats can be defined using the Card Format Editor application. If the card format is 
unknown, the user can enter that card either by raw data or via an enrollment reader (Enrollment Reader or Offline 
Enrollment Reader). The system saves the credential without deriving the Encoded ID, and this credential can be 
used only on offline locks. It will not function on online locks. 

The card formats can be selected using System Settings>Offline Credential Settings>Card Formats 
Used in the System option. 

Please refer to Card Format Editor section for further information on defining custom card formats. 

There are four (4) credential technologies available for creating CM Lock Credentials. They are: 

Á Magnetic Stripe 

Á Proximity 

Á PIN Only 

Á iButton 

Magnetic stripe and Proximity credential definition 

Once you have set up the card formats in the system, you can start adding the credentials. If you have defined a 
card format without a site code, you cannot manually enter the Encoded ID. 

1 Select the Offline Credential tab. To define a new offline credential, select Add CM Lock Credential. 



...   
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Note: This field will be visible only if the user has at least read only rights to the System Manager security 

item ñBadgesò and has at least read only permissions to one of the cardholder fields in the grid. If these 
conditions are not met, this field and the corresponding main menu options (File>Offline Credentials) will not 
be available. Due to this the File>Offline Credential option is unavailable, even to users with the correct rights, 
until the user selects the Offline Credential tab.  

2 The CM Lock Credential Definition window opens. 

 

Fill in the following fields: 

a) Credential Technology - Select the type of credential technology. You can auto-retrieve the credential 

technology using a Enrollment Reader or an Offline Enrollment Reader. 

Note: Credential Technology field cannot be changed when you are editing a Credential Definition. The 

credential must be retired and a new one should be created to change this field. This field must be entered 
before saving the record. 

Á Encoded ID, Raw Data, PIN, or iButton - This field changes depending on the credential technology 
you have selected in the previous step. If the Credential Technology you have selected is Magnetic Stripe, 
Proximity or iButton, this field will be Encoded ID and Raw Data. You can specify the input method in the 

System Settings>Offline Credential Settings>Magstripe CM Credential Input method. 
Regardless of the input method selected here, both Encoded ID and Raw Data fields are visible on this 

window. If you select the Input method as Encoded ID only, you cannot enter the raw data manually, 

but you can retrieve the data using an enrollment reader. 

 

3 If the input method is not selected in System Settings, both Encoded ID and Raw Data fields are available for 
selection. 

Á Encoded ID- For this method, you enter a small number, ten digits or less, that is written on the card, 
usually on the back side of the card. When the Encoded ID method is used, the raw data is automatically 
generated using the Encoded ID and the Site Code defined for that format. The ñEncoded Cardò has the 
Encoded ID printed on the back. So this method can be used for those cards. 
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Encoded ID can be entered manually or via a Enrollment Reader  or an Offline Enrollment Reader . 
If the system cannot recognize the card format of a card, the Encoded ID must be automatically retrieved 
(or the user must manually enter the raw data on the card). The system cannot construct the raw data 
without knowing the Encoded ID (Setting up Vanderbilt Enrollment Reader (on page 282)).   

If the raw data does not match the selected card formats, the system still saves the data, but Encoded 
ID will not be derived. The cards without Encoded ID cannot be used on online locks, but these cards will 
still function on offline locks. 

4 If you have defined a card format without a site code, you cannot manually enter the Encoded ID. In this case, 
you must enter the raw data or use the auto retrieve method. The reason is that when the system tries to 
construct the raw data from the Encoded ID and site code and if there is no site code, the raw data will be 
incomplete. If the site code is incorrect, the raw data will also be incorrect and the credential will not get access 
to any locks. If you want to create a credential for a card that has a different site code than the one defined in 
System Settings for that format, you must enter the raw data or use the auto retrieve method. That is because 
the system uses the site code extracted from the raw data instead of the one defined in System Settings for 
those methods. 

Note:  The site code defined in System Settings is only used when using the encoded ID input method. 

Á Raw Data - Raw data can be entered manually or via an enrollment reader. You must enter all the data 
from the Magstripe track. The same rules for securing Encoded ID is applied for Raw Data field. If you 
have Read/Write permissions to Encoded ID field, you can edit Raw Data too. 

The following are the rules for entering raw data for different credentials: 

a) Magstripe - Characters between 0-9 and a few symbols (<, >, =) are valid. The value should be minimum 
one (1) character long and can contain a maximum of forty (40) characters. The ñLocknetic 16 digits mag 
card w/7-d site codeò has the raw data written on the front side of it. 

While using the raw data method, you must enter the exact number of characters on the card. If you have 
the ñLocknetic 16 digits mag card w/7-d site codeò defined in the System Settings, you must enter sixteen 
(16) digits or you will get an error message. 

ñThe Magsritpe Credential does not match any of the Magstripe card formats defined in the Systemò. 

When you create a Magstripe credential (by using raw data or auto retrieve method) for the first time 
without a site code, you will be prompted to save the site code for that format If you click No, then this 
message will be displayed the next time you create a Magstripe credential and you will still not be able 
to use the Encoded ID input method.  

 

b) Proximity - For a proximity card, characters between 0-7 are valid and the value must be sixteen (16) 

characters long. 

c) iButton - For iButton credentials, you can use characters between 0-9 and a-f. The value must be sixteen 

(16) characters long. 

5 Auto Retrieve - This button is used when you are using the offline enrollment reader to extract the data 

from a card. Click the Auto Retrieve button to automatically retrieve the Encoded ID, PIN or iButton ID by 
attaching an enrollment reader to the computer through a serial port. When the user touches the button or 
swipes a card at the reader, the system generates the value automatically. The card format and credential 
technology also can be retrieved using this method. When the manual entry method is used, the user enters 
the raw data on the card and the system converts it to Encoded ID. When the auto retrieve method is used 
the complete data on the card is stored in the system. 



...   
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Note: The Auto-Retrieve button is not applicable to Enrollment Readers. If you are using Enrollment Reader, 

the data will be retrieved when you just swipe the credential or show the credential at the reader. In order for 
the Enrollment Reader to function properly, you need to set the COM Port and Card Format correctly in 
System Settings (Setting up Vanderbilt Enrollment Reader (on page 282)). 

6 Once a credential has been created, you can see Encoded ID and Raw Data on the Cardholder Definitions 
main screen. 

Á Creating iButton CM Credentials  

7  iButton - The raw data that you enter in this field must be sixteen (16) digits in length and can only have 
hexadecimal characters (0-9, a-f). You can enter the raw data or automatically retrieve it using Enrollment 
Reader or Offline Enrollment Reader. For iButton credentials, Encoded ID cannot be entered manually. The 
system will not be able to derive the raw data without having information like site code and family code. 

Á Creating PIN Only CM Credenti als  

8 PIN - This field is for PIN Only credential types. It must be numeric value between X and 8 digits. X = a setting 
in System Settings under Offline Credential Settings called Minimum PIN Length. The minimum number of 
digits that the system allows is three (3). The smaller the minimum length, the smaller the amount of PIN 
number the system can have. 

The system supports both 12 button and 6 button keypads. Also, it is highly recommended to use the Auto 
Retrieve option to generate the PIN, and not to use birth dates or other restricted or easy to guess sources. 

The system uses the Minimum PIN Length specified in the System Settings while generating the PINs. 

Á COM Settings  

1 The COM Port must be configured in System Settings under the Offline Credential Settings tab called 
Offline Enrollment Reader COM Port. If the COM Port is not configured correctly, the feature will time out after 
a set amount of seconds. 

2 The time-out period can be set under System Settings> Offline Credential Settings >Offline 
Enrollment Reader Time-out. The default is 5 seconds, but you can change this value to have enough 

time to swipe the credential. The time-out starts as soon as the button is clicked.    

3 If this feature is used only for proximity cards, the setting in System Settings>Offline Credential 
Settings>Proximity Card Format must be selected. If this field is set incorrectly, an error will occur and 

the system cannot retrieve the Encoded ID from the badge. 

Note: This is a required field. 

a) Stamped ID - This field is enabled only for card credential types; it is the number actually printed on the 

badge. 

Generating Stamped ID Or Encoded ID Automatically  

The encoded ID and Stamped ID fields can be generated automatically by enabling a setting in System 
Settings > Offline Credential Settings>Stamped ID Modifier. Enter a value in this field which functions as 
the modifier of the stamped ID or encoded ID. It works by taking the Encoded ID and subtracting the 
Stamped ID Modifier to get the Stamped ID and vice versa. 

If the above option is enabled, when the Encoded ID is entered by the user, the Stamped ID will 
automatically be generated using the above calculation. If the Stamped ID is entered by the user, the 
Encoded ID will be automatically generated. 

Note: This field must be between 0 and 2,147,483,647. If the Stamped ID modifier makes this field greater 

than 2,147,483,647, the field will just be 0 then. 

b) Keypad ID -This field is only enabled for Card and iButton types.  The Generate Keypad ID button 

can be used to automatically generate the Keypad ID. 
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Note: Keypad ID also can be generated. It follows the same input rules as the PIN Encoded ID above. Keypad 
ID value zero means there is no keypad ID. A cardholder can have two credentials with same Encoded IDs 
as long as the Keypad IDs are different. 

c) Offline Function - Click on the expand button to select a function the offline credential will perform when 

the cardholder presents the credential at the door. 

Note: This is a required field. 

These are the offline functions available. 

Normal -  Normal opens a door for a specified time. The time span is defined by the Relock Delay set in 

the Offline Lock Definition. 

Toggle -  Toggle opens a door and leaves it open until it is closed again by a toggle credential.  It toggles 

a door between locked and unlocked. 

Freeze -  Freeze disables the keypad/credential reader. Only credentials set to ñPass Throughò can open 
the door. Use a credential with ñFreezeò function to return the door to an operational state. ñFreezeò does 
not lock a door, for example when the door was toggled open. 

One Time Use -  One Time Use opens the door only once with the Normal function. After the door 
relocked the credential does not work anymore on this door. It can still work on other doors, until after it 
was used on these doors once. 

Pass Through -  Pass Through is a credential function that allows Users to pass through doors that are 
in secured lockout mode. It does not matter if this mode was set by a door Holiday, or by a Freeze 
credential used when the door was secured. A Pass Through credential will open the door for the 
specified relock time. 

Dogged -  Dogged has only a special function on electronic dogging bars. On these exit bars it keeps 

the push pad pushed in and the door unlocked. Dogged works as Normal function on all other devices. 

Supervised -  Supervised credentials follow the ñtwo person ruleò Two supervised credentials must be 
used within five seconds to open the door. The door stays open until the Relock Delay ends. 

Prohibit Access (with Alarm) -  Prohibit Access (with Alarm) is a credential function that will not allow 
the credential to open a door, but it will register when the User of this credential tries to do so. It always 
generates an Audit Event, and additionally sounds the Alarm when the door is equipped with a horn. 

CT Aux -  This credential function operates only the Auxiliary relay of CT Controllers, but not the Main 
relay. The time span the relay is activated is specified by the Relock Delay. 

CT Main and Aux -  This credential function operates both the Auxiliary relay and main relay of 
Controllers. The time span the relays are activated is specified by the relock delay. 

d) Badge Layout - Select a layout for the badge. This is the layout the badge uses when previewed or 

printed. 

Note: This field is enabled only for card technologies. This is not a required field. This dialog follows 
cardholder field security permissions. If the user does not have at least read only rights to a field, it will not be 
visible. The user must have read/write permissions to all required fields in order to save a record. 

Automatically create CM lock credential 

SMS allows the users to automatically create a corresponding offline credential when a new online credential is 
created. 

Follow these instructions to generate an offline credential. 

1 Open System Settings program. Enable Offline Credential Settings>Automatically create an 
offline credential when an online credential is created checkbox. 



...   
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Note: Only users with administrator rights to System Settings will be able to modify this field because it is a 

global setting throughout the system. 

2 Create a new online credential with an Encoded ID. Keypad ID is optional. This feature will not work with 
credentials created with no Encoded ID. Save the record. 

3 The application then verifies that the same cardholder does not already have an offline credential with the 
same Encoded ID and Keypad ID. If the user already has an offline badge that meets these criteria, then the 
process stops there. The system does not generate any error message. 

If the cardholder does not already have an offline credential with same encoded ID and Keypad ID and, an 
error occurs during the process, the user will be notified of this error with a message dialog. The offline 
credentials grid will be refreshed and the new credential will be visible. 

Note: If Issue Code is in use by the online credential then it must be supported by the offline credential.  If it 

is not, then an offline credential will not be created and the user will be notified via an error message. 

 Editing CM lock credentials 

If you want to modify the offline credentials you have created, double click on the record to open it. Make the 

necessary modifications and select Save and Close. 

The system allows users to edit encoded ID and raw data for iButton, PIN, Proximity and Magstripe credentials. 
Also, when applicable, the system allows users to edit both keypad ID and issue code.  Offline access is linked to a 
credential, not a cardholder.  When an offline credential is retired, all offline access records are deleted.  By being 
able to edit the raw data, encoded ID, keypad ID and the issue code the user can now replace a credential without 
reprogramming access entirely.  

 

Exporting data 

1 To export the offline credential data to a directory in your hard drive, select the record, and right click on it. 

2 Select the option Export Data or Export and Open Data. 

3 Choose the directory where you want to export the data. 
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4 Choose the correct format you want to save the data. Available formats:.xml,.html,.txt,.csv (comma separated 
value). 

5 Give a file name. Click Save. 
 

Deleting Offline Lock Access 

Vanderbilt recommends using Access Manager for all access management. 
 
Some access management functions may continue to performed via the Cardholder Definition application as in 
previous versions of SMS.  However, the Access Manager application consolidates all these functions, adds new 
access management functionality and provides a more rich access management environment.  Offline Lock 

access may now be granted in the same manner as Online Lock access:  include the Offline Lock in an Area 

(with or without Online Locks) and grant access for the Cardholder or Category to the Area (or Area Set). 
 
Access management functions in the Cardholder Definition application may be removed in future versions of 
SMS. 

 

Note: This option applies only to the CM Lock credentials. Campus lock access privileges are defined using the 

Campus Lock Access Definition  dialogue. 

The next step is defining the access privileges for the offline credentials you created. Follow these instructions to 
define offline lock access for credentials. 

 

1 Select the tab Offline Lock Access > Add Offline Lock Access or select File > Offline Lock 
Access > Add Offline Lock Access. 
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2 Click the + (insert) sign on the upper part of the Define Offline Access for... window. 

 

3 Select the credentials that require access to a specific area. The Insert button (+) opens the search window 
allowing users to select any of the current cardholderôs offline credentials. The user can add multiple 
credentials to the list. But the offline access cannot be given to more than one credential at a time. The user 
has to select one credential from the list and then define the offline lock access. The system allows users to 
create multiple access records for a selected credential. 

Note: The selected credentials displays in bold characters. 

4 Once the credential has been selected, the user can use the bottom pane to select the locks to add access.  

The insert button in the bottom pane brings up the Offline Lock Access Definition dialog. Click the insert 
button to select locks. The system allows the user to select multiple locks for one credential. While selecting 
the locks, the locks that do not have the selected timezone attached to it display in red and that lock will not 
be added to the list. 

The system does not allow you to mix Magstripe and Proximity credential technologies on the same lock.  If 
a lock supports only Magstripe credentials, you cannot add a Proximity credential to that lock. For more 

information about this refer to System Manager > Hardware Definitions > CM Lock Definition 

section. 

5 Select the + (insert) sign to add the locks. As mentioned above, only locks that have the selected time zone 
will be available for selection. At least 1 lock must be selected before saving. The user can add the same 
locks to the same credentials as long as the time zone is different. 

6 Next click the expand button and select a time zone. This is a required field. Lock that do not have the selected 
timezone attached to it display in red. 

7 Now select the activation and expiration dates by using the down arrow located near the corresponding fields. 

8 Select the Save and Close to save the record. 
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Note:  Offline locks have access record storage limitations.  Make sure to verify the limit for the specific lock 

model before assigning access. 

9 Click the Delete button in the bottom pane to remove the selected locks from the list view for the selected 

credential. The edit button in the bottom pane brings up the Offline Lock Access Definition dialog in edit 

mode with the current access record. 
 

Campus Lock Credential Definition 

Unlike CM Locks, Campus Locks are assigned by generating credential data which is encoded on Magstripe card. 
Access assignments are therefore tied to the Magstripe card and the system requires the Magstripe card to be 
presented for encoding. 

Follow these steps to assign a Campus Lock Credential to a cardholder. 

Details 

1 Select the Offline Credential tab. Now choose, Add Campus Lock Credential button. In the Campus 
Lock Credential Definition window, the Details tab displays the following fields. 

 

a) Activation - Select a date that the credential will start providing access to the selected locks. 

b) Expiration - Click the drop down arrow to select the expiration date for the credential. The cardholder's 
access rights expire on this date. This must be at least one day greater than the activation date. The time 
the access expires can be changed in the Campus Lock Definition window in System Manager. 

c) Offline Function - Offline function specifies the behavior of the Campus Lock Credential. Generally, the 
selection in Function is the only place to specify Campus Credential behavior, but there is one exception. 
Campus Locks can be configured to allow Campus Credential with ñNormalò function to toggle the lock 
open or close when swiping the card twice.  Click on the expand button to see the list with all functions. 
Select the desired function by clicking on the function name in the list. The list closes and the new selection 
appears in the text field of function. 



...   
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d) User Type - Select a user type this credential is part of. All the enabled user types will be shown in the 
list. Select the desired user type by clicking on the label in the list. The list closes and the new selection 
appears in the text field of User Type. 

e) PIN Requirement - PIN Requirement specifies whether a PIN is also required while presenting a card 
to gain access. The mandatory use of a PIN can be enforced for all times, can be required during a 
Timezone that is assigned to a User Type, or can be never used. Accordingly, the available options in PIN 
Requirement are ñAs Defined by TimeZoneò, ñAlwaysò, and ñNeverò. Click on to see the list with the options 
and select the desired option by clicking on the specific entry. The list closes and the new selection 
appears in the text field of PIN Requirement. 

Note: When setting up Timezones that require PIN use, make sure that this Timezone includes all times 
during which a user type is supposed to have access to that lock. In order for users to be allowed to access 
a campus lock without mandatory PIN entry during some times, and with mandatory PIN entry during other 
times, multiple Timezones need to be set up in Timezone Definitions. 

Example: All Users with user type ñAdministrationò are allowed to access a lock between 8 AM and 6 PM 
without entering a PIN. During the time spans 6 AM to 8 AM and 6 PM to 8 PM a PIN entry is mandatory. 
Between 8 PM and 6 AM any user with user type ñAdministrationò is not allowed to access the lock. This setup 
requires three TimeZones to be set up. 

f) PIN - The Pin value can be automatically generated (a random number) by enabling the option Automatic 
PIN Length in System Settings>Campus Lock Settings section. You can also enter this value manually. 
The credential will use this value after it is swiped at a campus lock. This is required field if the PIN 
Requirement is set to Always or As Defined by lock timezone. If the PIN Requirement is set to Never, this 
value need not be entered. 

g) Gender - Campus locks can be set to allow access rights for male or female users only, or to conduct no 
check on gender. Click on to see the list with the options ñMaleò, ñFemaleò, and ñAllò and ñOtherò. Setting 
Gender to ñMaleò allows access rights to locks that are set to ñMaleò or ñAllò, setting Gender to ñFemaleò 
allows access rights to locks that are set to ñFemaleò or ñAllò, and ñOtherò allows Access Rights to locks 
that are set to ñOtherò or do not check gender access. Choose the desired setting by clicking on the list 
entry. After the selection is completed the list closes and the new selection appears in the text field of 
Gender. 

All means this credential can access all locks no matter what gender access is checked. 

Male means this credential can only access locks that have male access only or that do not check gender 

access. 

Female means this credential can only access locks that have female access only or that do not check 

gender access. 

Other means this credential can only access locks that have Other access only or that do not check 

gender access. 

h) Badge Layout - Select a badge layout of the credential. Click on the expand button to see all the defined 
badge layouts. Select a layout and the list closes. The selected layout will be displayed in the Badge 
Layout field. 

i) Stamped ID - Enter the ID number printed on the badge. This allows the user to distinguish between 

different credential just by looking at the credential. This must be between zero (0) and 2,147,483,646. 

j) ADA Relock Delay - An individual ADA Relock Delay can be assigned to each Campus Lock Credential. 
The ADA Relock Delay of a credential always overrides the standard Relock Delay time configured for a 
lock. It further enables the ADA Relock Delay function of a Campus Lock. When both Campus Lock 
Credential and Campus Lock have an ADA Relock Delay specified, the longer delay time of both will apply, 
even when it is shorter than the standard Relock Delay of the lock. Enter the delay time in seconds into 
the text field of ADA Relock Delay (Sec.) or use to increase or decrease the delay time. The default entry 
is ñ0ò and the maximum amount is 255 seconds. 
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k) Last Encode Date ï This displays the last time the credential was encoded. This is a read only field. 
 

Card Access Values 

Next the user needs to select  the access plan that this credential will have access.  The CAV (Card Access Values) 
tab is used to setup the card access value keys for the credential. Access to a particular building, floor or room is 
given by associating its value to a key. A credential is allowed to have a maximum of five normal keys and one key 
that will expire on a set date. Multiple keys may be needed for the credential to have access to all the doors.  The 
left part of the tab shows the five (5) keys. Captions that are bold mean that a key is currently defined for that key. 
When a key is selected, the right part of the tab shows the access plan and the values that the key is currently using. 
The new access right assignment will not take effect unless the credential is encoded 

The Card Access Value (CAV) section is tied to Operator permissions:   

Á An operator with Administrative permissions is needed to modify the selected CAV 

Á An operator with at least Read permissions is needed to view the selected CAV 

Á An operator with no permission will not be able to view the CAV 

To select CAVs follow the steps below.  

1 Select the CAVs (Card Access Values) tab. 

2 To assign a key, first select a key and select an access plan that is already defined in the system. To assign 
a key, you need to have at least one access plan defined. 

+  

3 When a plan is selected, the system displays all the properties and values associated with that particular plan. 
The controls that you see on this screen depend heavily upon the access plan properties and values defined 

using the Access Plan Definition program. This means that the names shown may be different for each 
access plan. The property values can be selected by clicking on the expand button next to each property. 
When you click on the button, the corresponding property values are displayed. The user then must select a 
value for each property or select the Wild card checkbox which makes it a wildcard. All properties must 
completely be entered or the key will be invalid and the credential cannot be saved. The delete button above 
the keys will clear the selected key. 



...   
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Note: At least one key must be defined to save the credential. Each key can have a separate access plan if 

wanted. 

Any change to a Campus lock credential is only submitted to the database after the credential tied to the currently 
opened credential record is encoded with updated information. Clicking Encode will first initialize the Card Encoder 
connected to the PC. A message text appears in red font above the button bar of Campus Lock Credential Definition 
dialogue. Once the initialization is completed the card encoder is set to write mode and is ready to encode the 
Campus lock credential. Insert a card into the card encoder when the read/write light of the encoder turns on. A 
message indicates that the card is successfully encoded. 

 

Replacement Credential 

SMS provides a functionality to limit the damage resulting from a lost Campus lock credential. This tab will only 
display after the credential has been encoded once and the credential is being edited. It allows the operator to 

replace a lost credential. The Encode Replacement Card button will increment the issue code by one and then 
encode the new card. The new issue code will only be saved if the encoding process is successful. The new card 
must be swiped once to disable the lost one. This issue code cannot be manually changed. This system just uses 
the next value. The first time a card is encoded, the issue code is zero. 

 

Also the user needs to enter the Stamped ID for the replacement card that is printed on the new card. This replaces 
the old stamped ID that is in the database. 
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Temporary Credential 

This tab will only display after the credential has been encoded once and the credential is being edited. This allows 
the operator to issue a temporary card to a cardholder. If the card is completely lost, the Replacement Credential 
option should be used instead. The maximum expiration date can be set using the System Settings application. The 
default is seven days. This means that the longest this card can last is seven days from the current day. The 

activation must be the current day or above and must be one day below the expiration date. The Encode 
Temporary Credential button encodes the temporary credential using the dates selected. 

 
 

Room Change 

Room Change tab is available when the following conditions are met: 

1 The credential was encoded at least once, 

 and 

2 There is at least one campus lock defined to which the user does not have currently access to, 

 and 

3 There is at least one CAV on the credential with no wildcards defined (CAV with a wildcard is not displayed 
on the ñChange Room fromò list). 
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The Room C hange  tab is a simple interface of the expire key feature. While using the Room Change feature, 
instead of the user selecting an existing key, and converting it to an Expire Key, the user selects the lock they 
want to expire on a specific date and then can give access to a new lock. The user need to then select the 
expiration date for the room change. 

 

4 Change Room From lists all the Campus locks that are currently assigned to the selected credential. Click 
on the expand button next to the Change Room From field to see a list of all locks that the cardholder has 
access to and select the one to change by clicking on the specific entry in the list. The list closes and the new 
selection appears in the Change Room From filed. 

5 Click To Room to give the cardholder access to a new room. Assigning a new lock for a Room Change 
functions the same way as assigning an additional lock with the exception that only one lock can be created. 

The Change Room To selection window lists only those locks the user currently does not have access. 

6 The Room Change Expiration Date option allows the user to select the expiration for the room change. 
The minimum date is one day after the current date and the maximum date is one year after the current date. 
A Room change is typically used to allow a person to move things from one room to the other. In order to 
prevent this person from keeping access rights to the previous room the Room change expires at a specific 
date. From that date on access rights to the previous room are dropped and only access rights to the new 
room are in place. Select the expiration date in Room Change Expiration Date. The default date is always one 
day after today. 
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7 Once you choose the rooms to change and set the access expiration date to the old room, click on the Apply 
Room Change  button.  The system now displays the information about the temporary access the cardholder 

has to his/her previous room and the access expiration date.  Click on Remove Access to Room button to 
delete the cardholder's access rights to the previous room. 

 

Once all the fields are filled in, the user must use the Encode button for the changes to take effect. This 
saves the record with the room change and then encodes the new credential. The user must present the 
same card that matches the information in the database. 
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Void credential 

Voiding a credential is an easy way to block a person from accessing the doors that he/she has access. A void 
credential is created by encoding a card using the information of the credential you want to invalidate. When a void 
credential is created, the issue code for the credential automatically increments, making the old card invalid. Once 
a void credential is created, the user must swipe it at all the readers the card had access or reprogram all the locks. 
When a credential is invalidated, the card is added to the void list. 

 

1 Encode Void Credential - Put a card into the encoder to create a void credential. Encoding a credential 
will retire a credential. Once a card is encoded the user can swipe this card on every lock that the person has 
access. By doing that personôs access rights are invalidated. 

2 Display an HTML Report of All the Locks for which the Credential has Access - This option 
displays a report of all the locks the credential has access. The report will be in HTML format and will launch 
in the users default browser. 

3 Insert the card in the encoder and click the Encode button. The Retire Credential dialogue is shown. You 

need to select the status of the credential from the drop down menu and click Retire Credential. Now the 

credential is void and added to the Retired Credential list on the main window of the Cardholder Definition. 
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Encode Magstripe 

The Encode Magstripe button allows the user to encode a magstripe credential on Track 2 or Track 3 with the 
information that has been entered into SMS.   

Note: This feature will only work with the Magtek or JOMS encoders.   

Requirements 

The following requirements must be met in order for the Encode Magstripe button to function: 

Á The magstripe data format must be defined in the Badge Creation Utility 

Á The magstripe data format must be defined in the System Settings application   

Á The magstripe data format for Encoded ID, Site Code and Issue Code must be the same across all 
applications 

See the Badge Creation and System Settings sections for details on defining the formats of magstripe cards.   

To Encode a Magstripe Credential:  

1 Add the credential to the system (see the Credential Definition section for details).  

2 Connect the Magtek or JOMS encoder to the PC.   

3 Click on Preferences>Magstripe Credential Encoding.  

a) Select Track 2 or Track 3 to encode.   

4 Insert the magstripe credential into the encoder.  

5 Click on the Encode Magstripe button.   

Note: In order to encode an online credential, there must be a badge layout with magstripe encoding defined 

for the appropriate fields on the appropriate track.  

6  The card will be encoded.  Repeat the steps above for each magstripe card that needs to be encoded.   

 

 

 

Automatically generating Credentials 

The Cardholder Definition program allows the user to create badges automatically. This feature saves your time 

because if badge automation feature is enabled in the System Settings, whenever you click Add Credential or 
captures a cardholder image the system generates badges automatically. The user has to create a user-defined 
field and link it (using UDF LINK program) with the badge technology and the badge layout they will be using in the 
automatically created badges. 

This badge automation functionality works in two different modes. 

1 Credential Insert Partial Automation Mode -  In partial automation mode, an online credential is created 

when the user clicks the Add Credential button. 

2 Credential Insert Full Automation Mode -  In full automation mode, an online credential is created only 

when the cardholder image is taken. 
 



...   

 

 Chapter 6    Cardholder Definition 303 

 

 

Credential Insert Partial Automation Mode 

The following criteria must be met to insert an online credential automatically. 

Á There should not be an existing blank credential (a blank credential is one without encoded id and stamped 
id) for the cardholder. 

Á Valid UDF Cross References must be created for the badge technology and badge layout. 

Note:  If there is no valid UDF Cross Reference, a dialogue pops up asking you to select the badge layout and badge 
technology. 

Á The user must have at least read only permissions to the cardholder record. 

Á The user must have at least read/write permissions for badging. 

Á The option Credential Insert Partial Automation Mode must be selected in the System Settings. 

Á The option Enter Encoded ID and the Stamped ID Later must be selected in the System Settings 

Follow these steps to insert a blank credential: 

1 Design badge layout and annotations necessary for creating badges. 

2 Create a user-defined string field that can be duplicated using the UDF Editor. For example create a string 
field called ñBadge Technology Linkò. 

3 Using the UDF Cross Reference program, link the field you created with a badge layout and a badge 
technology. In order to do this first, the Badge Layout Mapping must be defined. Assign a logical field value. 
For this example, "Layout" is typed in the Field Value field. Whenever this value is entered in the relative field 
in Cardholder Definition, the program will automatically create a badge using the badge layout you have 
specified here. 

 

4 Next define the badge technology mapping. 

 

5 Select the user-defined field that you want to use for badge technology mapping. This field is located at the 
bottom of the UDF Cross Reference window.  (You can use the same user defined field that you used for 
badge layout mapping.) 

6 In the System Settings>Online Credential Options and Pin Calculator, select the following options. 

Á Enter Encoded ID and Stamped ID Later 
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Á Badge Insert Partial Automation Mode 

7 Click OK. If Cardholder Definition program is already open, close the program and open it again. 

8 Add a new cardholder. In the user defined field that was linked to badge automation, type the same column 
value that was entered in the Badge Layout Mapping Definition (of UDF Cross Reference). For example, enter  
"Layoutò. This is the value that was used as our example while mapping the field with badge layout and 
technology. So whenever you enter the field value of the user-defined field, and click Add Badge button the 
system will automatically generate a blank badge. 

Note:  You have to make sure that the UDF you have created is linked properly using the UDF Cross 
Reference program. Otherwise a dialogue pops up asking you to select the badge layout and badge 
technology. 

9 Click Add Credential. An online credential is automatically inserted. 
 

Credential Insert Full Automation Mode 

When Badge Insert Full Automation Mode is on, badges are generated automatically after the cardholderôs 
photograph is taken for the first time. 

The following criteria must be met to insert a blank badge in the Full Automation Mode. 

1 There must not already be a blank badge (a blank badge is one without Encoded ID and Stamped ID) for the 
cardholder. 

2 Valid UDF Links must be predefined for Badge Technology and Badge Layout. 

3 The user must have at least read only permissions on the cardholder. 

4 The user must have at least read/write permissions for badging. 

5 The option Enter Encoded ID and the Stamped ID later must be turned on in the System Settings. 

6 The option Credential Insert Full Automation Mode must be turned on in the System Settings. 

7 The Image Date field must be blank. 

Now follow steps 1 to 5 in the Badge Insert Partial Automation Section. 

Once you have created the user-defined field and linked it with a particular badge technology and badge layout, you 
can start adding cardholders. 

Fill in the required fields. While filling in the user defined field that you used for linking with the badge technology 
and badge layout, make sure that you are using the same field value that you used for linking. 

Note: The field value in Cardholder Definition must be the same as the column value that was entered in the 

UDF Cross Reference module. 

If the system is set to Badge Insert Full Automation mode, a blank badge is created when the user captures 

the photograph of the cardholder for the first time. 
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Editing Online Credential Information 

You can edit an existing credential by double clicking on the badge fields on the main window of Cardholder 
Definition program. You can change credential technology, badge layout and issue code. If the badge is a blank one 
you will be able to edit all the fields. 

    

                      Existing Credential Definition                        Blank credential definition 

 

Retire Credentials 

The Retire Credentials button allows the user to retire active credentials whenever they like. This option is 
particularly useful if a credential is lost or stolen. In such a situation, the operator can issue a new credential to the 
cardholder and retire his/her old credential. This feature helps the users ensure security. 

1 Select Active Online Credentials or Offline Credentials tab, highlight the credential that you want to 

retire. Click the Retire Credential button on the tool bar. You can also retire a credential by selecting File 
> Active Credential/Offline Credential > Retire Credential option. The credential no longer has any 
access control privileges. (The Encoded ID from this badge may be reused immediately.) The credential is 

automatically removed from the Active Credentials tab and can be found under the Retired Credentials 

tab. In the System Settings program under Badge Options and Pin Calculator section, select ñRetire 
Active Badgesò option. If you have checked this option, each time you initiate a new badge for the 
cardholder, a window pops up to select the active badges to retire. 

 

Note: Please note that the lock has to be programmed for any change to take place. 

a) Credential Retirement Status - From the drop-down menu, select the appropriate status of the 

credential. The following options are available. 

Á Cardholder Deleted 

Á Lost 
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Á Stolen 

Á Destroyed 

Á Suspended 

Á Terminated 

Á Credential Returned to Stock - Select this option to indicate that the credential is returned to stock 

and it does not have to be added to the void list. 

Note: Void list applies only to Campus lock credentials. 

The user can wipe the information on the card and re use it without invalidating the access on that card on 
every lock. 

You can also edit the credentials that are already retired from the Cardholder Definition main window. Select 

the cardholder record and select the tan Retired Credential tab. Double click on the credential record and 

the Retire Credential window is open. Update the status and click OK. Cancel aborts the changes you 

made. 

2 Select Reactivate Credential option to reactivate a retired credential. 
 

Massive Access Control Modification 

The Cardholder Definition program provides functionality to mass modify Access Control fields of cardholder records 
(modifying more than one cardholder at a time). The fields you can mass modify are Access Blocked, Activation and 
Expiration Dates and Controlled Antipassback. 

Follow these steps to Mass Modify Access Control fields for more than one cardholder at a time. 

1 Select Tools > Modify Access Control for Cardholders. The following window is displayed. 
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2 Select the cardholder records by clicking Add Cardholders. You can use the Search and Advance Search 
features for adding cardholders. Once you have added the required cardholder records you want to modify, 

click Next.  The Select Fields window will open.  

 

3 Choose which access control fields you want to modify. 

Á Access Blocked - Check the box to enable this field (This sets its value to true.). If you want to block 

access for the selected cardholders click the box next to the field. 

Á Activation Date - Enable this field by clicking the check box. You can modify the activation date by 
entering the date manually or click on the drop down arrow to use the calendar. Make sure that the date 
you enter is a valid date. (It must be the current date or a future date.) 

Á Expiration Date - It works the same way as the activation date. Enable the field and select a valid date. 

Á Controlled Antipassback - Place a check mark in the box next to Controlled Antipassback, if you 

want to enable this functionality. 

4 Choose which UDF fields (if any) you want to modify. Up to 5 UDF fields may be selected.   

a) In the Field 1 option use the drop down box to select which UDF to modify.   

b) Make changes to the selected field.   

c) Repeat steps a and b for Fields 2 through 5 (if desired), selecting each UDF to be modified.  A UDF field 
cannot be selected more than once.    

5 Click the Next button to continue. A summary of the modifications you made is displayed. To change any 

value, click Back to return to the previous step.  

6 When you are satisfied with the modifications, click the Finish button to complete the process. 
 

Add a new Cardholder (Method 2) 

1 An alternate way to add a cardholder is to fill in the fields on the main window. If you have specified any user 
defined field as Required in the UDF Editor, then a value must be entered in that UDF field as well. 
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2 Click Save on the tool bar once you have populated the fields in the top section. After the Save button is 

clicked, the tabs in the lower section of the window become active. 

3 Enter information for badge, lock access, area access, category and e-mail. Capture an image or signature 
using the tool bar icons or by accessing them from the View menu bar. 

 

Duplicate Cardholder Information 

This function is designed to help you to avoid typing repetitive data for new cardholders. It is useful when you must 
enter multiple cardholder records that will have the same Area Access and category privileges. It will also replicate 

user- defined fields that are marked for duplication in the UDF Editor module. The default data will appear in the 
tabs after the required fields are entered. Badge, image and signature information is entered individually for each 
cardholder record. 

Note: In the System Settings application, under the General tab,  there is an option for Duplication Policy 

in the Cardholder Defintion Settings section.  When an Operator is duplicating a cardholder, this option 
determines how the Security Permission level of the Operator will effect what Area Access, Cardholder Category 
and UDF records from the cardholder will be duplicated. See that section for details on the Duplication Policy option. 

1 To use the Duplicate Cardholder option, first display an existing cardholder record with the same area 
access and cardholder information or enter a new record with area access and category information that you 

want to be copied. Now click on the Duplicate Cardholder tool bar icon or select it from the File menu. 

2 Enter the cardholder information in the top section of the screen and click the Save icon. Area Access and 

Category information appears. 

Note: If area access or category set information is blocked from duplication due to the Duplication Policy 

setting (See System Settings for details) a warning will appear informing the Operator.   

3 Click the Active Online Credentials tab or Offline Credentials and choose Add Online Credentials 
(or Offline) to display the Credential Definition window. Here you must enter an Encoded ID, Badge 

Technology and Badge Layout. The Stamped Number and Issue Code are optional fields. 

4  Next you can capture images and signatures. For pictures, choose the Capture Image icon on the main 
screen tool bar or chose Image from the View menu. The Cardholder Image window is now displayed. Choose 
your Capture Source then select the Capture button on the bottom left corner. Your cropping options become 

active on the tool bar and in the Tool menu bar option. When you are satisfied with the image click OK. 

To open the Cardholder Signature window, select the Capture Signature icon on the tool bar or choose 

Signature from the View  menu. This feature works exactly like the Capture Image screen. 

 

Adding email addresses 

Cardholderôs e-mail addresses can be stored in the system. The user can either insert new E-mail addresses or 
associate the cardholder information with the existing addresses that are stored in the system using E-mail Address 
Editor application.    This option is also equipped with a search feature that allows you to find records easily. 

1 To add a new e-mail address, select the E-mail Addresses option from the lower pane of the window and 

choose the + (plus) icon. 

2 On the Insert E-mail Addresses window, type in the E-mail address. You can add as many records you 

want. 

3 Click OK. The records are shown in the Address section of the main screen. 

4 You can also select the existing e-mail addresses and associate with a cardholder information. Select 

Associate Existing E-mail. 



...   
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5 On the Search window, enter the text in the Search Criteria field and click Find Now. Just clicking the Find 
Now button displays all the records defined in the system. Select the appropriate records and click OK. 

 

Deleting email addresses 

1 If you want to remove an e-mail address from a cardholder record, open the cardholder record and select the 
E-mail Address tab located in the lower section of the window. 

2 Select the e-mail address you want to delete and select the delete icon from the tool bar. 

3 A confirmation message is displayed. Choose Yes to continue. 

Note: If the e-mail address you are trying to delete is attached to a report (used in the Report Scheduler 

program) you cannot delete the record. A warning message is displayed preventing you from deleting the 
record.  

Modifying and Deleting Cardholders or Cardholder Information 

Cardholder data can be modified and deleted directly from the main screen and by using menu or tool bars. 
Locate and display the cardholder by using the Search feature. You may type over information in any fields 
in the top section of the window then use the tabs and the tab tool bars to change badge, area access and 
category information. 

The grids of tabs cannot be modified. The quickest way to modify a field is to click on the record and use the 
picture icons. To edit a Date field use the drop down arrow to display the calendar or type the change directly 
in the field. Highlight the year field and right click your mouse to open the shortcut named ñGo to todayò. The 
field displays the current date. 

To delete information on a cardholder, highlight the field within one of the tabs and select the appropriate 
delete icon from the tab tool bar. To delete a cardholder from the database, search and display the cardholder 
then chose the Delete Cardholder icon. 

 

Delete Cardholders 

The following are the conditions for deleting cardholders. 

1 The user must have read/write permissions or greater to the cardholder (through category permissions) 

2 The user must have read/write permissions or greater to Cardholder Definitions (through launcher 
permissions) 

3 The user must have read/write permissions or greater to Cardholder ID (through cardholder permissions). 
 

Deleting a single cardholder record 

1 Using the Cardholder Search wizard, select the cardholder record that you want to remove from the database. 

2 With the record displayed on the main screen, select Edit>Delete Current Cardholder or choose the tool 

bar icon. A confirmation message is displayed. Click Yes to delete the cardholder. 
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Multiple cardholder deletions 

 In the Cardholder Search wizard, choose the records to be removed from the database. This feature is separate 
from the Delete Cardholder icon that resides on the tool bar. 

While deleting multiple cardholders at the same time, any attempt that fails will be added to a list view and when the 
deletion is complete, a dialog pops up with a list of cardholders who were not deleted and showing the cause of the 
error. 

1 Select Edit>Delete Multiple Cardholders or select the tool bar icon. The Cardholder Search window will 

display. Use your control (Ctrl) key to make multiple selections. Click OK. A confirmation message is displayed 

to verify the number of cardholders to be deleted. Click OK. 
 

Exporting Cardholder Portraits 

This feature provides an Export Wizard  that sends cardholder images to a separate file. These files can reside on 
the local drive or can send across the network to and saved on a different computer. This is useful when you want 
to store image copies on a different server or when a picture needs to be attached to an E-mail message. It is 

recommended that the file that you want to export reside outside of the SMS software. 

1 Select File>Export Cardholder Portraits . The Export Wizard permits you to copy portraits to a new file 

located outside of SMS. The Add Cardholder button links to the Cardholder Search Wizard. Highlight your 

selections and click OK. 

 

2 A list displays when a portrait is not be exported. The wizard displays the cardholders selected for export. 



...   
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3 The next step is to select the path, file naming convention and file name separator. 

 

a) Directory for Export - Type the full path or use the Browse button to select your folder location. 

b) File Naming - The Export folder contains the JPG images of your cardholders. Select a good naming 
convention under the File Name section. When choosing a combination of fields, you can determine the 
order by using the Field Up and Field Down buttons. 

c) Separator - This is used in conjunction with file names that use several fields. 

Example: When using a period, the file name format in the folder will be Last.First.jpg such as 
Doe.John.jp.  A forward slash, back slash or star symbol is not permitted as a Separator. An error 
message displays if one of these characters are entered. 

d) Replacement Character  - Click on the down arrow to select a character that replaces any invalid 
characters in the file name. 

4 Click Next .  A summary of the export is shown in the next window.  Click Finish  to start the export process. 
 

Printing Dossier Reports 

A Dossier is a type of Badge Layout that has been identified as such in the Badge Creation module. A Search 
window allows the user to select from a list and send the report to be printed. 

Dossier Reports can be sent to queues just like badges. While printing the reports select the option ñSend Dossier 
Reports to Printer Queue.ò 

Note: The system will default to the option set in the System Settings program. In the System Settings if you have 

set the option as ñSend Dossier to Default Printerò the system will automatically defaults to that option. 

If you have set a default dossier queue in the System Settings the system will default to that dossier queue 
automatically. 

Print Portrait Export Report: This report is created and printed when the user selects the date of the file export. 

 


























































































































































































































































































































































































































































































































































































































































